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About This Guide

The Micro Focus Vibe 4 Installation Guide covers the installation and configuration of Micro Focus
Vibe. The guide is divided into the following sections:

¢ Part I, “Product Overview,” on page 13

¢ Part Il, “What's New in Vibe 4,” on page 35

+ Part lll, “Basic Installation,” on page 49

+ Part IV, “Advanced Installation and Reconfiguration,” on page 101
+ Part V, “Multi-Server Configurations and Clustering,” on page 135
¢ Part VI, “Upgrade,” on page 177

+ Part VII, “Migrate,” on page 217

+ Part VIII, “Appendixes,” on page 229

Audience

This guide is intended for Micro Focus Vibe administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the comment on this topic feature at the bottom of each page
of the online documentation.

Documentation Updates

For the most recent version of this manual, visit the Micro Focus Vibe 4 Documentation website (http:/
/www.novell.com/documentation/vibe4).

Additional Documentation

You can find more information in the Micro Focus Vibe documentation, which is accessible from the
Micro Focus Vibe 4 Documentation website (http://www.novell.com/documentation/vibe4).

To access the Micro Focus Vibe User Guide from within Vibe, click the Settings icon, then click Help.

About This Guide 11
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Product Overview

¢ Chapter 1, “What Is Micro Focus Vibe?,” on page 15
+ Chapter 2, “Vibe System Requirements,” on page 19
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1 What Is Micro Focus Vibe?

Micro Focus Vibe is an enterprise collaboration tool designed to increase individual productivity, team
effectiveness, and organizational success by providing the right set of tools to the right people.
+ “Vibe Capabilities” on page 15
+ “Vibe Components” on page 16
+ “Vibe Configurations” on page 17

Vibe Capabilities

Micro Focus Vibe users fall into three basic groups:

+ “Content Consumers” on page 15
+ “Content Providers” on page 15

+ “Administrators” on page 16

Content Consumers

Content consumers use Micro Focus Vibe to work with important information that pertains to them.
Content consumers:

+ Maintain their personal workspaces, including setting up a personal Blog, Calendar, Files,
Guestbook, Photo Album, and Tasks folder

+ Participate in team workspaces set up for content providers, in order to better collaborate with
colleagues and facilitate their work assignments

+ Search the Vibe site for people, places, and other information that pertains to their personal work
assignments

+ |dentify subject-matter experts to assist them in their personal work assignments

The typical tasks performed by content consumers are covered in the Micro Focus Vibe 4.0.5 User
Guide.

In many cases, content consumers quickly become content providers.

Content Providers

Content providers use Micro Focus Vibe to create and manage teams, customize the Vibe
environment, and import data into the Vibe site for use by other Vibe users. Content providers:
+ Create and manage team workspaces and folders
+ Control user access to their team workspaces

+ Establish unique branding for workspaces and folders to clearly differentiate them from other
places on the Vibe site

+ Create landing pages for workspaces that consolidate the most necessary workspace
information into a single page

What Is Micro Focus Vibe?
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+ Customize data entry forms for gathering information from users
+ Create workflows to automate otherwise time-consuming manual processes

The typical tasks performed by content providers are covered in the Micro Focus Vibe 4.0.5 User
Guide.

Administrators

A Micro Focus Vibe administrator is responsible for installing the Vibe software and setting up the
Vibe site. This Micro Focus Vibe Installation Guide provides instructions for Vibe software installation.
After installation, the Vibe site administrator can:

+ Set up user access to the Vibe site

+ Create initial workspaces and populate them with information that is of interest to Vibe users

+ Control user access to workspaces and folders

+ Configure email integration, so that Vibe users can receive notifications of updated information
on the Vibe site and post to the Vibe site by using email messages

+ Set up mirrored folders to make large sets of data that are already available on disk more easily
available through the Vibe site

+ Set up software extensions (add-ons) that enhance the power and usefulness of the Vibe site

+ Set up remote applications that deliver data from a remote location, such as a remote database,
for easy access on your Vibe site

+ Manage users, workspaces, and folders as the Vibe site grows and evolves
+ Perform regular backups to safeguard the data stored in the Vibe site

The typical tasks performed by Vibe site administrators are covered in the Micro Focus Vibe 4.0.4
Administration Guide.

Vibe Components

A Micro Focus Vibe site consists of four major components:

+ “Vibe Software” on page 16
+ “Vibe Database” on page 16
+ “Vibe File Repository” on page 17

¢ “Lucene Index” on page 17

Vibe Software

The Vibe software is a customized version of Apache Tomcat. This software provides the web-based
functionality you use as you access the Vibe site through your web browser.

Vibe Database

The Vibe database is used for storing the following information about the Vibe site and its users:

¢ Structural information about workspaces, folders, and entries (for example, their location in the
workspace tree)

What Is Micro Focus Vibe?



+ |dentification information about workspaces, folders, and entries (for example, titles,
descriptions, dates of creation/modification, and users associated with creation/modification)

+ User profile information (for example, full name, phone number, and email address)

The Vibe database disk space requirements are relatively modest, because the database is not used
for storing files.

Vibe File Repository

The Vibe file repository holds all files that are imported into Vibe, information related to the imported
files (such as thumbnails and HTML renderings), and the search engine index.

The Vibe file repository disk space requirements depend on the size of the Vibe site. For a large Vibe
site, disk space requirements can be substantial.

Lucene Index
The Lucene Index Server is a high-performance Java search engine. The Lucene index contains

pointers to the actual data stored in the Vibe file repository. The index enables the Lucene search
engine to perform very fast searches through large quantities of Vibe data.

Vibe Configurations

You can configure Micro Focus Vibe to run on a single server or multiple servers, depending on the
size and needs of your Vibe site.

Configuration Description

Single Server By default, the Vibe Installation program installs all Vibe components on the same
server.

Remote Database For better performance and scalability, you can install the Vibe database on a remote

Server server.

Remote Lucene Index For better performance and scalability, you can install the Lucene index on a remote
Server server.

Multiple Vibe Servers By running Micro Focus Vibe on multiple servers, you can achieve high availability,
including failover and load balancing, depending on how you configure your servers.

Multiple Remote Your Micro Focus Vibe site depends on the Lucene Index Server for full functionality.

Lucene Servers Running multiple Lucene Index Servers provides high availability, so that if one Lucene
Index Server goes down, Vibe users can still access the Vibe site because other
Lucene Index Servers are still available.

Multiple Remote Each of the three databases supported by Vibe has its own approach to clustering the
Database Servers database server. Information about clustering database servers is available on the
Internet.

For more information about which configuration type will best achieve the needs of your organization,
see “Recommended Hardware Configurations Based on System Performance” on page 26.

For more information about how to set up these configurations, see Part V, “Multi-Server
Configurations and Clustering,” on page 135.

What Is Micro Focus Vibe? 17
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Vibe System Requirements

You, as a Micro Focus Vibe site administrator, must ensure that your system meets Vibe system
requirements, so that your Vibe site can be set up successfully. After your Vibe site is set up, you
must ensure that users’ browsers and office applications meet Vibe user requirements, so that users
can access the Vibe site successfully.

+ “Vibe Server Requirements” on page 19

+ “Vibe User Requirements” on page 22

+ “Desktop Requirements” on page 24

+ “Mobile Requirements” on page 24

+ “Supported Environments” on page 25

+ “Recommended Hardware Configurations Based on System Performance” on page 26

For the latest system requirements details, see the Micro Focus Vibe 4.0.4 Release Notes.

Vibe Server Requirements

+ “Hardware Requirements” on page 19

+ “Operating System Requirements” on page 20

+ “Database Server Requirements” on page 20

+ “Java Developer Kit (JDK) Requirements” on page 20

+ “Java Cryptography Extension (JCE) Requirements” on page 21
+ “Directory Service Requirements” on page 21

+ “Disk Space Requirements” on page 22

+ “Other Requirements” on page 22

Hardware Requirements

Item Requirement

Processor * x86-32 or x86-64
¢ Minimum 2 GHz

* Multi-CPU systems preferred

Server Memory + Atleast 3 GB RAM for an x86-32 processor
+ Atleast 4 GB RAM for an x86-64 processor

See “Recommended Hardware Configurations Based on System
Performance” on page 26 and “Vibe Server Memory” on page 53.
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Operating System Requirements

One of the following operating systems for the Vibe server.

Platform Requirement

Linux + Novell Open Enterprise Server 11 or later, plus the latest Support Pack

¢ SUSE Linux Enterprise Server (SLES) 11 or SLES 12, plus the latest
Support Pack
NOTE: On SLES, the X Window System is required by the GUI Vibe

installation program. However, it is not required in order to run Vibe after
installation, or for text-based installations or silent installations.

Windows * Windows Server 2008 R2, Windows Server 2012 R2, or Windows 2016,
plus the latest applicable Service Pack

See “Virtualization Support” on page 26 for information about support for running Vibe in a virtualized
environment.

Database Server Requirements

One of the following:

Platform Requirement

Linux + MariaDB 10 on SLES 12 server and client
+ MySQL 5.1 or later server and client on SLES 11
+ Oracle 11g or Oracle 12c
* PostgreSQL 9.4.x

Windows + MariaDB 5.2.6 or later server and tools
* MySQL 5.1 or later server and tools
+ Microsoft SQL Server 2008 R2 on Windows Server 2008 R2
+ Microsoft SQL Server 2012 R2 on Windows Server 2012 R2
+ Microsoft SQL Server 2014 R2 on Windows Server 2012 R2
+ Microsoft SQL Server 2016 on Windows Server 2016
+ Oracle 11g or Oracle 12c
* PostgreSQL 9.4.x

Java Developer Kit (JDK) Requirements

One of the following JDKs:

20 Vibe System Requirements



Platform Requirement

Linux + |IBM JDK 8 (JDK 7 is no longer supported)

Java scripting must be enabled for proper Vibe site functionality.
+ Oracle JDK 8 (latest version)

IMPORTANT: OES 2018 installs the Open JDK by default, which doesn’t
work with Vibe.

We strongly recommend that you add the Oracle JDK to the OES 2018
server and reference it when configuring Vibe.

Windows + Oracle JDK 8 (latest version)

More information about JDKSs is available in “Java Development Kit (JDK)” in Appendix A, “Vibe
System Requirements Assistance,” on page 231.

Java Cryptography Extension (JCE) Requirements

JCE policy files that match your chosen JDK.

Platform Requirement
Linux + Unrestricted SDK JCE policy files
Windows + Unrestricted SDK JCE policy files

More information about JDKs is available in “Java Cryptography Extension (JCE)” in Appendix A,
“Vibe System Requirements Assistance,” on page 231.

Directory Service Requirements

One of the following directory services:

Platform Requirement

Linux + eDirectory 8.8 or later, plus the latest Support Pack

+ eDirectory 9.0.3 or later, plus the latest Support Pack

For information about eDirectory, see the eDirectory Online Documentation (http:/

www.novell.com/documentation).

Windows + Microsoft Active Directory, plus the latest Service Pack

* Novell eDirectory 8.8 or later, or eDirectory 9.0.3 or later, plus the latest
Support Pack

For information about Active Directory, see Windows Server 2003 Active Directory

(http://www.microsoft.com/windowsserver2003/technologies/directory/
activedirectory) or Windows Server 2008 Active Directory (http://
www.microsoft.com/windowsserver2008/en/us/active-directory.aspx).

Vibe System Requirements
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Disk Space Requirements

Item

Requirement

Vibe software

Database server software

Vibe file repository

Database content

At least 500 MB for a new installation

When you update an existing Vibe system, ensure that your server has at
least twice the amount of disk space available in the following directory, plus
an additional 500 MB:

Linux: /var/ opt/novel | / t eani ng
Windows: c:\Program Files\Novell\Teaming
At least 500 MB for a new installation

When you update an existing Vibe system, ensure that your server has at
least twice the amount of disk space available in the following directory, plus
an additional 500 MB:

Linux: /var/ opt/novel | / t eam ng
Windows: c:\Program Files\Novell\Teaming
Depends on the anticipated size of the Vibe site
Substantially less than the Vibe file repository

See “Planning the Vibe Database” on page 60 to plan for the disk space
needs of your Vibe site.

Other Requirements

Requirement

Additional Information

Tomcat 8

TrueType fonts

Tomcat 8 is included with Vibe on Linux and Windows.

If you are installing Vibe in a non-GUI Linux environment, you might need to
manually install the TrueType fonts if they are not already installed. TrueType
fonts enable Stellent converters to function properly for document conversions.
For more information, see “Understanding and Configuring Document
Conversions with Oracle Outside-In Technology” in the Micro Focus Vibe 4.0.4
Administration Guide.

Vibe User Requirements

+ “Browser Requirements” on page 23

+ “Office Application Requirements” on page 23

+ “Collaboration Client Requirements” on page 24
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Browser Requirements

Platform Requirement
Linux * Mozilla Firefox (latest version)
Windows + Microsoft Internet Explorer 11 or later (must not have the Google Chrome
Frame plug-in installed)
* Mozilla Firefox (latest version)
+ Google Chrome (latest version)
+ Microsoft Edge (latest version)
Mac * Safari (latest version)

+ Mozilla Firefox (latest version)

+ Google Chrome (latest version)

Office Application Requirements

Table 2-1 Desktop OS

Platform Requirement
Linux N/A
Windows + Microsoft Office 2013
+ MS Office 2016 (not Office 365)
Mac N/A

Table 2-2 Workstation OS

Platform

Requirement

Linux

Windows

Mac

*

LibreOffice (latest version)

*

MS (latest version)

* Microsoft Office 2010

+ MS Office 2013

+ MS Office 2016 (not Office 365)
+ LibreOffice (latest version)

+ OpenOffice (latest version)

+ Windows 10 Drive Mapping via WebDAV Permalink

+ MS Office 2016 for Mac

Edit-in-place functionality requires launching a Java Web Start. Most browsers now require
downloading and opening a do. j nl p file for this.
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OpenOffice and LibreOffice are used synonymously throughout the Micro Focus Vibe documentation.
Functionality and issues that apply to OpenOffice also apply to LibreOffice.

Collaboration Client Requirements

Platform Requirement

Linux * GroupWise 2014 with the latest Support Pack

+ GroupWise 2012 with the latest Support Pack

Windows * GroupWise 2014 with the latest Support Pack

+ GroupWise 2012 with the latest Support Pack

Desktop Requirements

You can download Windows and Mac desktop applications that allow you to work with Vibe files
directly from the file system on your computer. The following operating systems are supported:

Platform Requirement
Windows Windows 7, 8.1, and 10
Mac Mac OSX 10.10 and later

Mobile Requirements

You can download a native application for your iPhone, iPad, Android, or BlackBerry device. These
applications have a more polished user interface and don’t require you to sign in each time you
access Vibe. However, the mobile app for Vibe does not store information on your device; information
can be viewed only when you have an Internet connection.

Other devices can access the Vibe mobile interface by using a mobile browser that meets the
requirements listed in “Mobile Browser Requirements” on page 25.

*

*

“Mobile App Requirements” on page 24

“Mobile Browser Requirements” on page 25

Mobile App Requirements

Micro Focus Vibe mobile apps are available for the following mobile operating systems:

*

iOS (native application is available for both the iPhone and iPad for a free download in the Apple
App Store for iOS 7 or later)

Android (native application is available for a free download in the Google Play App Store for
Android 2.3 or later)

Windows phones version 8.0 and 8.1

Windows tablets are not currently supported.
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+ Kindle Fire (native application is available for a free download in the Amazon Appstore for
Android)

+ BlackBerry Z10 and PlayBook (native application is available for a free download in the
BlackBerry World store)

Your device’s browser must also meet the requirements that are discussed in Mobile Browser
Requirements.

Mobile Browser Requirements

To access Vibe from a browser on a mobile device, your device’s browser must support the following:

¢ HTML 4
+ JavaScript

Supported Environments

+ “File Viewer Support” on page 25

+ “IPV6 Support” on page 25

¢ “Clustering Support” on page 25

+ “Virtualization Support” on page 26

+ “Single Sign-On Support” on page 26

+ “Linux File System Support” on page 26

File Viewer Support

In Micro Focus Vibe, file viewing capabilities are provided by Oracle Outside In viewer technology.
See “Oracle Outside In Technology 8.3 Supported Formats” (http://www.oracle.com/us/026956.pdf)
for a list of the supported file formats. See “Oracle Outside In Technology” (http://www.oracle.com/
technologies/embedded/outside-in.html) for background information about the Oracle viewer
technology included in Vibe.

The file viewers also support data indexing by the Lucene Index Server.

IPV6 Support

Micro Focus Vibe supports the IPV6 protocol when it is available on the server. If the protocol is
available, Vibe detects it and supports IPV6 by default, along with IPV4.

Clustering Support

You can install Vibe components on multiple servers to provide failover support, as described in
Part V, “Multi-Server Configurations and Clustering,” on page 135.
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Virtualization Support

You can install Vibe in virtual environments where a software program enables one physical server to
function as if it were two or more physical servers.

Micro Focus tests the Vibe software on both Xen and VMware platforms. Vibe is supported on these
platforms, as well as other virtualization platforms, such as Microsoft Hyper-V. If you encounter an
issue that cannot be duplicated in a Micro Focus test environment, you may be responsible for
following up with the provider of your virtualization software.

For more information about virtualization support on SUSE Linux Enterprise Server, see the SLES
Documentation website (https://www.suse.com/documentation/sles11/#additional).

For more information about VMware virtualization support, see the VMWare website (http://
www.vmware.com).

Single Sign-On Support

Micro Focus Access Manager can be used to provide single sign-on capabilities for your Vibe site.
For setup instructions, see “Configuring Single Sign-On with Novell Access Manager” on page 111.

Linux File System Support

The following file systems are supported for Vibe running on Linux:

+ ext3 (recommended in most cases)

NOTE: The maximum number of file entries in a Vibe File folder cannot exceed 31,998 when
using the ext3 file system.

+ NSS (recommended if you are running OES Linux and need the feature-rich environment of
NSS)

+ reiser3

Recommended Hardware Configurations Based on
System Performance

Because of the wide variety of ways you can use Vibe, the recommendations given in this section are
only guidelines.

The hardware configuration that you set up for your Micro Focus Vibe site should be based on the
following considerations:

+ Number of active users that the Vibe site must support: Users who have accounts in the
Vibe system but do not log in to the system should not be considered in this number. For
example, if there are 1,000 users in the Vibe system but only 300 access the system on a regular
basis, the number of active users is 300.

+ Content the users will add: The type of content that is shared and stored on your Vibe site.
The number of active users in the system is a good indicator of what the hardware configuration
of your system should be, but you should also keep in mind that the type of content that is
shared and stored on your Vibe site has a significant effect on the amount of disk space and
memory that is required.
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For example, your users might add the following types of content:

+ Multimedia documents, such as CAD and PowerPoint documents (requires the most
system resources)

+ Other documents, such as text documents and photos

+ Vibe entries that do not contain attachments, such as blog entries and discussion entries
(requires the least amount of system resources)

For example, if you have a Vibe installation with only 400 active users, but those users often upload
and share CAD files, you might want to configure a dedicated SQL server where those files can be

stored. In addition, provide a larger CPU, increased memory, and a larger Java heap to more
efficiently upload and search for the files.

Server machines can be physical or virtual.

+ “Configuration Based on Installation Size” on page 27
+ “Test Installation” on page 28

+ “Small Installation” on page 29

+ “Medium Installation” on page 29

+ “Large Installation” on page 30

+ “Very Large Installation” on page 32

Configuration Based on Installation Size

The following table shows the recommended hardware configuration based on the size of the Vibe

installation. For more detailed information about each type of installation, click the installation size in

the column header.

Test Installation Small Medium Large Very Large
Installation Installation Installation Installation

Single Server X X
Only

Remote X
Database
Server

Remote Vibe X X
Desktop
Server

Remote Vibe
Add-In or
WebDAV
Server

Remote Lucene X
Index Server

Remote File X X
Repository

Multiple Vibe X X
(Tomcat)
Servers
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Test Installation Small Medium Large Very Large
Installation Installation Installation Installation

Multiple X
Remote Lucene
Servers

Multiple X X
Remote

Database

Servers

Multiple X
Remote Vibe

Desktop

Servers

Multiple X
Remote Vibe
Add-In Servers

Test Installation

Tomcat
Lucene Index
SQL Database
File System
Vibe Desktop

This deployment is suitable for a single-person evaluation or minimal usage by a small group.

Vibe Components CPU Memory Java Heap
1 dedicated Vibe (Tomcat) server with: 3Ghz x86 or x64, single- 4-8 GB 2-6 GB
core or dual-core
* Lucene
¢+ SQL

+ File System
+ Vibe Desktop
+ Vibe Add-In

For more information about installing a basic, single-server Vibe site, see Part Ill, “Basic Installation,’
on page 49.

You can perform a Basic installation to set up a single-server configuration, as described in
Chapter 8, “Planning a Basic Vibe Installation,” on page 51 and Chapter 9, “Installing and Setting Up
a Basic Vibe Site,” on page 71.
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Small Installation

Tomcat Tomcat

Lucene Index (for Vibe Desktop
SQL Database if more than 100
File System active users)

This deployment is suitable for a workgroup, department, or small company. All components are on a
single server but are running typical memory allocations. If Vibe Desktop is being used with more
than 100 active users, it must be running on one or more separate Vibe (Tomcat) servers.

Vibe Components CPU Memory Java Heap

Multiple Vibe servers: 3Ghz x86 or x64, dual- 4-8 GB 2-6 GB

core or quad-core
+ 1 dedicated Vibe (Tomcat) server

with SQL and file system

+ 1 dedicated Vibe (Tomcat) server
with Vibe Desktop for 100 or fewer
active users; 2 dedicated Vibe
(Tomcat) servers with Vibe Desktop
for more than 100 active users

For more information about installing a basic, single-server Vibe site, see Part Ill, “Basic Installation,”
on page 49.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how to
distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Configuring Vibe
Desktop and the Microsoft Office Add-In" in “Site Setup” in the Micro Focus Vibe 4.0.4 Administration
Guide.

You can perform a Basic installation to set up a single-server configuration, as described in
Chapter 8, “Planning a Basic Vibe Installation,” on page 51 and Chapter 9, “Installing and Setting Up
a Basic Vibe Site,” on page 71.

Medium Installation

<5} <

v

Tomcat Tomcat Tomcat
(for Vibe Desktop) Lucene Index (for Vibe Desktop
File System if more than 100

active users)
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This deployment is suitable for a medium-to-large business. The database server is separate, to
increase the amount of parallel processing in the system. The database can be a single server or a
cluster of database servers. More memory is also allocated to the Vibe server. If Vibe Desktop is
being used with more than 100 active users, it must be running on multiple separate Vibe (Tomcat)
servers.

Vibe Components CPU Memory Java Heap
Multiple Vibe servers: 3Ghz x86 or x64 quad- 4-8 GB 6 GB
core

+ 1 dedicated Vibe (Tomcat) server
with file system

+ 1 or more dedicated SQL servers
+ 2 dedicated Lucene servers

+ 2 or more dedicated Vibe (Tomcat)
servers with Vibe Desktop

For information on how to create a separate Vibe database, follow the instructions specific to your
database type, as described in Chapter 18, “Creating the Vibe Database on a Remote Server,” on
page 137.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how to
distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Configuring Vibe
Desktop and the Microsoft Office Add-In" in “Site Setup” in the Micro Focus Vibe 4.0.4 Administration
Guide.

You can perform a Basic installation to set up a multiple-server configuration (as described in
Chapter 8, “Planning a Basic Vibe Installation,” on page 51 and Chapter 9, “Installing and Setting Up
a Basic Vibe Site,” on page 71); however, the remote database must be created manually and in
advance of performing the installation, as described in Chapter 18, “Creating the Vibe Database on a
Remote Server,” on page 137.

Large Installation

iy, BN HR

Tomcat Tomcat SQL database

(for Vibe Desktop) / \

File System Lucene Index

This deployment is suitable for a large business. This deployment uses load balancing across all
servers. The database server is separate, to increase the amount of parallel processing in the
system. The index server is separate, to allow the application to better utilize the physical memory
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that is allocated. The file system is separate, and a SAN file system is recommended. The memory
utilization of the index server is proportional to the index size, which is directly related to the number
and size of documents and entries that are stored. As the number and size of documents and entries
that are stored increases, you should increase the amount of memory accordingly. If Vibe Desktop is
being used with more than 100 active users, it must be running on multiple separate Vibe (Tomcat)
servers.

Vibe Components CPU Memory Java Heap
Multiple Vibe servers: 3Ghz x64 quad-core or 8- 4-8 GB 6 GB
core

+ 3-5 dedicated Vibe (Tomcat)
servers

+ 2 dedicated Lucene servers
+ 2 dedicated SQL servers

+ 1 dedicated file system server (SAN
is recommended)

+ 2 or more dedicated Vibe (Tomcat)
servers with Vibe Desktop

For more information on load balancing, see “Configuring a Web Application to Provide High
Availability Functionality for Your Vibe Site” on page 153.

For information on how to create a separate Vibe database, follow the instructions specific to your
database type, as described in Chapter 18, “Creating the Vibe Database on a Remote Server,” on
page 137.

For information on how to create a separate index server, see Chapter 19, “Installing the Lucene
Index Server on a Remote Server,” on page 145.

For more information on how to create a separate file system server, see “Vibe File Repository
Considerations” on page 149.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how to
distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Configuring Vibe
Desktop and the Microsoft Office Add-In" in “Site Setup” in the Micro Focus Vibe 4.0.4 Administration
Guide.

You must perform an Advanced installation to achieve this type of deployment. For more information,
see Part 1V, “Advanced Installation and Reconfiguration,” on page 101.
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Very Large Installation

<5} Q&E -}

Tomcat Tomcat SQL database

(for Vibe Desktop) / \

File System Lucene Index

This deployment is suitable for a large business. This deployment uses load balancing across all
servers. The database server is separate, to increase the amount of parallel processing in the
system. The index server is separate, to allow the application to better utilize the physical memory
that is allocated. The file system is separate, and a SAN file system is recommended. The memory
utilization of the index server is proportional to the index size, which is directly related to the number
and size of documents and entries that are stored. As the number and size of documents and entries
that are stored increases, you should increase the amount of memory accordingly. If Vibe Desktop is
being used with more than 100 active users, it must be running on multiple separate Vibe (Tomcat)
servers.

Vibe Components CPU Memory Java Heap
Multiple Vibe servers: 3Ghz x64 quad-core or 8- 4-8 GB 6 GB
core

+ 4-8 dedicated Vibe (Tomcat)
servers

+ 2 dedicated Lucene servers
+ 2 dedicated SQL servers

+ 1 dedicated file system server (SAN
is recommended)

+ 2 or more dedicated Vibe (Tomcat)
servers with Vibe Desktop

For more information on load balancing, see “Configuring a Web Application to Provide High
Availability Functionality for Your Vibe Site” on page 153.

For information on how to create a separate Vibe database, follow the instructions specific to your
database type, as described in Chapter 18, “Creating the Vibe Database on a Remote Server,” on
page 137.

For information on how to create a separate index server, see Chapter 19, “Installing the Lucene
Index Server on a Remote Server,” on page 145.
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For more information on how to create a separate file system server, see “Vibe File Repository
Considerations” on page 149.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how to
distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Configuring Vibe
Desktop and the Microsoft Office Add-In" in “Site Setup” in the Micro Focus Vibe 4.0.4 Administration
Guide.

You must perform an Advanced installation to achieve this type of deployment. For more information,
see Part IV, “Advanced Installation and Reconfiguration,” on page 101.
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What's New in Vibe 4

This section describes new features and enhancements that have been added to Micro Focus Vibe 4.

*

*

*

*

*

Chapter 3, “New in Vibe 4.0.4,” on page 37
Chapter 4, “New in Vibe 4.0.3,” on page 39
Chapter 5, “New in Vibe 4.0.2,” on page 41
Chapter 6, “New in Vibe 4.0.1,” on page 43
Chapter 7, “New in Vibe 4.0,” on page 45

What's New in Vibe 4
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3 New in Vibe 4.0.4

The main focuses of the Vibe 4.0.4 release are

+ Edit-in-Place refinements

IMPORTANT: Starting with Vibe 4.0.4, the default solution for editing files that are accessed
through a web browser, has been switched from Java Applets to Microsoft Universal Resource
Identifier (MS URI) technology.

This only allows users to edit files from a Windows workstation with MS Office 2010 or later
installed. For more information about this change, see “Editing Files Accessed through a Web
Browser” in the Micro Focus Vibe 4.0.5 User Guide.

+ Security updates
+ Bug fixes.
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New in Vibe 4.0.3

The main focuses of the Vibe 4.0.3 release are

+ Support for PostgreSQL as a database. See “Database Server Requirements” on page 20 and
additional information in Database-related information in the Micro Focus Vibe 4.0.4
Administration Guide.

+ Support for GroupWise as an LDAP source. See “Adding Vibe Users from Your LDAP Directory”
on page 90 and additional information in the LDAP-related instructions in the Micro Focus Vibe
4.0.4 Administration Guide.

+ Bug fixes.
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New in Vibe 4.0.2

The main focuses of the Vibe 4.0.2 release are

+ Edit-in-place: Replacing the Java applet that supported edit-in-place functionality in previous
versions of Vibe with a new Java Web Start Launcher (do. j nl p) that downloads automatically
and can then be run by Vibe users as described in Editing Files Accessed through a Web
Browser in the Micro Focus Vibe 4.0.5 User Guide.

+ Custom JSPs: Addressing many of the concerns expressed by those using custom JSPs.

+ Vibe 3 rendering: Providing Vibe-3-level formatting of customized workspaces and folders for
those who are dissatisfied with the default GWT rendering in Vibe 4. See the Display using
Micro Focus Vibe 3 formatting option as documented for folders and workspaces.

+ Rebranding: Reflecting Micro Focus ownership and development.

The Vibe 4.0.2 development team has also delivered

+ An interim solution for the Java applet challenges seen by Vibe 4.0.1 users wanting to use Vibe’s

“Edit-in-Place” feature.

For Firefox users, the experience is exactly as it was before the browser withdrew NPAPI
support. Users of Chrome and Microsoft Edge browsers must choose to run the applet that is
automatically downloaded.

+ The ability for administrators to require Custom Terms and Conditions for external users.

+ Product improvement tracking of KeyShield use.

New in Vibe 4.0.2
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New in Vibe 4.0.1

Vibe 4.0.1 User Enhancements

See What's New in the Micro Focus Vibe Desktop 4.0.4 Release Notes.

Vibe 4.0.1 Administration Enhancements

*

Customized Email Notifications: “Customizing Email Templates” in the Micro Focus Vibe
4.0.4 Administration Guide.

User Visibility Management Enhancements: “Limiting User Visibility ” in the Micro Focus Vibe
4.0.4 Administration Guide.

KeyShield Two-Factor Authentication: “Configuring Two-Factor Authentication” in the Micro
Focus Vibe 4.0.4 Administration Guide.

LDAP for External Users: When defining an LDAP resource, you can now specify whether the
imported users are treated as internal or external by Vibe. See “Synchronizing Users and
Groups from an LDAP Directory” in the Micro Focus Vibe 4.0.4 Administration Guide.

MariaDB Support: See ““MySQL or MariaDB SQL Database Server” on page 234.”
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New in Vibe 4.0

Vibe 4.0 User Enhancements
For a list of Micro Focus Vibe user enhancements and instructions for use, see:

+ “What's New in Micro Focus Vibe 4.0” in the Micro Focus Vibe 4.0.5 User Guide
+ “What's New in Vibe 4.0” in the Micro Focus Vibe 4.0.5 Advanced User Guide

Vibe 4.0 Installation Enhancements
+ Database Changes: Vibe now requires you to create the database.

For more information about creating the database on Linux, see “Creating the Vibe Database” on
page 75.

For more information about creating the database on Windows, see “Creating the Vibe
Database” on page 84.

+ Specify File Types for Document Conversions during Installation: Previous versions of
Vibe allowed you to configure the file formats that could be converted to HTML by editing
configuration files. Vibe 4.0 provides a graphical interface during installation for configuring the
file formats that can be converted to HTML and viewed from Vibe.

For more information, see “Adding File Types for HTML Conversions” on page 67.

For more generic information on document conversions in Vibe, see “Understanding and
Configuring Document Conversions with Oracle Outside-In Technology” in the Micro Focus Vibe
4.0.4 Administration Guide.

+ Ability to specify a From email address for outbound email: You can specify an email
address to be used as the From address of emails sent from Vibe.

For more information, see “Outbound Email From Address” on page 65.

Vibe 4.0 Administration Enhancements
+ LDAP Synchronization Improvements: The following improvements were made to LDAP
synchronization:
+ Synchronization performance improvements
Performance improvements in Vibe 4.0 as compared with Vibe 3.4:
+ When synchronizing 1 to 10,000 users - 3x improvement
+ When synchronizing 10,000 to 30,000 users - 5x improvement
+ When synchronizing 30,00 to 60,000 users - 10x improvement
+ Improved interface, with a tabbed view
+ LDAP browser for selecting users and containers in your directory for LDAP configuration
+ Support for non-unique group names

+ Ability to preview an LDAP synchronization (display the users and groups that will be
added, deleted, or disabled in Vibe) before the LDAP synchronization runs

+ Filter users and groups on Sync Results pages
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For more information, see “Synchronizing Users and Groups from an LDAP Directory” in the
Micro Focus Vibe 4.0.4 Administration Guide.

+ Sharing: The following administration improvements were made for sharing:

+ Ability to determine whether LDAP groups can be used when sharing: New option to
allow you to control whether groups that were imported from the LDAP directory are
displayed in the Share with field when users are sharing an item.

+ Whitelist or blacklist for sharing: You can create a whitelist or blacklist for sharing with
certain email addresses and domains.

+ New sharing option for File Link: Grant users the ability to share files by distributing a link
to the file. Any person with access to the link then has access to the file.

For more information about sharing, see “Setting Up Sharing” in the Micro Focus Vibe 4.0.4
Administration Guide.

*

Ability to Reset the Administrator User ID: You can reset the user ID for the Vibe
administrator.

For more information, see “Changing the Vibe Administrator User ID or Password” in the Micro
Focus Vibe 4.0.4 Administration Guide.

+ Improved Method for Resetting Passwords: It is easier than ever for local and external users
to reset their passwords. This method also applies to the Vibe administrator.

For information about how to reset the password for the Vibe administrator, see “Changing the
Vibe Administrator User ID or Password” in the Micro Focus Vibe 4.0.4 Administration Guide.

+ New user interface for granting administrator privileges: It is now easier to grant
administrator rights to users and groups.

For more information, see Creating Additional Vibe Administrators.

+ Team management administration: You can more easily view and manage team workspaces
across your Vibe site.

For more information, see “Managing Team Workspaces” in the Micro Focus Vibe 4.0.4
Administration Guide.

*

Enhanced user and group management interface: For information, see “Managing Users”
and “Managing Groups” in the Micro Focus Vibe 4.0.4 Administration Guide.

*

Improved handling of external users: In Vibe 3.4, marking a user as external was a manual
process. External user accounts are now created automatically when a workspace, folder, or
entry is shared with someone outside of the organization.

External user accounts from Vibe 3.4 are maintained after upgrading to Vibe 4.

For more information, see “Setting Up Sharing” in the Micro Focus Vibe 4.0.4 Administration
Guide.

Ability to disable access to the web client: You can disable users’ ability to access Vibe via a
web browser. Users can then access Vibe only through Vibe Desktop or through the Vibe mobile

app.
For more information, see “Disabling User Access to the Vibe Site on the Web” in the Micro
Focus Vibe 4.0.4 Administration Guide.

Support for multiple groups with the same name: In the Type-to-Find drop-down list, Vibe
now includes the group name or group title, as well as secondary information about the group
(either the group description or the Fully Qualified DN). This secondary information helps
distinguish between multiple groups that have the same name.

*

*

*

Ability to specify a maximum number of REST requests: You can specify the maximum
number of concurrent upload and download requests made by Vibe Desktop and mobile
applications.
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For more information, see “Configuring Requests and Connections Configuration” on page 106.

Centralized Trash Management: All items that have been sent to the trash are now visible in
one location and can be restored or permanently deleted.

For more information, see “Permanently Deleting Files from the Trash” in the Micro Focus Vibe
4.0.4 Administration Guide.

Data Quota on Outgoing Mail Messages: You can set a data quota on outgoing mail
messages. The combined size of all attachments in a single outgoing email cannot exceed the
guota that you set.

For more information, see “Enabling/Disabling Outbound Emailing of Folder Digests” in the
Micro Focus Vibe 4.0.4 Administration Guide.

Download Vibe Desktop and Add-In from the Web Client: You can make the Vibe Desktop
and Vibe Add-In available to users from the Vibe web client.

For more information, see “Configuring the Vibe Desktop Application for All Users” in the Micro
Focus Vibe 4.0.4 Administration Guide.

Exporting and Importing Folders Includes Global Filters: When you export and import
folders out of and into Vibe, all global filters are included in the export and import. (Personal
filters are not included.)

Workspace Templates Can Be Created at a Non-Global Level: You can create workspace
templates and make them available to only specific workspaces, rather than making them
available at a global level.

Automatically Delete or Archive Audit Trail and Change Log Entries: You can configure
Vibe to automatically delete or archive Audit Trail and Change Log entries after a given number
of months. This is helpful if these logs are consuming a lot of disk space.

For more information, see “Managing Database Logs and File Archives” in the Micro Focus Vibe
4.0.4 Administration Guide.

Single Sign-On Support with KeyShield: You can provide single sign-on to your Vibe site with
KeyShield (KeyShield license not included).

For information, see “Configuring Single Sign-On with KeyShield” in the Micro Focus Vibe 4.0.4
Administration Guide.

Ability to Deter Brute-Force Attacks with CAPTCHA: By default, CAPTCHA (http://
en.wikipedia.org/wiki/CAPTCHA) is now enabled on the Vibe site, securing the Vibe web
application against brute-force attacks.

For information about how to customize when CAPTCHA is used on the Vibe site, see “Securing
against Brute-Force Attacks with CAPTCHA" in the Micro Focus Vibe 4.0.4 Administration
Guide.

For information about how to enable CAPTCHA and set various configuration options, see
Securing against Brute-Force Attacks with CAPTCHA.

Ability to Secure User Passwords: You can require the passwords of local and external users
to meet certain password requirements.

For more information, see “Securing User Passwords” in the Micro Focus Vibe 4.0.4
Administration Guide.
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I I I Basic Installation

+ Chapter 8, “Planning a Basic Vibe Installation,” on page 51

+ Chapter 9, “Installing and Setting Up a Basic Vibe Site,” on page 71
+ Chapter 10, “Adding Users to Your Vibe Site,” on page 89

+ Chapter 11, “Updating Your Vibe License,” on page 91

+ Chapter 12, “Setting Up Vibe,” on page 93

+ Chapter 13, “Basic Vibe Installation Summary Sheet,” on page 95
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8 Planning a Basic Vibe Installation

The installation program for Micro Focus Vibe helps you install the Vibe software and file repository to
the appropriate locations.

+ “What Is a Basic Vibe Installation?” on page 51

+ “Selecting the Operating Environment for Your Vibe Server” on page 52

+ “Selecting a Java Development Kit” on page 55

+ “Gathering Network Information for Your Vibe Site” on page 55

+ “Planning the WebDAV Authentication Method” on page 58

+ “Planning the Vibe Database” on page 60

¢ “Gathering Outbound Email Information” on page 63

+ “Enabling Inbound Email” on page 65

+ “Adding File Types for HTML Conversions” on page 67

+ “Planning Site Security” on page 67

+ “Gathering Directory Services Information” on page 68

+ “Accommodating Multiple Languages” on page 69

What Is a Basic Vibe Installation?

The Micro Focus Vibe installation program provides two installation types: Basic and Advanced.
When you perform a Basic installation, the result is a fully functional Vibe site with all required options
configured and with typical defaults in use for optional settings.

If you are new to Vibe, the easiest way to get started is to perform a Basic installation first, with all
Vibe components installed on the same server. Then you can add advanced configuration options to
your Vibe site after the Basic installation has been successfully tested. However, experienced Vibe
administrators can choose to perform an Advanced installation immediately, which includes all
installation and configuration options, as described in Part 1V, “Advanced Installation and
Reconfiguration,” on page 101.

IMPORTANT: The following Vibe configurations require that you perform an Advanced installation as
your initial installation of the Vibe software:

+ Setting up the Vibe file repository so that some types of files are located outside the Vibe file
repository root directory. See “Distributing Different Data Types to Different Locations” on
page 104 for Advanced installation instructions. You cannot move subdirectories within the Vibe
file repository after they have been created.

+ Installing the Vibe software on multiple servers to create a clustered environment. See
Chapter 20, “Running Vibe on Multiple Servers,” on page 149 for Advanced installation
instructions. The option to enable a clustered environment is available only during an Advanced
installation.

If you want to implement an Advanced installation option, you should perform a Basic installation first,
in a test environment, before performing the Advanced installation to set up your permanent Vibe site.
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This section helps you make informed decisions about the required options for a Basic installation:

¢ Server platform (Linux or Windows)

+ Server architecture (32-bit or 64-bit)

+ Physical server memory requirements

+ File locations (Vibe software and data)

+ Java Development Kit (JDK) version (Sun or IBM)

+ Database type (MySQL/MariaDB, Microsoft SQL Server, or Oracle)

+ Database creation (during installation or before installation)

+ Database authentication (user name and password)

+ Network information (Vibe server hostname or fully qualified domain name, and ports)

¢ Outbound email configuration (SMTP vs. SMTPS, hosthame, SMTP port, time zone,
authentication)

+ Inbound email configuration (SMTP address, SMTP port, and TLS support)
+ User and group for running the Vibe software (Linux only)

Before performing a Basic installation, ensure that all system requirements are met, as listed in
Chapter 2, “Vibe System Requirements,” on page 19.

As you proceed with planning, you can use the Basic Vibe Installation Summary Sheet to record your
decisions about the options you want to use.

Selecting the Operating Environment for Your Vibe
Server

+ “Vibe Server Platform” on page 52

+ “Vibe Server Architecture” on page 52

+ “Vibe Server Memory” on page 53

+ “Vibe Installation Locations” on page 54

+ “TrueType Font Location (Linux Only)” on page 55

Vibe Server Platform

Micro Focus Vibe can run on the versions of Linux and Windows listed in “Vibe Server Requirements”
on page 19.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Vibe Server Platform, mark your operating system of choice.

Vibe Server Architecture

Vibe can run on 32-bit or 64-bit processors. A 64-bit processor is recommended for a large Vibe site
where the processor load is heavy and data storage requires a large amount of disk space.
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BASIC VIBE INSTALLATION SUMMARY SHEET

Under Processor Architecture, mark the processor capacity required for the size of Vibe site that you
want to set up.

Vibe Server Memory

If a 32-bit processor is sufficient for your Vibe server, the server needs at least 3 GB of memory. If you

plan to use a 64-bit processor in your Vibe server, the server needs more.
Vibe server memory usage is significantly affected by some factors and less affected by others:

+ Number of users logged in: No significant effect.
+ Number of concurrent active sessions: No significant effect.
+ Database server caches: Significant memory usage.

When you follow the instructions for a Basic installation, the database is located on the same
server as the Vibe software. After you have successfully tested your Basic installation, you can
reconfigure Vibe to have its database on a remote server, so that the database uses separate

memory resources, as described in Chapter 18, “Creating the Vibe Database on a Remote
Server,” on page 137.

+ Vibe internal data caches: Significant memory usage.

When you follow the instructions for a Basic installation, the Vibe internal data caches are
subdirectories of the t eani ngdat a directory, described in “Vibe Installation Locations” on

page 54. The Vibe internal data caches are separate from any caching or memory usage by the

database server itself.
+ Lucene index cache: Significant memory usage.
The Lucene Index Server is a high-performance Java search engine. Large file repositories

(particularly with large files or a large number of files) can create a very large data index. When
you perform a Basic installation, the Lucene index is created on the same server where the Vibe

software is installed. After you have successfully tested your Basic installation, you can

reconfigure Vibe to have its Lucene index on a remote server, so that it uses separate memory

resources, as described in “Installing the Lucene Index Server on a Remote Server” on
page 145.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Memory Requirements, specify the amount of physical memory you plan to have for your Vibe
server.

When you perform a Basic installation, the default amount of memory allocated to the Java Virtual

Machine (JVM) where the Vibe software runs is 1 GB, which is adequate for a medium-sized Vibe site

running on a 32-bit server. This memory allocation, called the Java “heap size,” does not include
memory used by your database server or by the Lucene Index Server when these programs are
running on the same server as the Vibe software.

A general rule is that no more than 75% of the available physical memory should be allocated to the

JVM. Memory not allocated to the JVM must be sufficient to support the operating system, the

database server, and the Lucene Index Server if they are also running on the Vibe server, and any

other processes running on the Vibe server.
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IMPORTANT: A JVM on a 32-bit server should not be configured to take more than 1.5 G of memory.
However, large numbers of users and documents often need memory settings higher than 2 GB to
provide adequate performance. This type of Vibe system should be set up on 64-bit hardware.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location, specify the amount of memory to allocate to the JVM where Vibe runs.

Although it is possible to run Vibe with less than 1 GB of memory for the JVM, this applies only to very
small test configurations, and is not suitable for production systems. In a test configuration, 512 MB is
the minimum amount of memory required to produce a functioning Vibe installation.

Vibe Installation Locations

The default file location for the Vibe software varies by platform:

Linux: /opt/novel | / t eani ng

Windows: c:\ Program Fi |l es\ Novel |\ Team ng

Included under the main Vibe software directory are subdirectories for Tomcat and file viewer
software.

The default file location for the Vibe file repository also varies by platform:

Linux: /var/ opt/novel I/t eam ng

Windows: c:\ Novel I\ Team ng

IMPORTANT: On Windows, the Vibe installation program displays the Windows pathname with
forward slashes (/) rather than the traditional backslashes (). This syntax is hecessary in the
installation program.

The Vibe file repository holds all files that are imported into Vibe, information related to the imported
files, such as thumbnails and HTML renderings, and the search engine index.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under File Locations, specify the directories where you want to install the Vibe software and data if you
prefer not to use the default locations.

A Basic installation allows you to change the root directory for the Vibe software and the Vibe file
repository.

IMPORTANT: If you want to organize the Vibe file repository so that some file types are not under the
Vibe file repository root directory, you must perform an Advanced installation as your initial Vibe
installation. You cannot move directories out of the Vibe file repository root directory after the initial
installation has been performed. To perform an Advanced installation in order to organize the Vibe file
repository to meet your needs, complete the planning steps for a Basic installation and complete the
Basic Vibe Installation Summary Sheet, then follow the additional instructions in “Distributing Different
Data Types to Different Locations” on page 104.
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TrueType Font Location (Linux Only)

The Oracle Outside In viewer technology used by Micro Focus Vibe to render various file formats into
HTML for viewing requires access to TrueType fonts. Typical locations for these fonts include the
following:

[usr/ X11R6/ i b/ X11/fonts/truetype
/usr/share/fonts/truetype

If the TrueType font location is not correct, thumbnails are not displayed correctly on the Vibe site.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under TrueType Font, specify the directory that contains the TrueType font location.

Selecting a Java Development Kit

As listed in “Vibe Server Requirements” on page 19, you need to install a Java Development Kit
(JDK) before you install Micro Focus Vibe. You can use either the Sun JDK or the IBM JDK for the
platform where you are installing Vibe (Linux or Windows).

If you want to use an SSL connection between your Micro Focus Vibe site and a WebDAV server, and
if the WebDAV server has a self-signed certificate rather than a certificate provided by a certificate
authority, you must use the Sun JDK. The existing Vibe functionality for handling self-signed
certificates is not compatible with the way the IBM JDK handles self-signed certificates.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java Development Kit, mark the JDK that you want to use with Vibe.

You must install the JDK on the Vibe server before you install the Vibe software. If you are not familiar
with installing a JDK, see “Java Development Kit (JDK)” in Appendix A, “Vibe System Requirements
Assistance,” on page 231.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java Development Kit, specify the directory where you have installed the JDK.

The Vibe Installation program uses this path as if you had set the JAVA_HOME environment variable.
The path is stored for future reference in the i nstal | er. xni file so that you need to specify the path
to the JDK only once.

Gathering Network Information for Your Vibe Site

When you perform a Basic installation, the Micro Focus Vibe installation program needs hostname
and HTTP port information about the server where you are installing Vibe.

+ “Host Identification” on page 56

+ “Port Numbers” on page 56
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Host Identification

When you install Vibe, the Vibe installation program needs to know the name of the server where you
are installing the Vibe software. The default is | ocal host . Do not use the default.

For internal use, you can use the DNS hostname of the Vibe server. However, if you want your Vibe
site to be accessible from the Internet, you must specify the fully qualified domain name for the Vibe
server in order to allow external access.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the hostname or fully qualified domain name to use for the Vibe
server.

Port Numbers

When you install Vibe, Tomcat is installed along with the Vibe software. Vibe uses Tomcat as a
standalone web server for delivering data to Vibe users in their web browsers. For more information
about Tomcat, see the Apache Tomcat website (http://tomcat.apache.org).

IMPORTANT: If the server where you want to install Vibe already has a web server running on it, shut
it down while you install and test Vibe. The instructions for a Basic Vibe installation assume that no
other web server is running on the Vibe server. If you want to maintain another web server on the
Vibe server, you are responsible for resolving any port conflicts that might arise.

On the command line, use the net st at command to see what ports are currently in use on the server
where you plan to install Vibe:

Linux: netstat -tan

Windows: netstat -a -n -p tcp

Ensure that the port numbers that you specify during Vibe installation do not conflict with ports that
are already in use on the server.

¢ “HTTP/HTTPS Ports” on page 56

¢ “HTTP/HTTPS Ports When You Use Novell Access Manager with Vibe” on page 57
+ “Shutdown Port” on page 58

+ “AJP Port” on page 58

HTTP/HTTPS Ports

By default, standard web servers such as Apache and Microsoft Internet Information Services (1IS)

use port 80 for non-secure HTTP (Hypertext Transfer Protocol) connections and port 443 for secure
HTTPS connections. HTTPS connections use SSL (Secure Sockets Layer) for added security. As a
result, web browsers default to port 80 when no port is specified in a non-secure HTTP URL and to
port 443 when no port is specified in a secure HTTPS URL.

Tomcat defaults to port 8080 for non-secure HTTP connections and to port 8443 for secure HTTPS
connections, so that it does not conflict with the standard web server port numbers. If you configure
Vibe with the Tomcat default port numbers, users must include the appropriate port number when
providing the Vibe site URL. Typically, users prefer not to do this.
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Unfortunately, the situation is not as simple as just configuring Vibe to use the default port numbers of
80 and 443. On Linux, non-r oot processes are not allowed access to port numbers lower than 1024
and you are counseled against running Vibe as r oot in “Linux User ID for Vibe” on page 68. Also on
Linux and Windows, the default Tomcat installation expects ports 8080 and 8443.

For a Basic installation, you can use the default port numbers as presented by the Vibe Installation
program:

HTTP port: 80

Secure HTTP port: 443
Listen port: 8080
Secure listen port: 8443

IMPORTANT: If you are installing Vibe on Novell Open Enterprise Server 2, port 80 is already in use
by iManager. In order for Vibe to listen on port 80 (which is the standard port), you need to change
iManager to listen on a non-standard port, such as 81.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, the default port numbers have been provided for you. You need to specify
different port numbers only if you anticipate port conflicts with other software on the Vibe server.
Resolving port conflicts is beyond the scope of this Vibe documentation.

After you install Vibe on Linux, you need to complete the steps in “Setting Up Port Forwarding” on
page 78 so that users are not required to include the port number in the Vibe URL.

If you want to use secure HTTPS connections for your Vibe site, you must obtain signed certificate
files as described in “Preparing for Secure HTTP Connections” in “Site Security” in the Micro Focus
Vibe 4.0.4 Administration Guide either before or after you install Vibe.

HTTP/HTTPS Ports When You Use Novell Access Manager with Vibe

If you are fronting Vibe with Novell Access Manager, ensure that you have configured the HTTP/
HTTPS ports as described in the following sections, depending on the operating system where Vibe
is running.

Configuring Vibe in this way configures Novell Access Manager to access Vibe over port 80, which is
the standard port.

+ “Windows Port Configuration” on page 57

+ “Linux Port Configuration” on page 58

Windows Port Configuration

Use the following port configuration when Novell Access Manager is fronting your Vibe system on
Windows:

HTTP Port: 80
Secure HTTP Port: 443
Listen Port: 80

Secure Listen Port: 443
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Linux Port Configuration

Use the following port configuration when Novell Access Manager is fronting your Vibe system on
Linux:

HTTP Port: 80

Secure HTTP Port: 443
Listen Port: 8080
Secure Listen Port: 8443

With this suggested configuration on Linux, you also need to set up port forwarding, as described in
“Setting Up Port Forwarding” on page 78.

Shutdown Port

By default, Vibe uses 8005 as its shutdown port. For an explanation of the shutdown port, see Tomcat
- Shutdown Port (http://www.wellho.net/mouth/837_Tomcat-Shutdown-port.html).

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the port you want Vibe to use as its shutdown port if the default of
8005 is already in use on the Vibe server.

AJP Port

By default, Vibe uses 8009 as its AJP port. For an explanation of the Apache JServ Protocol port, see
The AJP Connector (http://tomcat.apache.org/tomcat-6.0-doc/config/ajp.html).

IMPORTANT: If you are installing Vibe on Novell Open Enterprise Server, port 8009 is already in use,
so you need to select a different port, such as 8010.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the port you want Vibe to use as its AJP port if the default of 8009 is
already in use on the Vibe server.

Planning the WebDAYV Authentication Method

+ “Understanding WebDAV” on page 59
+ “Choosing the WebDAV Authentication Method” on page 59
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Understanding WebDAV

WebDAV is a standard collaborative editing and file management protocol. Micro Focus Vibe relies on
the WebDAV protocol for two key features:

+ Edit-in-Place for using tools such as OpenOffice and Microsoft Office, as described in “Editing
Files Accessed through a Web Browser” in the Micro Focus Vibe 4.0.5 User Guide.

+ Mapping Vibe folders as a web folder on the client computer, which allows access to Vibe files
from a WebDAV-compliant file navigation tool such as Windows Explorer or Nautilus, as
described in “Creating a Mapped Drive to the Vibe Folder” in the Micro Focus Vibe 4.0.5
Advanced User Guide.

IMPORTANT: When Vibe users are running Windows 7 as the client operating system, various
issues can be introduced because of WebDAYV limitations in Windows 7. If your Vibe users are using
the Windows 7 operating system, see “Configuring Vibe to Support WebDAV on Windows 7" in the
Micro Focus Vibe 4.0.4 Administration Guide.

Choosing the WebDAV Authentication Method

The WebDAV authentication method determines how user credentials are passed from Vibe to the
WebDAV server. Vibe 3 and later supports three types of WebDAV authentication methods:

+ “Choosing Basic Authentication” on page 59
+ “Choosing Digest Authentication” on page 59
+ “Choosing Windows Authentication” on page 60

Choosing Basic Authentication

Basic authentication encodes the user name and password with the Base64 algorithm. The Base64-
encoded string is unsafe if transmitted over HTTP, and therefore should be combined with SSL/TLC
(HTTPS).

Select this type of authentication when you plan to use Novell Access Manager or Internet
Information Services (11S) to authenticate users.

For more information about encryption algorithms, see “Database Encryption Algorithm” on page 62.

Choosing Digest Authentication

Digest authentication applies MD5 cryptographic, one-way hashing with usage of nonce values to a
password before sending it over the network. This option is more safe than Basic Authentication
when used over HTTP.

Select this type of authentication when client users are using Windows 7 as their operating system
and Microsoft Office as their text editor.

For more information about encryption algorithms, see “Database Encryption Algorithm” on page 62.
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Choosing Windows Authentication

Windows Authentication provides Windows users with a single sign-on experience, enabling users to
automatically authenticate to Vibe after they are logged in to their individual workstations. Internet
Information Services (1IS) provides this capability.

To configure Vibe to use Windows Authentication as the WebDAV authentication method, select
basic in the WebDAV authentication method field during the Vibe installation program, then configure
Windows Authentication as described in “Configuring Single Sign-On with Internet Information
Services for Windows” on page 111.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under WebDAV authentication method, specify the authentication method you want Vibe to use when
authenticating to WebDAV.

Planning the Vibe Database

Micro Focus Vibe database disk space requirements are relatively modest. Files that are imported
into Vibe are saved in the Vibe file repository, as described in “Vibe Installation Locations” on
page 54.

The Vibe database is primarily used for storing the following information:

¢ Structural information about workspaces, folders, and entries (for example, their location in the
workspace tree)

+ Identification information about workspaces, folders, and entries (for example, titles,
descriptions, dates of creation/modification, and users associated with creation/modification)

+ User profile information (for example, full name, phone number, and email address)
You or your database administrator must make the following decisions about the Vibe database:

+ “Database Type” on page 60

+ “Database Setup Method” on page 61

+ “Database Location” on page 61

+ “Database Credentials” on page 62

+ “Database Encryption Algorithm” on page 62

Database Type

Vibe supports the following database types:
On Linux: MariaDB, MySQL, Oracle, and PostgreSQL
On Windows MariaDB, MySQL, Microsoft SQL, Oracle, and PostgreSQL

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Type, mark the type of database that you want to use with Vibe.

Ensure that a supported version of the database server, as listed in “Vibe Server Requirements” on
page 19, is installed and running before you install Vibe.
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Database Setup Method

You or your database administrator must manually create the Vibe database. This is a requirement,
regardless of which type of database you are using.

+ “Basic Setup” on page 61
+ “Remote Server Setup” on page 61

Basic Setup

If you plan to deploy the Vibe database as a basic installation, with the database running on the same
server as the Vibe software, you first install the Vibe software, and then create the database, as
described in Chapter 9, “Installing and Setting Up a Basic Vibe Site,” on page 71.

Remote Server Setup

If you plan to deploy the Vibe database on a remote server, follow the instructions in Chapter 18,
“Creating the Vibe Database on a Remote Server,” on page 137.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Setup Method, mark whether you are setting up the database as a basic installation
(with the database running on the same server as the Vibe software), or whether you are performing a
remote server setup, with the database server on a remote server.

Database Location

Creating the database on the same server where you install the Vibe software is the preferable
location for your Basic installation. The default database name is si t escape (a reference to the
company that previously developed the Vibe software).

You can have your database administrator create a database on a remote server later, after you have
successfully tested your Basic installation. See Chapter 18, “Creating the Vibe Database on a
Remote Server,” on page 137.

You must decide before installation whether you want the database on the Vibe server or on a remote
server. See Chapter 18, “Creating the Vibe Database on a Remote Server,” on page 137.

Vibe knows where to find its database from the JDBC (Java Database Connectivity) URL that you

provide during installation. For a database that is local to the Vibe software, the default JDBC URL
that provides | ocal host as the hostname of the Vibe server is appropriate. If the database is on a
remote server, the JDBC URL must provide the hostname of the remote database server.

The JDBC URL also includes the port number on which Vibe can communicate with the database
server. The default port number depends on the database server you are using:

Database Server  Default Port Number

MySQL/MariaDB 3306

Microsoft SQL 1433
Oracle 1521
PostgreSQL 5432
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Use this port number unless it is already in use by another process on the database server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under JDBC URL, specify the appropriate hostname for the database server (I ocal host or the
hostname of a remote server) and the port number it will use to communicate with Vibe.

Database Credentials

When you have the Vibe Installation program create the database for you, it defaults to the following
administrator user names for the database server:

Database Default Administrative User Name
MySQL/ r oot
MariaDB

IMPORTANT: The database r oot user name is not the same as the Linux r oot user on a
Linux server.

Microsoft SQL  (no default) For a Microsoft SQL database, your database administrator establishes the
administrator user name and password for the database server.

Oracle (no default) For an Oracle database, your database administrator establishes the
administrator user name and password for the database server.

PostgreSQL post gres

For an Oracle database and Microsoft SQL database, your database administrator establishes the
administrator user name and password for the database server.

Check with your database administrator to see if the default administrator user name is still in use for
your database server, and obtain the administrator password for the database server before you run
the Vibe Installation program.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials, specify the administrator user name and password for the database server
so that Vibe can access its database.

Database Encryption Algorithm

Different encryption algorithms provide differing encryption strength. The supported algorithms for
encrypting the Vibe database password are listed below.

+ SHA-256

This is the only available option when you use Basic Authentication for WebDAV authentication,
as described in “Planning the WebDAV Authentication Method” on page 58.
+ PBEWITHSHA256AND128BITAES-CBC-BC

This is the only available option when you select Digest Authentication for WebDAV
authentication, as described in “Planning the WebDAV Authentication Method” on page 58.
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BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Encryption Algorithm, mark the encryption algorithm you want to use for Vibe
passwords.

Gathering Outbound Email Information

Your Micro Focus Vibe site can be configured to send outbound email through an existing email
system. Email from the Vibe site is useful for the following activities:

+ Vibe users can subscribe to email notifications, so that they automatically receive a message
whenever content of interest changes. For more information, see “Subscribing to a Folder or
Entry” in “Getting Informed” in the Micro Focus Vibe 4.0.5 User Guide.

+ From the Vibe site, users can send email messages to individual users or to teams. For more
information, see “Sending Email from within Vibe” in “Connecting With Your Co-Workers” in the
Micro Focus Vibe 4.0.5 User Guide.

+ If your email client is iCal-enabled, appointments created in a Vibe Calendar folder can be sent
to your email client for posting in your email client Calendar. For example, if you are using
GroupWise, see “Accepting or Declining Internet Iltems” in “Calendar” in the GroupWise 8
Windows Client User GuideGroupWise 8 Windows Client Help.

In order for your Vibe site to communicate with your email system, you need to gather the following
information about your email system:

¢ “Outbound Email Protocol” on page 63

¢ “Outbound Email Host” on page 64

+ “Outbound Email Authentication” on page 64

+ “Outbound Email Send Restriction” on page 65

¢ “Outbound Email From Address” on page 65

After installation, outbound email can be disabled and enabled again on the Vibe site, as described in
“Configuring Email Integration” in “Site Setup” in the Micro Focus Vibe 4.0.4 Administration Guide.
However, you must configure outbound email in the Vibe installation program.

Outbound Email Protocol

Email systems communicate by using SMTP (Simple Mail Transfer Protocol). You need to determine
whether the email system that you want your Vibe site to communicate with is using SMTP or SMTPS
(secure SMTP).

For GroupWise, you can check how the Internet Agent is configured:

1 In the GroupWise Admin Console, browse to Internet Agents > GWIA > Agent Settings.
2 The SMTP row, SSL column indicates which protocols can be used as follows:

SSL Setting Protocols Supported
Requi red SMTPS

Enabl ed SMTP or SMTPS

Di sabl ed SMTP
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3 Click Close.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound Email Protocol, mark SMTP or SMTPS to match the email system that you want Vibe
to communicate with.

4 If the email system requires SMTPS, see “Securing Email Transfer” in “Site Security” in the
Micro Focus Vibe 4.0.4 Administration Guide.

Outbound Email Host

In order to send messages to your email system, Vibe needs to know the hostname of your SMTP
mail server.

The default SMTP port of 25 is typically appropriate, unless the SMTP mail server requires port 465
or 587 for SMTPS connections.

For GroupWise, this is the hostname of a server where the Internet Agent is running. GroupWise
always uses port 25, even when SSL is enabled.

When the Vibe site sends email notifications for scheduled events, the messages are time-stamped

according to the time zone you specify here during installation. This setting allows you to use a time

zone for email notifications that is different from the time zone where the server is located. The time

zone list is grouped first by continent or region, optionally by country or state, and lastly by city. Some
common selections for United States time zones include the following:

Time Zone Continent/City
Pacific Time America/Los Angeles
Mountain Time America/Denver
Central Time America/Chicago
Eastern Time America/New York

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound Email Host, specify the name of the mail host, the SMTP port number it uses, and the
time zone for the time stamp you want on scheduled event naotifications.

Outbound Email Authentication

Many SMTP mail hosts require a valid email address before they establish the SMTP connection.
Some email systems can construct a valid email address if you specify only a valid user name; other
email systems require that you specify the full email address for successful authentication. You
should provide a user name (email address) to ensure a successful connection. Email notifications
from the Vibe system are sent using this email address in the From field.

Some email systems also require a password. Some do not. If authentication is required, you should
also provide a password.
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By default, the GroupWise Internet Agent does not require authentication in order to receive inbound
messages. However, the /forceinboundauth startup switch is available for use in the Internet Agent
startup file (gwi a. cf g), in order to configure the Internet Agent to refuse SMTP connections where a
valid email user name and password are not provided. The Internet Agent can accept just the user
name or the full email address.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound Email Authentication, indicate whether or not authentication is required for the Vibe
site to communicate with your email system. If it is, specify the user name or email address, and if
necessary, the password for the email account.

Outbound Email Send Restriction

By default, the Vibe site allows Vibe users to send messages to all Vibe users by using the All Users
group on the Vibe site. On a very large Vibe site, this generates a very large number of email
messages. If desired, you can prevent messages from being sent to the All Users group.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Allow Sending Email to All Users, mark whether you want users to be able to send messages to the
All Users group.

Outbound Email From Address

You can specify an email address to be used as the From address of emails sent from Vibe.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under From email address override, specify the email address to be used as the From address for emails
sent from Vibe.

Under Use this from email address for all outbound email, mark whether you want this address to be used
for all outbound email.

Enabling Inbound Email

You can configure your Micro Focus Vibe site so that users can post comments by emailing them to
the folder where they want to post the comment. In order to receive email postings, folders must be
properly configured, as described in “Enabling Folders to Receive Entries through Email” in
“Managing Folders” in the Micro Focus Vibe 4.0.5 Advanced User Guide. Also, users must know the
email address of the folder where they want to post their comment.

+ “Internal Mail Host for Inbound Email” on page 66

¢ “Inbound Email Port Number” on page 66

+ ‘“Inbound Email IP Address” on page 66

+ ‘“Inbound Email Security” on page 66
After installation, inbound email can be disabled and enabled again on the Vibe site, as described in

“Disabling/Enabling Inbound Email Postings” in “Site Setup” in the Micro Focus Vibe 4.0.4
Administration Guide. However, you must configure inbound email in the Vibe installation program.
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Internal Mail Host for Inbound Email

Inbound email is disabled by default. When you enabile it, the Vibe site starts an internal SMTP mail
host to receive incoming messages and post them to the folders associated with the email addresses
to which the messages are addressed. By default, the internal SMTP mail host uses port 2525, so
that it does not conflict with another mail host that might be running on the Vibe server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, mark whether you want users to be able to post to the Vibe site from
their emalil clients.

Inbound Email Port Number

Selecting the port number for the Vibe internal SMTP mail host presents the same issue that needs to
be dealt with for the HTTP port numbers, as described in “HTTP/HTTPS Ports” on page 56. You
might want to configure the Vibe internal SMTP mail host to use the standard SMTP port of 25. How
you handle the issue depends on whether you are installing on Linux or on Windows.

Linux: Keep the default port number (2525) in the Vibe Installation program, then complete the steps in
“Setting Up Port Forwarding” on page 78 so that requests incoming on port 25 are forwarded to
port 2525.

Windows: Specify port 25 for incoming email in the Vibe Installation program.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, specify the port number for the Vibe internal SMTP host to listen on.

Inbound Email IP Address

If you want to install Vibe on a server where an SMTP mail host is already running, you can do so if
the server has multiple IP addresses. The existing SMTP mail host can use port 25 on one IP address
and Vibe can use port 25 on another IP address. During installation, you need to specify an IP
address only if the server has multiple IP addresses and you want Vibe to bind to a specific IP
address rather than all of them.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, specify the IP address for the Vibe internal SMTP host to listen on, if you
are installing Vibe on a server with multiple IP addresses and you want Vibe to bind to just one of them.

Inbound Email Security

You can choose whether the Vibe internal mail host uses TLS (Transport Layer Security) when it
communicates with other SMTP mail hosts. In order for TLS to function properly, you must have a
certificate on the Vibe server, as described in “Securing Email Transfer” in “Site Security” in the Micro
Focus Vibe 4.0.4 Administration Guide. When an SMTP mail host queries the Vibe mail host, the Vibe
mail host communicates its ability or inability to handle TLS. The other SMTP mail host then
communicates appropriately, taking into account how the Vibe internal mail host is configured. The
default is to use TLS, because this provides more secure communication between mail hosts.

Planning a Basic Vibe Installation



BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, mark whether you want the Vibe server to announce that it can use TLS.

You can install Vibe with Announce TLS selected, and then set up the certificate afterwards.
However, if you select Announce TLS, inbound email does not work until the certificate is available on
the Vibe server.

Adding File Types for HTML Conversions

Many file formats in Micro Focus Vibe can be viewed as HTML by default, as described in “Viewing
the File in HTML Format” in the Micro Focus Vibe 4.0.5 User Guide. File formats that can be viewed
as HTML by default are: . 123, . bnp, . db, . doc, . docx, . dot m . drw, . dxf,.htm . htm, .| wp,.odf,
.odf, . odp, .ods,.odt,.pct,.ppt,.pptx,.prz,.qgpw,.rtf,.sdw, .shw,.sxw,.tif,.txt,.vsd,
.wpd, . xI's, . xl sx, . sxi

Some file formats, such as . pdf files, cannot be viewed as HTML by default. This is because the
quality of these files is lessened when viewed as HTML. However, if you choose, you can enable non-
default file formats, such as . pdf files, to be viewed as HTML.

Not all file formats can be enabled to be viewed as HTML in Vibe, but many can be. If you are unsure
whether Vibe supports a particular file format to be viewed as HTML, try it and see.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Vibe File Types for HTML Conversions, specify the file types (in addition to the default file types)
that you want users to be able to view as HTML.

Planning Site Security

+ “Vibe Site Administrator Password” on page 67
+ “Linux User ID for Vibe” on page 68
+ “Administrator Name for Micro Focus Vibe” on page 68

Vibe Site Administrator Password

When you first log in to the Micro Focus Vibe site, you use adni n as the Vibe administrator user name
and adm n as the password. You should immediately change the password to one of your own
choosing when you are prompted to do so. If you do not immediately change the password, you can
change the Vibe adminsitrator user name and password at any time, as described in “Changing the
Vibe Administrator User ID or Password” in the Micro Focus Vibe 4.0.4 Administration Guide.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Vibe Administrator Credentials, specify the password that you want to use whenever you log in
as the Vibe site administrator.
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Linux User ID for Vibe

For optimum security, Vibe should not run as the Linux r oot user. For example, if an intruder
manages to assume the identity of the Vibe program, the intruder gains all the privileges of the
commandeered process. If the process is running with r oot user privileges, the intruder has r oot
access to your system. If the process is running as a user with minimal privileges, the intruder has
only restricted access to your system. Therefore, your system is more secure if the Vibe program
does not run as r oot . For example, you might want to create a user named vi beadmi n for the Vibe
program to run as. Linux users require a full name and a password.

In addition to creating a Linux user for the Vibe program to run as, you can also create a Linux group
for that user to belong to. This enables the Vibe program to create directories and files with consistent
ownership and permissions. For example, you might want to create a group named vi beadmi n for the
vi beadmi n user to belong to. Groups do not require passwords.

As an alternative to creating a custom Linux user name and group for Vibe, you can use the existing
wwwr un user name and the www group. This account is typically used to start web server processes.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Linux User Name and Group, specify the non-r oot Linux user name and group name to use for
running the Vibe program. If you are creating a new Linux user, specify its full name and password.

IMPORTANT: The non-r oot Linux user name and group must exist before you start the Vibe
Installation program. Instructions for creating the user name and group are provided in “Performing
Pre-Installation Tasks on Linux” on page 71.

Administrator Name for Micro Focus Vibe

This is the administrator user ID that is used when logging in to the Vibe system. For enhanced
security, you might want to change the user ID.

In the Default Administrator Name field, specify a new user ID for the vibe administrator.

Gathering Directory Services Information

Unless you are planning a very small Micro Focus Vibe site, the most efficient way to create Vibe
users is to synchronize initial user information from your network directory service (Novell eDirectory,
GroupWise, or Microsoft Active Directory directory service) after you have installed the Vibe software.
Over time, you can continue to synchronize user information from the LDAP directory to your Vibe
site.

“Synchronizing Users and Groups from an LDAP Directory” in the Micro Focus Vibe 4.0.4
Administration Guide provides instructions for synchronizing user information via LDAP. Use this
section when planning your LDAP configuration.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under the LDAP sections, mark the information specific for your environment.
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Accommodating Multiple Languages

The Micro Focus Vibe installation program runs in English only. When you install the Vibe software,
you can choose to have the primary language of the Vibe site be any of the following languages:

¢ Chinese-Simplified

+ Chinese Traditional

+ Danish

¢ Dutch

+ English

+ French

+ German

¢ Hungarian

+ ltalian

+ Japanese

¢ Polish

+ Portuguese

+ Russian

¢ Spanish

+ Swedish

Some languages have an additional distinction by locale (the country where the language is spoken).

The language you select during installation establishes the language of the global text that displays in
locations where all Vibe users see it, such as in the Workspace tree when you click the Workspace
treeicon & :

o

Horne Workspace Personal Workspace Guest (guest)

The language you select also establishes the default interface language and locale for creating new
workspaces.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Default Locale, mark the default language and specify the default country for your Vibe site.

Additional language customization can be done after installation, as described in “Managing a
Multiple-Language Vibe Site” in “Site Setup” in the Micro Focus Vibe 4.0.4 Administration Guide.
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Installing and Setting Up a Basic Vibe
Site

Follow the setup instructions for the platform where you are installing Micro Focus Vibe:

+ “Linux: Installing and Setting Up a Basic Vibe Site” on page 71
+ “Windows: Installing and Setting Up a Basic Vibe Site” on page 82

Linux: Installing and Setting Up a Basic Vibe Site

You should already have reviewed Chapter 8, “Planning a Basic Vibe Installation,” on page 51 and
filled out the Basic Vibe Installation Summary Sheet. The following sections step you through the
process of installing and starting Micro Focus Vibe on Linux:

+ “Performing Pre-Installation Tasks on Linux” on page 71

¢ “Running the Linux Vibe Installation Program” on page 72

+ “Creating the Vibe Database” on page 75

+ “Performing Post-Installation Tasks on Linux” on page 77

Performing Pre-Installation Tasks on Linux

1 Ensure that the Linux server where you plan to install Vibe meets the system requirements listed

in “Vibe Server Requirements” on page 19.
2 In a terminal window, become r oot by entering su - and the r oot password.
3 Set the Linux open file limit to meet the needs of the Vibe software:
3a Openthe/etc/security/lints.conf fileinan ASCII text editor.
3b Add the following lines to the bottom of the list, following the format of the example lines:

* hard nofile 65535
* sof t nofile 4096

3c Save the file, then exit the text editor.
4 Perform the following conditional tasks if necessary:
+ “Stopping and Disabling an Existing Web Server” on page 71
+ “Creating a Vibe User and Group” on page 72

Stopping and Disabling an Existing Web Server

If a web server is currently running on the Vibe server, stop it, and preferably disable it.
For example, to stop the Apache web server and its associated instance of Tomcat:

1 Enter the following commands to stop Apache and Tomcat:
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/etc/init.d/tontat5 stop
/etc/init.d/apache2 stop

2 Enter the following commands to ensure that Apache and Tomcat do not start again when you
reboot the server:

chkconfig --del apache2
chkconfig --del tontath

Creating a Vibe User and Group

If the user and group that you want to use for Vibe (as described in “Linux User ID for Vibe” on
page 68) do not exist yet, create them. It is easier if you create the group first.
1 Create the Linux group that you want to own the Vibe software and data store directories:

la In YaST, click Security and Users > User and Group Management to display the User and
Group Administration page.

1b Click Groups, then click Add.
1c Specify the group name, then click Accept or OK.
The group does not need a password.
2 Create the Linux user that you want Vibe to run as:
2a Click Users, then click Add.

2b On the User Data tab, specify the user’s full name, user name, and password, then select
Disable User Login.

Like any Linux system user, the Vibe Linux user does not need to manually log in. The Vibe
Linux user does not need a password, either, but YaST requires you to provide one.

2c Click the Details tab.

2d Inthe Login Shell drop-down list, select /bin/false, because this user does not need to
manually log in.

2e Inthe Default Group drop-down list, select the Linux group that you created in Step 1.
2f Inthe Groups list, select the Linux group that you created in Step 1.
2g Click Accept or OK.

3 Exit YaST.

Running the Linux Vibe Installation Program

When you run the Vibe installation program for the first time, you typically want to use the GUI
interface. However, if you are installing Vibe on a server where the X Window System is not available,
a text-based installation program is also available. After you are familiar with the Vibe installation
process, you can use a silent installation to automate the process.

+ “Using the GUI Installation Program” on page 72
+ “Using the Text-Based Installation Program” on page 74
+ “Performing a Silent Installation” on page 75

Using the GUI Installation Program

1 In aterminal window, enter su - to become the r oot user, then enter the r oot password.

Installing and Setting Up a Basic Vibe Site



You need r oot permissions in order to install the Vibe software, but you should not run the Vibe
software as r oot .

2 Change to the directory where you downloaded and extracted the Vibe software.

3 Ensure that you have a |l i cense- key. xni file in the same directory with the Vibe installation
program.

nore |icense-key.xm

The Vibe installation program does not start without a license file in the same directory. If you
have not already, rename the license file to be called | i cense- key. xm .

For more information about licensing, see Chapter 11, “Updating Your Vibe License,” on
page 91.

4 Enter the following command to start the Vibe installation program:
./installer-team ng.!linux

5 Accept the License Agreement, then click Next.

Novell Vibe 4 Installation Program = x
Installation Options
Select the action you want to perferm. N
* New installation
" Update software and settings
" Reconfigure settings

6 Click Next to accept the default of New installation.

Novell Vibe 4 Installation Program = x
Choose Inslallation Type

Select the type of installation you want to perform N

Select the Basic installation if you do not want to configure

| Advanced any of the optional features.

7 Click Next to accept the default of Basic.

8 Use the information that you have gathered on the Basic Vibe Installation Summary Sheet to
provide the information that the Vibe installation program prompts you for:

Installation Locations

Location of TrueType Fonts for Stellent Converters
Additional Extensions for View as HTML

Default Locale for Micro Focus Vibe

User ID for Micro Focus Vibe

Built-In Administrator Name for Micro Focus Vibe
Network Information

WebDAV Authentication Method
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Database Selection
Database Type
JDBC URL
Credentials
Setup
Encryption Algorithm
Java JDK Location
Outbound Email Configuration
Protocol
Host, Port, and Time Zone
User Name, Password, and Authentication
Allow Sending Email to All Users
Inbound Email Configuration

The installation program stores the information that it gathers in the i nstal | er. xnml file in the
same directory where you started the installation program.

9 After you have provided all the requested information, click Install to begin the Vibe installation.
10 Verify that the JCE is properly configured.
11 When the installation is complete, click Finish to exit the Vibe installation program.

Information about the installation process is written to the i nstal | er. | og file in the same
directory where you ran the Installation program. If a problem arises during the installation, the
i nstall er.| og file provides information that can help you resolve the problem.

12 Continue with “Creating the Vibe Database” on page 75.

Using the Text-Based Installation Program

If you try to start the GUI Vibe installation program in an environment where the X Windows System is
not running, the text-based Vibe Installation program starts.

Checking license key...

License Summary

Product: Novell Vibe

Version: 3.0

UID: 1
Effective: 10/27/2012
Expires: never
Users: unlimited

Installing this software requires agreement to the
terms and conditions set forth in the:
Novell EULA and Export Compliance Notice

You can review this agreement again at the download site or
type "REVIEW" below.

Note: You must answer "YES" to install the software.

Have you read and agree with the license? :

If you want to use the text-based installation program in an environment where the GUI starts by
default, use the following command in the directory where the installation program is located:

.linstaller-team ng.linux --text
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IMPORTANT: The text-based Vibe installation program must be run in the same directory where the
Vibe license file is located. If the license file is not in the same directory, the text-based installation
program cannot find it.

The text-based installation program gathers the same configuration information as the GUI
installation program does. This information is stored in the i nstal | er. xnl file in the directory where
you run the installation program.

The installation program does not write the information it gathers into the i nstal | er. xm file until you
exit the installation program, and you cannot go back when you use the text-based installation
program. Therefore, when you use the text-based installation program, you should plan your
installation carefully in advance, using the Basic Vibe Installation Summary Sheet or the Advanced
Vibe Installation Summary Sheet. If you make a mistake during the installation, continue to the end of
the installation process and exit the installation program normally, so that all information is saved.
Then run the text-based installation program again. Your previous information is supplied as defaults,
and you can change the information as needed.

Performing a Silent Installation

If your Vibe system expands beyond one server, you might need to repeatedly install the same Vibe
components. A silent installation makes this an easy process.

1 Editan existing i nstal | er. xn file so that it has the hostname of the server where you want to
perform the silent installation and copy it to that server.

2 In the directory where the installation program is located, use the appropriate command to run
the Vibe installation program, depending on the action that you want the silent installation to
perform:

.linstaller-teaming.linux --silent --install
./installer-team ng.linux --silent --upgrade
./installer-teamng.linux --silent --reconfigure

The Installation program obtains all the information it needs from the i nstal | er. xni file and
completes the installation without user interaction. If you have manually modified index server
scripts, such as the i ndexser ver - st art up. sh file as described in “Installing the Lucene
Software” on page 145, all modifications will be lost when you perform a silent upgrade. To retain
your modifications, you should upgrade with the GUI installation program, as described in “Using
the GUI Installation Program” on page 72.

Creating the Vibe Database

Before you can start Vibe, you need to create the Vibe database.

1 If you haven't done so already, install the database on the Vibe server.

For single-server installations running on Linux, we recommend that you install the PostgreSQL
database, but other databases are also supported (see Step 3). For information about how to
install the database on the Vibe server (on Linux), see “PostgreSQL on Linux” on page 236.

For more information about installing the database for a multi-server Vibe system, see
Chapter 18, “Creating the Vibe Database on a Remote Server,” on page 137.

2 Ensure that the database already exists on the server that is running the Vibe software or on the
remote server, depending on where you want to install the database.

3 Change to the following directory:
cd /vibe_installation_source/tenp-installer/db/scripts/sql
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This directory contains the following scripts, one for each database type (MySQL/MariaDB,
Microsoft SQL, Oracle, and Postgresq]l):

* nysql - creat e- enpt y- dat abase. sql

+ oracl e-creat e-enpt y- dat abase. sql

+ post gresql -creat e-enpt y- dat abase. sql
+ sql server-creat e-enpt y-dat abase. sql

(Optional) If you need to change the default database name from si t escape to something else,
edit the . sql file for your database type to replace si t escape with the new name.

Use the database utility command for your database type to run the corresponding script for your
database from the vi be_i nstal | ati on_source/tenp-install er/db/scripts/sqgl directory:

MySQL/ nysql -uadm n-usernane -ppassword < "nysqgl -creat e- enpt y- dat abase. sql "
MariaDB:

Microsoft ~ osgl -Uadm n-usernanme -Ppassword -i sql server-create-enpty-database. sql

SQL:
You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/

downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to create the database.

Oracle: sql plus "/ as sysdba"
SQ@.>spool updat e-oracl e. out;
SQ>@r acl e- cr eat e- enpt y- dat abase
SQL>qui t;

Postgresql: psqgl -Uadm n-username < "postgresql -create-enpty-database. sql "

You are prompted for the password that you set for the admin user.

Change to the db directory in the Vibe installation:
cd /vibe_installation_source/tenp-installer/db
This directory contains the following properties files:

* nysql -1i qui base. properties

¢ Oracle-liquibase. properties

+ postgresql -1iqui base. properties

* sql server-1liqui base. properties

In a text editor, open the properties file that corresponds with your database type and make the
applicable changes in both the Dri ver and ref erenceDri ver sections. Save and close the text
editor when you are finished making changes.

¢ Change the user nane, passwor d, r ef er enceUser nane, and r ef er encePasswor d fields to
reflect the username and password for accessing your database.

+ (Conditional) If the database is running on a remote server, replace | ocal host with the IP
address of the remote server.

+ (Optional) If you changed the database name in Step 4 on page 76, change the ur| and
r ef er enceURL fields to reflect name of your Vibe database.

Save and close the text editor.

In the same directory, execute the following command to create the database schema:

./ manage- dat abase. sh dat abase_t ype updat eDat abase

where database_type is one of the following: nysql , or acl e, post gresql , or sql server.
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NOTE: You can safely ignore the following Liquibase log messages:

* Warning: nodifyDataType will [ose primary key/autoincrenent/not null
settings for nysql

+ Any messages that contain the words i nfo: failureorinfo: failed, aslong as they
are associated with a type | NFOmessage

9 Start the Vibe server as described in “Starting Vibe on Linux” on page 80.
10 For security reasons, delete the password that you specified in Step 7:
10a Change to the following directory in your Vibe installation:
cd /vibe_installation_source/tenp-installer/db

10b In atext editor, open the database script that corresponds with your database type to delete
the password.

10c Save and close the properties file.
11 Continue with “Performing Post-Installation Tasks on Linux” on page 77.

Performing Post-Installation Tasks on Linux

+ “Checking for Available Hot Patches” on page 77

+ “Configuring Vibe to Start Automatically on Reboot” on page 77
+ “Setting Up Port Forwarding” on page 78

+ “Starting Vibe on Linux” on page 80

+ “Checking the Status of the Vibe Server” on page 81

+ “Restarting Vibe” on page 81

+ “Stopping Vibe” on page 81

+ “Uninstalling Vibe” on page 81

Checking for Available Hot Patches
After you install Vibe, ensure that you check the Vibe download site where you downloaded the Vibe
software for any hot patches that might be available.
Configuring Vibe to Start Automatically on Reboot
You can configure Vibe to start automatically each time you reboot the Linux server.

1 As the Linux r oot user, enter the following command:

chkconfig --add team ng
2 To verify that automatic startup is turned on, enter the following command:

chkconfig team ng
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Setting Up Port Forwarding

In order to make Vibe available on the default HTTP/HTTPS ports of 80 and 443, you must set up port
forwarding in order to forward the browser default ports (80 and 443) to the Vibe server ports (8080
and 8443). In addition, you must set up port forwarding if you want to forward the default SMTP mail
host port (25) to the default Vibe internal mail host port (2525).

You can set up port forwarding in one of two ways, depending on whether you are using the Vibe
server as a firewall.

+ “Using the SuSEfirewall2 File” on page 78
+ “Using iptables Commands on Pre-SLES 12 Servers” on page 78
+ “Using iptables Commands on SLES 12" on page 80

Using the SuSEfirewall2 File
To enable port forwarding on a SUSE Linux server that uses SuSEf i r ewal | 2:

1 As the Linux r oot user, open the following file:
/etc/sysconfig/ SuSEfirewal | 2
2 Find the following line:
FW REDI RECT=""
3 Between the quotation marks, copy and insert the following string:

0/0,i p_address, tcp, 80,8080 0/0,i p_address, tcp, 443, 8443 0/
0, i p_address, tcp, 25, 2525

4 Replace i p_addr ess with the IP address of the Vibe server.

5 Save the SuSEfirewal | 2 file, then exit the text editor.

6 Use the following command to restart the firewall:
/shin/SuSEfirewal | 2 start

7 Use the following command to verify that the default browser ports (80 and 443) have been
forwarded to the Vibe server ports (8080 and 8443) and that the default SMTP mail host port (25)
has been forwarded to the Vibe internal mail host:

i pt abl es-save | grep REDI RECT

Now, users do not need to include a port number in the Vibe site URL.

Using iptables Commands on Pre-SLES 12 Servers
To use i pt abl es commands to enable port forwarding on any type of Linux server:

1 Asthe Linux r oot user, change to the / etc/init. d directory.

2 In atext editor, create a new file for a set of i pt abl es commands, for example:
gedit vibe-iptables

3 Copy and paste the following lines into the vi be- i pt abl es file:
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#!/ bi n/ bash -

i ptables -t nat -A QUTPUT -d | ocal host -p tcp --dport 80 -j REDIRECT --to-ports
8080

iptables -t nat -A OUTPUT -d hostname -p tcp --dport 80 -j REDI RECT --to-ports
8080

i ptables -t nat -A PREROUTING -d hostnane -p tcp --dport 80 -j REDI RECT --to-
ports 8080

iptables -t nat -A OQUTPUT -d | ocal host -p tcp --dport 443 -j REDI RECT --to-
ports 8443

i ptables -t nat -A QUTPUT -d hostname -p tcp --dport 443 -j REDIRECT --to-ports
8443

i ptables -t nat -A PREROUTING -d hostnane -p tcp --dport 443 -j RED RECT --to-
ports 8443

i ptables -t nat -A QUTPUT -d | ocal host -p tcp --dport 25 -j REDIRECT --to-ports
2525

i ptables -t nat -A OQUTPUT -d hostname -p tcp --dport 25 -j REDI RECT --to-ports
2525

i ptables -t nat -A PREROUTING -d hostnane -p tcp --dport 25 -j REDI RECT --to-
ports 2525

In this example, the lines are wrapped. When you paste them into the text editor, if the lines are
still wrapped, remove the hard returns so that you have nine iptables commands, each on its
own line.

4 Replace host nare with the hostname or IP address of the Vibe server.

5 Save the vi be-i pt abl es file, then exit the text editor.

6 Use the following command to make the file executable:
chmod +x vi be-i ptabl es

7 Use the following command to immediately execute the commands in the vi be-i pt abl es file:
chkconfig vibe-iptables on

8 Use the following command to add vi be-i pt abl es to future server boot initialization:
chkconfig --add vi be-iptabl es

9 Use the following command to verify that the default browser ports (80 and 443) have been
forwarded to the Vibe server ports (8080 and 8443) and that the default SMTP mail host port (25)
has been forwarded to the Vibe internal mail host:

i pt abl es-save | grep RED RECT

10 To view existing iptables rules, use the command i ptables -t nat -L -n -v

Now, users do not need to include a port number in the Vibe site URL.
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Using iptables Commands on SLES 12

The port forwarding script (/ et ¢/ i ni t. d/ vi be-i pt abl es) used on earlier SLES servers no longer
works in SLES 12.

Complete the following steps to avoid needing to run the iptables commands after every boot:

1 As the Linux root user, change to the /et c/i ni t. d directory.
2 Openthe after.local filein atext editor.
3 Copy/past the following commands to the end of the after. | ocal file and save the file.

i ptables -t nat -A QUTPUT -d | ocal host -p tcp --dport 80 -j REDIRECT --to-ports
8080

i ptables -t nat -A OUTPUT -d hostname -p tcp --dport 80 -j REDI RECT --to-ports
8080

i ptables -t nat -A PREROUTING -d hostnane -p tcp --dport 80 -j REDI RECT --to-
ports 8080

i ptables -t nat -A OUTPUT -d | ocal host -p tcp --dport 443 -j RED RECT --to-
ports 8443

i ptables -t nat -A QUTPUT -d hostname -p tcp --dport 443 -j REDIRECT --to-ports
8443

i ptables -t nat -A PREROUTING -d hostnane -p tcp --dport 443 -j RED RECT --to-
ports 8443

i ptables -t nat -A QUTPUT -d | ocal host -p tcp --dport 25 -j REDIRECT --to-ports
2525

i ptables -t nat -A OUTPUT -d hostname -p tcp --dport 25 -j REDI RECT --to-ports
2525

i ptables -t nat -A PREROUTING -d hostnane -p tcp --dport 25 -j REDI RECT --to-
ports 2525

4 Replace hostname with the hostname or IP address of the Vibe server.

The lines above are wrapped. When you copy/paste them into the text editor, if the lines are still
wrapped, remove the hard returns so that you have nine iptables commands, each on its own
line.

5 Save the /etc/init.d/after.local file, then exit the text editor.
6 Reboot the Vibe server. Port forwarding should now be working again.

Starting Vibe on Linux

The Vibe Installation program created a t eam ng startup script in the /et ¢/ i ni t. d directory.

1 In aterminal window, become r oot by entering su - and the r oot password.
2 Enter the following command to start Vibe:
/etc/init.d/team ng start

You must execute the t eani ng script as r oot , but the script runs Vibe as the user you selected
in “Linux User ID for Vibe” on page 68 and specified during installation.

You should see output similar to the following example:
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Usi ng CATALI NA BASE: / opt/ t eani ng/ apache-t ontat
Usi ng CATALI NA_HOVE: / opt/ t eani ng/ apache-t ontat
Usi ng CATALI NA TEMPDI R /opt/team ng/ apache-tontat/tenp

Usi ng JRE_HOVE: lusr/lib64/jvmjavaljre
Usi ng CLASSPATH: / opt/ novel | / t eam ng/ apache-t ontat/ bi n/
boot strap. jar:opt/novel | /teanm ng/ apache-tontat/bin/tontat-juli.jar

3 Ensure that Vibe is ready for work:
3a Change to the following directory:
/ opt/novel | / t eam ng/ apache-tontat/| ogs
3b Enter the following command to display the end of the Tomcat log:
tail --f catalina.out
At the end of the log file listing, you should see:

INFO. Server startup in nnnn ns

4 Press Ctrl+C when you finish viewing the cat al i na. out file.

Checking the Status of the Vibe Server

You can see if Vibe is running by checking for its process ID (PID).
1 In aterminal window, enter the following command:
ps -eaf | grep teanming
You should see the Vibe PID number, along with a listing of configuration settings.
Restarting Vibe

You need to restart Vibe whenever you use the Vibe installation program to make configuration

changes, as described in Chapter 15, “Performing an Advanced Vibe Installation,” on page 127.

1 Asroot in aterminal window, enter the following command:
/etc/init.d/team ng restart
You should see the same output as when you originally started Vibe.

Stopping Vibe

1 Asroot in aterminal window, enter the following command:
/etc/init.d/team ng stop
You should see the same output as when you started Vibe.
2 To verify that Vibe has stopped, check for its PID number:
ps -eaf | grep teanming

The Vibe PID number, along with a listing of configuration settings, should no longer be
displayed.

Uninstalling Vibe

If you move the Vibe site to a different server, you can delete the Vibe files from the original server to

reclaim disk space. The default Vibe file locations are:
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Vibe Software [ opt/novel | /t eani ng

Vibe File Repository and [ var/opt/novel | / t eam ng
Lucene Index

MySQL or MariaDB [var/1iblmysql
Database
Postgresgl Database /var/1ibl pgsql

For a complete list of your Vibe files, check the i nstal | er. xm file in the directory where you
originally ran the Vibe installation program.

Windows: Installing and Setting Up a Basic Vibe Site

You should already have reviewed Chapter 8, “Planning a Basic Vibe Installation,” on page 51 and
filled out the Basic Vibe Installation Summary Sheet. The following sections step you through the
process of installing and starting Micro Focus Vibe on Windows:

+ “Performing Pre-Installation Tasks on Windows” on page 82

+ “Running the Windows Vibe Installation Program” on page 83
+ “Creating the Vibe Database” on page 84

+ “Performing Post-Installation Tasks on Windows” on page 86

Performing Pre-Installation Tasks on Windows

+ “Verifying System Requirements” on page 82
+ “Stopping an Existing Web Server” on page 82
+ “Setting Environment Variables” on page 83

Verifying System Requirements

Ensure that the Windows server where you plan to install Vibe meets the system requirements listed
in “Vibe Server Requirements” on page 19.

Stopping an Existing Web Server

If a web server is currently running on the Vibe server, stop it, and preferably disable it.
For example, to stop and disable the Internet Information Services (1IS) web server:

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click World Wide Web Publishing Service, then click Properties.
3 Inthe Startup type drop-down list, select Disabled.

4 Click Stop, then click OK.

82 Installing and Setting Up a Basic Vibe Site



Setting Environment Variables

Ensure that the JAVA_HOME environment variable is set to the path where you installed the JDK and
that the Windows PATH environment variable includes the path to your database server.
1 Right-click My Computer, then click Properties.
2 Onthe Advanced tab, click Environment Variables.
3 Set the JAVA_HOME environment variable:
3a Inthe System variables box, click New.
3b Inthe Variable name field, specify JAVA_HOME.
3c Inthe Variable value field, specify the path where you installed the JDK.

3d Click OK to add the JAVA_HOME environment variable to the list of system variables, then
click OK again to save the setting and return to the Advanced tab.

4 Check the PATH environment variable:
4a On the Advanced tab, click Environment Variables.
4b In the System variables list, locate the PATH environment variable.
4c If the path includes your database server software directory, click Cancel.
or

If the path does not include your database server software directory, add the directory, then
click OK.

Running the Windows Vibe Installation Program

1 Log in to the Windows server as a user with Administrator rights.

2 In Windows Explorer, browse to the directory where you downloaded and extracted the Vibe
software.

3 Ensure that thereis ali cense-key. xm file in the directory.

The Vibe installation program does not start without a license file, and it has a different name
when you download it.

For more information about licensing, see Chapter 11, “Updating Your Vibe License,” on
page 91.

4 Double-click the i nst al | er -t eam ng. exe file to start the Vibe installation program.

5 Accept the License Agreement, then click Next.

, :

Installation Options N

Select the action you want to perform.

& New installation
(" Update software and settings

" Reconfigure settings

6 Click Next to accept the default of New installation.
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: :
0ot tsion e S ==

‘Choose Installation Type

Select the type of installation you want to perform N

Select the Basic installation if you do not want to configure any of
| Advanced the optional features. |

7 Click Next to accept the default of Basic.

8 Use the information that you have gathered on the Basic Vibe Installation Summary Sheet to
provide the information that the Vibe installation program prompts you for:

Installation Locations
Default Locale for Micro Focus Vibe
Network Information
WebDAV Authentication Method
Database Selection
Database Type
JDBC URL
Credentials
Setup
Encryption Algorithm
Java JDK Location
Outbound Email Configuration
Protocol
Host, Port, and Time Zone
User Name, Password, and Authentication
Allow Sending Email to All Users
Inbound Email Configuration
Adding File Types for HTML Conversions

The installation program stores the information that it gathers in the i nstal | er. xnl file in the
same directory where you started the installation program.

9 After you have provided all the requested information, click Install to begin the Vibe installation.
10 When the installation is complete, click Finish to exit the Vibe installation program.

Information about the installation process is written to the i nst al | er. | og file in the same
directory where you ran the Installation program. If a problem arises during the installation, the
i nstal | er. | og file provides information that can help you resolve the problem.

11 Continue with “Creating the Vibe Database” on page 84.

Creating the Vibe Database

IMPORTANT: The following procedures are performed at the command prompt.

Before you can start Vibe, you need to create the Vibe database.

1 If you haven't done so already, install the database on the Vibe server.
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For single-server installations running on Windows, install either the MySQL/MariaDB,
Postgresql, or Microsoft SQL database. (For information about how to install the PostgreSQL,
MySQL or MariaDB database on the Vibe server (on Windows), see “PostgreSQL on Windows”
on page 238 and “MySQL or MariaDB on Windows” on page 236).

For more information about installing the database for a multi-server Vibe system, see
Chapter 18, “Creating the Vibe Database on a Remote Server,” on page 137.

Open a command prompt window, then change to the following directory in your Vibe
installation:

vibe_installation\tenp-installer\db\scripts\sqgl

This directory contains the following scripts for each database type (MySQL/MariaDB, Microsoft
SQL, and Oracle):

* nysql - creat e- enpt y- dat abase. sql

¢ Oracl e-creat e-enpt y- dat abase. sql

* post gresql -creat e-enpt y- dat abase. sql
* sql server-creat e-enpt y-dat abase. sql

(Optional) If you need to change the default database name from si t escape to something else,
edit the . sql file for your database type to replace si t escape with the new name.

Open a command terminal, then use the database utility command for your database type to run
the corresponding script for your database from the vi be_i nstal | ati on_source/t enp-
instal | er/db/scripts/sql directory:

MySQL/ nysql -uadm n-usernane -ppassword < "nysql -creat e- enpt y- dat abase. sql "
MariaDB:

Microsoft ~ osgl -Uadm n-usernanme -Ppassword -i sql server-create-enpty-database. sql

SQL:
You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/

downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to create the database.

Oracle: sql plus "/ as sysdba"
SQ@.>spool updat e-oracl e. out;
SQ>@r acl e- cr eat e- enpt y- dat abase
SQL>qui t;

Postgresql: psqgl - Uadm n-username < "postgresql -create-enpty-dat abase. sql "

You are prompted for the password that you set for the admin user.

Change to the db directory in the Vibe installation:
vibe_installation_source\tenp-installer\db
This directory contains the following properties files:

* nysql -1iqui base. properties

¢ Oracle-liquibase. properties

+ postgresql-1iqui base. properties

* sql server-1iqui base. properties

In a text editor, open the properties file that corresponds with your database type and make the
applicable changes in both the Dri ver and ref erenceDri ver sections. Save and close the text
editor when you are finished making changes.

+ Change the database user name and password for accessing the database.
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+ (Conditional) Specify the IP address for the database if it is running on a remote server.
You need to replace | ocal host with the IP address of the remote server.

+ (Optional) Change the name of the Vibe database (the default name of the Vibe database is
si t escape, the name of the company that previously developed the Vibe software).

In the same directory, execute the following command to create the database schema:
manage- dat abase. bat dat abase_t ype updat eDat abase
For example, if you are using a Microsoft SQL database:

manage- dat abase. bat sql server updat eDat abase

NOTE: You can safely ignore the following Liquibase log messages:

+ Warning: nodifyDataType will [ose primary key/autoincrenent/not null
settings for nysql

+ Any messages that contain the words i nfo: failureorinfo: failed, aslong as they
are associated with a type | NFOmessage

Start the Vibe server as described in “Running Vibe as a Windows Service” on page 86 and
“Running Vibe as a Windows Application” on page 88.

For security reasons, delete the password that you specified in Step 7:
9a Change to the following directory in your Vibe installation:
vibe_installation_source\tenp-installer\db

9b In atext editor, open the database script that corresponds with your database type to delete
the password.

Continue with “Performing Post-Installation Tasks on Windows” on page 86.

Performing Post-Installation Tasks on Windows

*

“Checking for Available Hot Patches” on page 86
“Running Vibe as a Windows Service” on page 86
“Running Vibe as a Windows Application” on page 88
“Uninstalling Vibe” on page 88

Checking for Available Hot Patches

After you install Vibe, ensure that you check on the Vibe download site where you downloaded the
Vibe software for any hot patches that might be available.

Running Vibe as a Windows Service

*

“Removing Vibe as a Windows Service” on page 87

“Configuring Vibe as a Windows Service” on page 87

“Starting Vibe as a Windows Service” on page 87

“Configuring the Vibe Service to Start Automatically on Reboot” on page 87
“Restarting the Vibe Service” on page 88

“Stopping the Vibe Service” on page 88

Installing and Setting Up a Basic Vibe Site



Removing Vibe as a Windows Service

The Vibe installation program creates a ser vi ce. bat file that you can use to remove the Vibe
service.

1 Inthe c:\ Program Fi | es\ Novel | \ Teani ng\ apache-t ontat\ bi n\ wi ndows directory, copy the
files from the appropriate subdirectory—x86, x64, or i a64.

If you are unsure which subdirectory is appropriate for your server, use the r eadne. t xt file
located in the windows directory as a reference.

2 Paste the files into the c: \ Program Fi | es\ Novel | \ Teani ng\ apache-t ontat\ bi n directory.
3 Ina Command Prompt window, change to the following directory:

c:\ Program Fi | es\ Novel | \ Team ng\ apache-tontat\bin
4 Use the following command to configure Vibe as a Windows service:

servi ce. bat renmove Teani ng

This removes a service named Apache Tomcat Teaming.

Configuring Vibe as a Windows Service

The Vibe installation program created a ser vi ce. bat file for configuring Vibe to run as a Windows
service.
1 In a Command Prompt window, change to the following directory:
c:\ Program Fi | es\ Novel | \ Team ng\ apache-tontat\bin
2 In the wi ndows directory, copy the files from the appropriate subdirectory.
The following subdirectories exist: x86, x64, i a64.

If you are unsure which subdirectory is appropriate for your server, use the r eadne. t xt file
located inthe c: \ Program Fi | es\ Novel | \ Teani ng\ apache-t ontat \ bi n\ wi ndows directory as
a reference.

3 Paste the files into the c: \ Program Fi | es\ Novel | \ Teani ng\ apache-t ontat\ bi n directory.
4 Use the following command to configure Vibe as a Windows setrvice:

service.bat install Team ng

This creates a service named Apache Tomcat Teaming.

Starting Vibe as a Windows Service

IMPORTANT: If you named your Vibe service something other than “Teaming,” substitute your
service name for Teaming in the sections that follow.

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Start.

Configuring the Vibe Service to Start Automatically on Reboot

When you run Vibe as a Windows service, you can configure Vibe to start automatically each time
you reboot the Windows server.

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Properties.
3 Inthe Startup type drop-down list, select Automatic, then click OK.
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Restarting the Vibe Service

You need to restart Vibe whenever you use the Vibe installation program to make configuration
changes, as described in Chapter 15, “Performing an Advanced Vibe Installation,” on page 127.

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Restart.
3 Close the Services window.

Stopping the Vibe Service

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Stop.
3 Close the Services window.

Running Vibe as a Windows Application

+ “Starting Vibe as an Application” on page 88
+ “Stopping Vibe as an Application” on page 88
Starting Vibe as an Application
The Vibe installation program created a st ar t up. bat file for starting Vibe.

1 In a Command Prompt window, change to the following directory:
c:\ Program Fi | es\ Novel | \ Team ng\ apache-tontat\bin
2 Runthe st artup. bat file to start Vibe as an application.

Stopping Vibe as an Application

1 In a Command Prompt window, change to the following directory:
c:\ Program Fi | es\ Novel | \ Team ng\ apache-tontat\bin
2 Run the shut down. bat file to stop the Vibe application.

Uninstalling Vibe

If you move the Vibe site to a different server, you can delete the Vibe files from the original server to
reclaim disk space. The default Vibe file locations are:
Vibe Software c:\ Program Fi | es\ Novel |\ Team ng

Vibe File Repository and c:\ Novel I'\ Team ng
Lucene Index

MS SQL Database c:\Program Fil es\M crosoft SQ. Server\MSSQ.\ Dat a

For a complete list of your Vibe files, check the i nstal | er. xm file in the directory where you
originally ran the Vibe Installation program.
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10 Adding Users to Your Vibe Site

After you have installed Micro Focus Vibe and ensured that Vibe starts successfully, you are ready to
access your Vibe site from your web browser and add users.

+ “Accessing Your Basic Vibe Site as the Site Administrator” on page 89
+ “Creating a User” on page 89
+ “Adding Vibe Users from Your LDAP Directory” on page 90

Accessing Your Basic Vibe Site as the Site
Administrator

1 In your web browser, specify one of the following URLs, depending on whether you are using a
secure SSL connection:

http://vi be_host nane
htt ps://vi be_host nane

Replace vi be_host name with the hostname or fully qualified domain name of the Vibe server
that you have set up in DNS. If you configured the HTTP ports correctly during installation, you
do not need to include the port number in the Vibe URL.

Novell. Vibe

User D

Password

Forgot your password?

2 If this is the first time you have logged in to the Vibe site, log in using adm n as the login name
and adni n as the password.

The Change Password dialog box is automatically displayed when you first log in to the Vibe
site.

If this is not your first time logging in, log in using adni n as the login name and your password.

Creating a User

For information about how to create a local user in the Vibe system, see “Creating a New Local User”
in the Micro Focus Vibe 4.0.4 Administration Guide.
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Adding Vibe Users from Your LDAP Directory

Unless you have a very small Micro Focus Vibe site, you create Vibe users by synchronizing their
user information from an LDAP directory service such as eDirectory, Active Directory, or GroupWise.

For information about how to add users to your Vibe system via LDAP, see “Synchronizing Users and
Groups from an LDAP Directory” in the Micro Focus Vibe 4.0.4 Administration Guide.

IMPORTANT: Consider the following before you add users to your Vibe system:

+ For a large Vibe site with thousands of users, the synchronization process can consume
substantial server resources and can take some time to complete. Perform the initial import from
the LDAP directory at a time when this processing does not conflict with other activities on the
server.

+ After they are added to the Vibe system, users could log into the Vibe site by using their
eDirectory, Active Directory, or GroupWise user names and passwords. However, you should not
invite users to access the Vibe site until after you have finished setting up the Vibe site, as
described in “Site Setup” in the Micro Focus Vibe 4.0.4 Administration Guide.
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Updating Your Vibe License

Several Vibe license types are available:
+ Evaluation License: Available from Novell Downloads (http://download.novell.com).

You receive your 60-day evaluation license when you download the evaluation version of Vibe.

+ Standard Vibe License: Purchased through a Micro Focus sales representative or Micro Focus
partner.

The Standard Vibe License gives full Vibe functionality on a per-user basis.
After you purchase the Standard Vibe License, you can access your license key or view your
purchase history in the Novell Customer Center (http://www.novell.com/customercenter).

If you are upgrading to a new version of Vibe, or if you originally installed Vibe with an Evaluation
License, it is easy to update your Vibe site with a new license file.

1 Copy the new license file that you downloaded from one of the sources listed above into the
directory where you originally ran the Vibe installation program.

Rename the existing | i cense- key. xni file to a different name.

Rename the new license file to | i cense- key. xni .

Stop Vibe.

Run the Vibe Installation program, select the Reconfigure Settings option, then select the Basic
Installation option.

a A~ W N

6 Click Next through all the installation program pages, then click Install to update your Vibe
license.

7 Start Vibe.
8 Log in to the Vibe site as the Vibe administrator.
9 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon *'.
10 Under Management, click License.
11 If the contents of the new license file are not displayed, click Reload Vibe License.
12 Click Close.

At any time, you can generate a report of license usage, as described in “License Report” in “Site
Maintenance” in the Micro Focus Vibe 4.0.4 Administration Guide.
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Setting Up Vibe

After you have installed and started Micro Focus Vibe, there are still administrative tasks to perform
before your Vibe site is ready for users to log in and use Vibe efficiently. Refer to the following
sections of the Micro Focus Vibe 4.0.4 Administration Guide as you finish setting up your Vibe site.

*

*

“Setting Up Initial Workspaces”

“Planning and Controlling User Access to Workspaces and Folders”
“Setting Up User Access to the Vibe Site”

“Setting Up Site-Wide Customizations”

“Configuring Vibe to Support WebDAV on Windows 7”
“Configuring Email Integration”

“Configuring Weekends and Holidays”

“Configuring Real-Time Communication Tools”

“Enabling Custom JSPs to Be Used on Your Vibe Site”
“Enabling Custom JAR Files to Be Used on Your Vibe Site”
“Setting Up Mirrored Folders”

“Setting Up Zones (Virtual Vibe Sites)”

“Adding Software Extensions to Your Vibe Site”

“Using Remote Applications on Your Vibe Site”

“Managing a Multiple-Language Vibe Site”
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3 Basic Vibe Installation Summary Sheet

Installation Program Field

Your Setting/Choice

Explanation

Vibe Server Platform:

+ Windows

¢ Linux

See “Vibe Server Platform” on
page 52.

Vibe Server Architecture:

¢ 32-bit
* 64-bit

See “Vibe Server Architecture” on

page 52.

Vibe Server Memory:

¢ 4GB
¢+ 8GB

¢ More

See “Vibe Server Memory” on
page 53.

Java Development Kit (JDK):

¢ Sun JDK
¢ |BM JDK

See “Selecting a Java
Development Kit” on page 55.

Vibe Installation Locations:
¢ Software
Linux default:
/opt/novel | /teami ng
Windows default:

c:\ Program
Fi | es\ Novel I\ Team ng

* File repository

Linux default:

/var/opt/novel I/t eam ng

Windows default:

c:\ Novel I'\ Team ng

See “Vibe Installation Locations”
on page 54.

TrueType Font Location:
Default:

fusr/ X11R6/1i b/ X11/font s/
truetype

[ usr/share/fonts/truetype

See “TrueType Font Location
(Linux Only)” on page 55.
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Installation Program Field

Your Setting/Choice

Explanation

Vibe Site Locale:
Language:

¢ Chinese-Simplified

¢ Chinese Traditional

¢ Danish

¢ Dutch

+ English

+ French

*+ German

¢ Hungarian

+ Japanese

+ Polish

* Portuguese

¢ Russian

¢ Spanish

+ Swedish

Country:

See “Accommodating Multiple
Languages” on page 69.

User ID for Micro Focus Vibe (Linux

only):
* User ID:
Full name:

Password:

¢ Group ID:

See “Linux User ID for Vibe” on
page 68.

Network Information:

¢ Host:

¢ HTTP port: 80

¢ Secure HTTP port: 443
¢ Listen port: 8080

* Secure listen port: 8443
¢ Shutdown port:

* AJP port:

See “Gathering Network
Information for Your Vibe Site” on
page 55.

WebDAV Authenticaiton Method:

+ basic

+ digest

See "Planning the WebDAV
Authentication Method” on
page 58.

Basic Vibe Installation Summary Sheet



Installation Program Field Your Setting/Choice

Explanation

Database Type:

* MySQL/MariaDB
* Microsoft SQL
¢ Oracle

* PostgreSQL

See “Database Type” on page 60.

JDBC URL:

¢ Hostname:

* Port number:

See “Database Location” on
page 61.

Database Credentials:

+ User name:

+ Password:

See “Database Credentials” on
page 62.

Database Setup Method:

+ Basic installation (same server as
Vibe software)

+ Remote installation

See “Database Setup Method” on
page 61.

Database Encryption Algorithm:

¢ SHA-256

¢+ PBEWITHSHA256AND128BITAES-
CBC-BC

See “Database Encryption
Algorithm” on page 62.

Java JDK Location:

+ Java home:

+ JVM heap size:

See “Selecting a Java
Development Kit” on page 55.

Outbound Email Protocol:

¢ SMTP
¢ SMTPS

See “Outbound Email Protocol” on
page 63.

Outbound Email Host:

¢ Hostname:
¢ SMTP port:
Default: 25
¢ Time zone
+ Continent/region:
+ Country/state:

* City:

See “Outbound Email Host” on
page 64.
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Installation Program Field Your Setting/Choice

Explanation

Outbound Email Authentication:

¢ User name:
* Password:

+ Authentication required? No / Yes

See “Outbound Email
Authentication” on page 64.

Allow Sending Email to All Users

Yes / No

See “Outbound Email Send
Restriction” on page 65.

From email address override
+ Email address for outbound email

Use this email address for all
outbound email

Yes / No

See “Outbound Email From
Address” on page 65.

Inbound Email Configuration

+ Enable: No/ Yes
¢ SMTP bind address:
¢ SMTP port:

+ Announce TLS: Yes/ No

See “Enabling Inbound Email” on
page 65.

File Types for HTML Conversions

¢ Added HTML Extensions:

See “Adding File Types for HTML
Conversions” on page 67

Vibe Site Password:

+ Administrator user name: admin
+ Default password: admin

* Your password:

See “Vibe Site Administrator
Password” on page 67.

LDAP Directory Service:

+ eDirectory
* GroupWise

+ Microsoft Active Directory

See “Synchronizing Users and
Groups from an LDAP Directory
in the Micro Focus Vibe 4.0.4
Administration Guide.

LDAP Server:

¢ LDAP server URL:
¢ User DN:

+ Password:

See “Server Information” in the
Micro Focus Vibe 4.0.4
Administration Guide.

GUID Attribute (to identify the user):

* For eDirectory, select GUID.

* For Active Directory, select
objectGUID.

* For GroupWise, select entryUUID.

See “Server Information” in the
Micro Focus Vibe 4.0.4
Administration Guide.
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Installation Program Field

Your Setting/Choice

Explanation

Vibe Account Name Attribute:

+ LDAP Attribute that is used for Vibe
usernames.

See “Server Information” in the
Micro Focus Vibe 4.0.4
Administration Guide.

LDAP User Search Context:

+ Base DNs:
+ Additional filter attributes:

+ Search subtree: Yes / No

See “Configuring User
Synchronization Options” in the
Micro Focus Vibe 4.0.4
Administration Guide.

LDAP Group Search Context:

+ Base DNs:
+ Additional filter attributes:

+ Search Subtree: Yes / No

See “Configuring Group
Synchronization Options” in the
Micro Focus Vibe 4.0.4
Administration Guide.

LDAP Synchronization Schedule:

¢ Days
+ Every day
* Weekly
Sun Mon Tue Wed Thu Fri Sat

¢ Hours:
¢ Attime:

+ Repeat every nn hours

See “Configuring the
Synchronization Schedule” in the
Micro Focus Vibe 4.0.4
Administration Guide.

LDAP User Options:

+ Synchronize user profiles

* Register LDAP user profiles
automatically

+ Delete users that are not in LDAP

+ When deleting a user, delete
associated user workspaces and
content

+ Time zone for new users

See “Configuring User
Synchronization Options” in the
Micro Focus Vibe 4.0.4
Administration Guide.

LDAP Group Options:

+ Synchronize group profiles

* Register LDAP group profiles
automatically

+ Synchronize group membership

+ Delete local groups that are not in
LDAP

See “Configuring User
Synchronization Options” in the
Micro Focus Vibe 4.0.4
Administration Guide.
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I Advanced Installation and
Reconfiguration

*

*

Chapter 14,
Chapter 15,
Chapter 16,
Chapter 17,

“Planning an Advanced Vibe Installation,” on page 103
“Performing an Advanced Vibe Installation,” on page 127
“Setting Configuration Options after Installation,” on page 129
“Advanced Vibe Installation Summary Sheet,” on page 131
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4 Planning an Advanced Vibe Installation

The Advanced installation provides additional options for you to customize Micro Focus Vibe.

*

*

*

“What Is an Advanced Installation?” on page 103

“Distributing Different Data Types to Different Locations” on page 104
“Using Advanced Network Information Settings” on page 105
“Configuring Requests and Connections Configuration” on page 106
“Configuring Web Services” on page 107

“Changing Your Lucene Index Server Configuration” on page 107
“Managing RSS Feeds” on page 109

“Configuring Presence” on page 110

“Configuring Single Sign-On with Novell Access Manager” on page 111
“Configuring Single Sign-On with Internet Information Services for Windows” on page 111
“Configuring Mirrored Folder Resource Drivers” on page 123

“Installing the Vibe Software in a Clustered Environment” on page 125

As you proceed with planning, you can use the Advanced Vibe Installation Summary Sheet to record
your decisions about the options you want to use.

What

Is an Advanced Installation?

In addition to the Basic installation options described in “What Is a Basic Vibe Installation?” on
page 51, the installation program for Vibe provides several advanced installation and configuration
alternatives. You can implement the advanced options after performing a Basic installation, or you
can have the installation program present all the options together.

Compared to a Basic installation, an Advanced installation offers the following additional options:

*

*

Changing the session timeout

Specifying a keystore file

Specifying different directories for different types of data

Configuring requests and connections configuration

Disabling and enabling four different web services

Changing the configuration of the Lucene Index Server

Configuring a remote Lucene Index Server or a group of high-availability Lucene nodes
Reconfiguring how RSS feeds are retained or disabling them entirely
Enabling presence in conjunction with GroupWise Messenger
Configuring a reverse proxy to accommodate single sign-on
Configuring Windows Authentication

Configuring mirrored folders

Installing Vibe in a clustered environment
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IMPORTANT: The following Vibe configurations require that you perform an Advanced installation as
your initial installation of the Vibe software:

+ Setting up the Vibe file repository so that some types of files are located outside the Vibe file

repository root directory. See “Distributing Different Data Types to Different Locations” on
page 104 for Advanced installation instructions. You cannot move subdirectories within the Vibe
file repository after they have been created.

Installing the Vibe software on multiple servers to create a clustered environment. See

Chapter 20, “Running Vibe on Multiple Servers,” on page 149 for Advanced installation
instructions. The option to enable a clustered environment is available only during an Advanced
installation.

If you want to implement an Advanced installation option, you should perform a Basic installation first,
in a test environment, before performing the Advanced installation to set up your permanent Vibe site.

Distributing Different Data Types to Different
Locations

The default location for the Micro Focus Vibe file repository varies by platform:

Linux: /var/ opt/novel |/t eam ng

Windows: c:\ Novel I\ Team ng

Under the main Vibe file repository root directory are subdirectories for various kinds of data files that

are not stored in the Vibe database (MySQL/MariaDB, Microsoft SQL Server, Oracle, or
PostgreSQL). You can use an Advanced installation to store Vibe data files in various locations.

The data files not stored in the Vibe database are divided into several functional areas:
+ Simple file repository: A large consumer of disk space.

All attachment files are stored in the file repository. All versions of files are also stored here.

+ Jackrabbit repository: (Optional) Takes only a fraction of the space consumed by the file
repository.

By default, Vibe stores all data files individually on disk, in the file repository. If you prefer to store

data files in the database itself, you can use Apache Jackrabbit with Vibe. See the Apache
Jackrabbit website (http://jackrabbit.apache.org) for setup instructions.

+ Extensions repository: Disk space consumption depends on the number of extensions you
add to your Vibe site.

An extension is a software program that you can incorporate into your Vibe site in order to

enhance (extend) Vibe capabilities. Adblock Plus is an example of a Firefox browser extension
that filters out advertisements. You or a Java developer can create custom extensions for your
Vibe site. For more information about creating and using Vibe extensions, see the Micro Focus
Vibe 4.0.4 Developer Guide.

+ Archive store: Alarge consumer of disk space.

When entries are deleted, files that were attached to the deleted entries are retained in the
archive store in order to meet compliance and archival goals. Previous versions of documents
are also retained in the archive store. After files have been archived, they are inaccessible from
the Vibe site. Files that accumulate in the archive store must be manually deleted as needed to
manage the disk space occupied by the archive store.
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¢ Cache store: Consumes less disk space than the file repository.

Information derived from the attachments (such as thumbnails, HTML renderings, scaled
images), and word lists for indexing are stored in the cache store.

+ Lucene index: Takes only a fraction of the space consumed by the file repository.

The Lucene index contains only pointers to the actual data stored in the file repository. The index
enables the Lucene search engine to perform very fast searches through large quantities of
data.

The directories for the various types of data can be on the Vibe server or on a remote server. Data
access is fastest if the data is local; however, depending on the size of your Vibe site and the types of
data you store, the Vibe server might not be the best place to store all the Vibe data. If you want to
store any of the data types on a remote server, you must ensure that the remote location of the data
appears local to the Vibe server and that it is always available with read/write access.

Linux: Mount the file repository to the Vibe server.

Windows: Map a drive from the Vibe server to the file repository.

Linux and Place the file repository on a SAN (storage area network) with read/write access. This alternative

Windows provides the most reliable remote location for the Vibe file repository. This is required for a
clustered environment, as described in Chapter 20, “Running Vibe on Multiple Servers,” on
page 149.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Data Locations, specify the directories where you want to store the various types of Vibe data.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 15, “Performing an Advanced Vibe Installation,” on
page 127.

Using Advanced Network Information Settings

+ “Changing the Vibe Session Timeout” on page 105

+ “Providing a Secure Keystore File” on page 106

Changing the Vibe Session Timeout

By default, if a user's Micro Focus Vibe session is idle for four hours (240 minutes), Vibe logs the idle
user out. For increased convenience to Vibe users, you can make the session timeout interval longer.
For increased security for your Vibe site, you can make the session timeout shorter.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the session timeout interval (in minutes) for your Vibe site.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 15, “Performing an Advanced Vibe Installation,” on
page 127.
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Providing a Secure Keystore File

For your convenience, the Vibe software includes a self-signed public certificate that enables you to
specify secure HTTP and listen ports during installation. This certificate is stored in the . keyst or e file
in the following directory:

Linux: / opt/ novel | / t eam ng/ apache-t ontat/ conf

Windows: c:\ Program Fi | es\ Novel |\ Tean ng\ apache-t ontat\ conf

To ensure secure SSL connections for your Vibe site, you should replace the self-signed public
certificate with a public certificate issued by a valid certificate authority.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the name and location of the public certificate.

If you do not already have a permanent public certificate for your Vibe server, see “Securing HTTP
Browser Connections” in “Site Security” in the Micro Focus Vibe 4.0.4 Administration Guide.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 15, “Performing an Advanced Vibe Installation,” on
page 127.

Configuring Requests and Connections
Configuration

You can configure the number of client requests and database connections that Vibe is able to
support.

If you have an extremely large Vibe site and you need to make numerous client requests and
database connections, you might see improved performance by increasing these settings.

+ Max Threads: The maximum number of simultaneous client request threads that Vibe is able to
support. The default is 200 threads.

+ Max Active: The maximum number of database connections that can be allocated from this pool
at the same time.

If your database server license (for Oracle or MS SQL) restricts you from having more
connections than the Vibe default of 50, you must specify a number that does not exceed your
database server license.

+ Max Idle: The maximum number of database connections that can be idle in this pool at the
same time. The default is 20 connections.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Requests and Connections Configuration, mark the maximum client request threads, maximum
active database connections, and maximum idle database connections.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 15, “Performing an Advanced Vibe Installation,” on
page 127.
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Configuring Web Services

When you install and set up your Micro Focus Vibe site, three web services are enabled by default; a
fourth is available for selection. These web services enable programs to access information on your
Vibe site just as users would. Allowing programmatic access to your Vibe site can be useful or can be
viewed as a security risk.

+ WSS authentication: Uses OASIS Web Services Security (WSS) (http://www.oasis-open.org).

+ HTTP Basic authentication: Uses HTTP Basic Access authentication (http://tools.ietf.org/html/
rfc2617).

+ Token-based authentication: Uses custom Vibe tokens to communicate with Vibe remote
applications. For more information, see “Using Remote Applications on Your Vibe Site” in “Site
Setup” in the Micro Focus Vibe 4.0.4 Administration Guide.

+ Anonymous access: Allows access to your Vibe site without authentication. It is similar to the
Guest access provided for users, as described in “Allowing Guest Access to Your Vibe Site” in
“Site Setup” in the Micro Focus Vibe 4.0.4 Administration Guide.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Web Services, mark which web services you want enabled for your Vibe site. The first three are
enabled by default. The fourth is disabled by default.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 15, “Performing an Advanced Vibe Installation,” on
page 127.

Changing Your Lucene Index Server Configuration

The default Lucene Index Server configuration is appropriate for a medium-sized Micro Focus Vibe
site. If you have a larger Vibe site, you can change its Lucene Index Server configuration.

¢ “Understanding Indexing” on page 107

+ “Changing Lucene Configuration Settings” on page 108

+ “Running the Lucene Index Server in Its Own JVM” on page 108

+ “Running the Lucene Index Server on a Remote Server” on page 109

+ “Running Multiple Lucene Index Servers” on page 109
After planning your Lucene configuration, complete the planning process for additional Advanced

installation features as needed, then perform the Advanced installation as described in Chapter 15,
“Performing an Advanced Vibe Installation,” on page 127.

Understanding Indexing

The Lucene Index Server is responsible for indexing all data on the Vibe site so that Vibe users can
easily use the Find and Search features to retrieve the information that they need. Text posted in
folder entries is easy to index, because the formatting is simple. However, text in attached files arrives
in many different file formats, many of which require conversion before the text in the files can be
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indexed. Therefore, the Lucene Index Server is dependent on the available file conversion
technology in order to perform its indexing function. For information about the file viewers that Vibe
uses, see “File Viewer Support” on page 25.

The Lucene Index Server provides additional services on your Vibe site in addition to indexing. In
fact, you cannot access your Vibe site if the Lucene Index Server is not running.

Changing Lucene Configuration Settings

If you have an extremely large Vibe site and you need to reindex the Vibe data, you might see
improved performance by increasing these settings.

+ Max booleans: The default is 10000. This means that 10,000 Boolean clauses are allowed in a
guery. You need to increase this only if your Vibe site includes more than 10,000 users, groups,
or teams.

+ RAM in MB that may be used for buffering: The default is 256 MB for remote and high
availability Lucene configurations and 32 MB for local Lucene configurations. This is the amount
of RAM that is allocated for buffering documents and deletions before they are flushed to the
directory. (This setting can be changed only in the Lucene installer; it is not available in the Vibe
installer.)

+ Merge factor: The default is 10. This sets the number of index segments that are created on
disk. When additional index segments are needed, existing segments are merged to keep the
merge factor constant.

+ Network interface for RMI service: (Optional) Specify the IP address or hostname for the
network interface for the RMI (Remote Method Invocation (http://java.sun.com/javase/
technologies/core/basic/rmi/index.jsp)) service.

This is the hostname of the server where the Lucene Index is installed.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Lucene Configuration, specify any Lucene configuration settings that you want to change.

Running the Lucene Index Server in Its Own JVM

By default, the Lucene Index Server runs in the same Java Virtual Machine (JVM) as the Vibe
software. To leave more memory available for the Micro Focus Vibe software, you can configure the
Lucene Index Server to run in a separate JVM. In this configuration, it communicates with the Vibe
software using the RMI (Remote Method Invocation (http://java.sun.com/javase/technologies/core/
basic/rmi/index.jsp)) port, which by default is 1199.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Lucene Configuration, specify a hostname of | ocal host . Use the default RMI port number
unless it is already in use on the server.

To change from running the Lucene Index Server in the same JVM with Vibe to running it in its own
JVM, you must complete the same steps that you use for setting up the Lucene Index Server on a
remote server. This includes manually installing the Lucene Index Server software on the Vibe server,
as described in Chapter 19, “Installing the Lucene Index Server on a Remote Server,” on page 145.

Planning an Advanced Vibe Installation


http://java.sun.com/javase/technologies/core/basic/rmi/index.jsp
http://java.sun.com/javase/technologies/core/basic/rmi/index.jsp

Running the Lucene Index Server on a Remote Server

If the Lucene Index Server requires more memory, disk space, or CPU resources than are available
on the Micro Focus Vibe server, you can move it to a remote server. This requires installing the
Lucene Index Server software on that server. For instructions, see Chapter 19, “Installing the Lucene
Index Server on a Remote Server,” on page 145.

Running Multiple Lucene Index Servers

Because the availability of the index is critical to the functioning of the Micro Focus Vibe site, you can
install multiple Lucene Index Servers on multiple remote servers to provide high availability. For
instructions, see Chapter 21, “Running Multiple Lucene Index Servers,” on page 157.

Managing RSS Feeds

By default, Micro Focus Vibe users can set up RSS feeds in folders on the Vibe site, as described in
“Viewing Folders as RSS or Atom Feeds” in “Getting Informed” in the Micro Focus Vibe 4.0.5 User
Guide.

+ “Configuring RSS Feeds” on page 109
+ “Disabling RSS Feeds” on page 109
After planning the RSS settings, complete the planning process for additional Advanced installation

features as needed, then perform the Advanced installation as described in Chapter 15, “Performing
an Advanced Vibe Installation,” on page 127.

Configuring RSS Feeds

The following aspects of RSS functionality on your Vibe site are configurable:

+ Max elapsed days: By default, items from RSS feeds are retained on the Vibe site for 31 days.
You can decrease the number of days to reduce the amount of disk space occupied by the RSS
files.

+ Max inactive days: By default, if no one on the Vibe site accesses an RSS feed for 7 days, the

feed is no longer updated. Increase or decrease the retention time for inactive feeds to meet the
needs of Vibe users and disk space considerations.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under RSS Configuration, specify the number of days that meet the needs of your Vibe site.

Disabling RSS Feeds

Some administrators consider RSS feeds to be a security risk because the RSS feed URL includes
user name and password information. If you do not want Vibe site users to be able to subscribe to
RSS feeds from the Vibe site, you can disable this feature.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under RSS Configuration, mark No.
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Configuring Presence

If you are using GroupWise Messenger as your instant messaging solution, you can configure Micro
Focus Vibe to display a user's Messenger presence information. For information about where
presence information is displayed in Vibe, see “Sending an Instant Message from within Vibe” in the
Micro Focus Vibe 4.0.5 User Guide.

When you click a user’s presence icon, the Profile Quick View is displayed. This enables you to send
an instant message to the user, view the user’s personal workspace, follow the user, and more.

In order to configure Messenger presence to be displayed in Vibe, you need the following information
about the Messenger system during the Vibe installation:

+ Server address: Specify the IP address or DNS hostname of the messaging agent for your
Messenger system.
+ Port: Specify the port number.

+ Server user: Specify the fully typed, comma-delimited context user name of the Allowed Service
User that you want to log in to the Messenger system and retrieve presence information.

For example, cn=vi besvc, o=acne

For more information about the Allowed Service User, see “Integrating Micro Focus Vibe with
GroupWise Messenger” in the GroupWise Messenger 18 Administration Guide

+ Password: Specify the password for the Allowed Service User that you want to log in to the
Messenger system and retrieve presence information.

For more information about the Allowed Service User, see “Integrating Micro Focus Vibe with
GroupWise Messenger” in the GroupWise Messenger 18 Administration Guide.

+ Server Certificate: Browse to and select the Messaging Agent’s SSL certificate. Vibe uses this
certificate to identify the Messenger server.

If Messenger is installed on a separate server, copy the certificate from the Messenger server
and place it in a location on the Vibe server that can be reached from the Vibe installation
program.

The certificate is located in the following directory on the Messenger server:

Linux: / opt/novel | / nessenger/certs

Windows: c:\Novel | \ Messenger\certs

To remove the certificate after you have already selected it, click Browse > Cancel.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Presence Configuration, select Enable GroupWise Messenger Presence, then list the
information that the Vibe site needs to know in order to communicate with the Messenger system.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 15, “Performing an Advanced Vibe Installation,” on
page 127.

IMPORTANT: In order for Messenger presence to display in Vibe when using LDAP, you need to map
pr esencel Dto your authentication attribute in the Vibe LDAP configuration page. For example,

pr esencel D=cn. For more information, see “Configuring Presence” in the Micro Focus Vibe 4.0.4
Administration Guide
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Configuring Single Sign-On with Novell Access
Manager

Novell Access Manager provides secure single sign-on access to your Micro Focus Vibe site by
functioning as a reverse proxy server. Access Manager 3.1 SP1 IR1 is required for use with Micro
Focus Vibe. You can download the required version of Access Manager from Novell Downloads
(http://download.novell.com).

For background information about setting up Novell Access Manager 3.1, see the Access Manager
3.1 Documentation website (http://www.novell.com/documentation/novellaccessmanager31). For
instructions specific to Vibe, see “Configuring a Protected Resource for a Micro Focus Vibe Server” in
the Micro Focus Vibe 4.0.4 Administration Guide.

After you have configured Novell Access Manager, you must configure your Vibe site with the IP
address of one or more Access Gateway servers and with the logout URL. When you configure the
Vibe site to use the Access Gateway, the IP addresses that you specify are the only locations from
which the Vibe site accepts logins. The logout URL is the location where users find themselves when
they log out of the Vibe site.

When you enable the Access Gateway for use with your Vibe site, all Vibe users must log in through
the Access Gateway. It is not possible to set up the Vibe site so that some users log in through the
Access Gateway and some do not.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Reverse Proxy Configuration, list one or more IP addresses of Access Gateway servers that
have been configured for use by Vibe. List the logout URL, and if necessary, the Access Gateway
hostname for WebDAV connections.

Complete the planning process for additional Advanced installation features as needed, then perform
the Advanced installation as described in Chapter 15, “Performing an Advanced Vibe Installation,” on
page 127.

Configuring Single Sign-On with Internet Information
Services for Windows

Like Novell Access Manager, Windows Authentication provides Windows users with a single sign-on
experience, enabling users to automatically authenticate to Micro Focus Vibe after they log in to their
individual workstations. Internet Information Services (I1S) provides this capability.

Before you implement Windows Authentication, consider the following limitations:

+ |IS is best suited for an intranet environment. Because NTLM is a connection-based protocol, it
does not work well with HTTP proxy servers.

+ IS does not support Guest Access.

After you configure the Vibe server to support Windows Authentication, complete the planning
process for additional Advanced installation features as needed, then perform the Advanced
installation as described in Chapter 15, “Performing an Advanced Vibe Installation,” on page 127.

+ “System Requirements” on page 112

+ “Planning Your IIS Installation and Configuration” on page 113

+ “Configuring the Vibe Server to Support Windows Authentication” on page 114
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+ “Running the Vibe Installation Program” on page 119

+ “Configuring Your Browser to Allow Access to the Vibe Site” on page 119

+ “Bypassing Windows Authentication to Configure LDAP and Perform Other Tasks” on page 120
+ “Logging In to the Vibe Site through Windows Authentication” on page 121

+ “Editing Files through WebDAV with Windows Authentication” on page 121

+ “Configuring IIS to Allow Uploading of Large Files to the Vibe Site” on page 122

¢ “Configuring IIS to Load Balance in a Clustered Environment” on page 122

System Requirements

Windows Authentication with 1IS can be enabled for Vibe only in the following environments:

Server

+ Windows 2008 Server
+ Windows 2008 R2 Server

1S

+ IS 7 with IIS Manager with CGI and ISAPI components
+ IS 7.5 with 1IS Manager with CGI and ISAPI components

Authentication Protocol

One of the following authentication protocols:

* NTLM
+ Kerberos v5
+ Negotiate/SPNEGO (wrapper for NTLM and Kerberos v5)

Domain Controller

+ Active Directory Service

Vibe needs to be configured and synchronized with your Active Directory directory service. For
more information about configuring LDAP synchronization within Vibe, see “Gathering Directory
Services Information” on page 68 and “Synchronizing Users and Groups from an LDAP
Directory” in the Micro Focus Vibe 4.0.4 Administration Guide.

If you are using Kerberos as your authentication protocol, then Key Distribution Services is also
required.

For more information about installing and configuring the domain controller and other domain
services to support Windows Authentication, refer to the appropriate Microsoft documentation.
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Client

One of the following clients:

+ Windows 7
+ Windows XP

Browser
One of the following browsers, configured to support Windows Authentication:

+ Internet Explorer
+ Firefox

For information on how to configure your browser to support Windows Authentication, see
“Configuring Your Browser to Allow Access to the Vibe Site” on page 119.

Planning Your IIS Installation and Configuration

Use the information in the following table as you consider your IIS installation.

Directory: The default installation directory for the 1IS plug-inis C: \ Program Fi | es\ Novel | . This
is the recommended directory. If for some reason you choose to install the IS plug-in in a directory
other than the C: \ Progr am Fi | es\ Novel | directory, you need to modify the

i sapi _redirect. properti es files, as described in “Installing the Vibe I1IS Plug-In” on page 114.

External or Local Server: You can install the IIS plug-in on the same server where you are running
Vibe, or you can install it on an external server. Installing 1IS on an external server can have the
following benefits:

+ Performance improvement
+ Ability to integrate with several Vibe servers in a clustered environment

+ Ability to run Vibe from a non-Windows server

If you are running IS from an external server, you need to edit the C: \ Pr ogr am
Fil es\ Novel I'\Vibe IS Pl ugi n\conf\workers. properti es file, as described in “Installing
the Vibe IIS Plug-In” on page 114.

64-bit/32-bit: You can install the IIS plug-in on a 64-bit or 32-bit operating system. However, Vibe
should run on a 64-bit operating system; therefore, if you install 1IS on a 32-bit operating system,
you should use an external server.

HTTP Ports: Regardless of whether IIS and Vibe are located on the same server or separate
servers, the HTTP port and secure HTTP port for Vibe should always be 80 and 443. This ensures
that when links are generated, they contain the correct hostname and port number.

These are the ports that Vibe uses to refer to the browser. In a very basic Vibe system (single server
without Windows Authentication), the HTTP ports can be the same as the listen ports. However, in a
Vibe system with Windows Authentication enabled, the HTTP ports correspond with the ports that
the 1IS server is configured to use.
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Listen Ports: If you plan to run 1IS on the same server as the Vibe server, you need to set the listen
port and secure listen port for Vibe to something other than 80 and 443.

By default, Vibe listens on ports 80 and 443. Because IIS also uses these ports to listen on, you
must reconfigure the Vibe listen ports to ports that are not currently in use, such as 8080 for the
listen port and 8443 for the secure listen port.

You configure Vibe ports during the Vibe installation, as described in Chapter 15, “Performing an
Advanced Vibe Installation,” on page 127.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the HTTP ports and listen ports.

Under Integration with 1IS for Windows Authentication, select Enable Integration with IIS for
Windows Authentication, then list the logout URL.

Configuring the Vibe Server to Support Windows
Authentication

To configure the Vibe server to support Windows Authentication, you must first configure IIS. You can
set up IIS on the same server where Vibe is running, or on a separate server. See “Planning Your IS
Installation and Configuration” on page 113 for more information.

Complete the instructions in the following sections to ensure that IIS is configured correctly to work
with Vibe.

+ ‘“Installing the Vibe IIS Plug-In” on page 114

+ ‘“Installing ISAPI and GCI” on page 115

+ “Installing Windows Authentication Role Service” on page 115

+ “Creating and Managing Vibe Resources with 1IS Manager” on page 115

Installing the Vibe IIS Plug-In

1 Locate the t eam ng-version-iis-pl ugin. zi p file from the Vibe distribution, then unzip it into
the C:\ Program Fi | es\ Novel | directory.

This creates a directory called Vi be 11S Pl ugin.

2 Ifin Step 1 you chose to unzip the t eam ng- ver si on-ii s- pl ugi n. zi p file into the C: \ Pr ogr am
Fi | es\ Novel | directory, continue with Step 3.

or

If in Step 1 you chose to unzip the t eami ng- versi on-ii s-pl ugi n. zi p file into a location other
than C.\ Program Fi | es\ Novel | , you must complete the following steps:

2a Locate the i sapi _redirect. properti es file in each of the following directories:
¢ Vibe I'l'S Plugin\resourcesl\bin
¢ Vibe I'l'S Plugin\resources2\bin
2b In each of the directories, open the i sapi _redirect. properti es file in a text editor.

2c Adjust the values of the 1 og_fi |l e, worker _fil e and worker _nount _fil e properties to
reflect the directory where you chose to unzip the t eani ng- ver si on-i i s-pl ugi n. zi p file.

2d Save your changes and close both of the i sapi _redirect. properti es files.

114 Planning an Advanced Vibe Installation



3 If IIS and the Vibe server are located on the same server, continue with Step 4.

or

If IIS and the Vibe server are located on separate servers, complete the following steps:

3a

3b
3c

3d

Locate the C:\ Program Fi | es\ Novel I\ Vi be 1S Pl ugi n\ conf\workers. properties
file.

Open the wor ker s. properti es file in a text editor.

Adjust the value of the wor ker . wor ker 1. host property from | ocal host to the hostname or
IP address of the Vibe server.

Save your changes and close the editor.

4 (Conditional) If you are running IIS on a 64-bit server, complete the following steps:

4a Locate the C:\ Program Fi | es\ Novel I\ Vibe 1S Plugin\library\w n64 directory.

4b

4c

4d

Copy the appropriate version of the . dl | library and paste it into each of the following
directories:

¢ C\ProgramFil es\Novel I\Vibe IS Plugin\resourcesl\bin
¢ C\Program Fil es\Novel I\Vibe IS Pl ugin\resources2\bin

Ensure that you copy the correct version of the . dI | library. If you copy the incorrect
version, you receive a 500 error when you try to access the Vibe site.

Delete the existing i sapi _redirect.dll files from the C:\ Program Fi | es\ Novel I\ Vi be
I'I'S Pl ugin\resour cesl\ bi n directory, as well as from the C: \ Pr ogr am
Fil es\ Novel I\ Vibe IS Pl ugi n\resources2\bi n directory.

Rename the . dI | library files that you copied in Step 4b toi sapi _redirect.dl|.

For example, if Vibe is running on an AMD64/EM64T platform, copy C: \ Pr ogr am

Fil es\Novel I\Vibe I'I'S Plugin\library\w n64\and64\i sapi _redirect-

version.dl | intothe C:\ Program Fi | es\ Novel |\Vibe I1S Pl ugi n\resourcesl\bin
and C:\ Program Fi | es\ Novel I\ Vi be || S Pl ugi n\resources2\ bi n directories, then
delete the original i sapi _redirect.dl | file andrenamei sapi _redirect-version.dll to
i sapi _redirect.dll.

Installing ISAPI and GClI

1 Install the ISAPI and CGI components:

la Launch the Web Platform Installer.

1b
1c

Search for isapi.
Add both the extensions and filters.

Installing Windows Authentication Role Service

If the Windows Authentication Role Service is not already installed, use the Add Roles and Features
Wizard to add "Windows Authentication" to [IS/Web Server/Security.

Creating and Managing Vibe Resources with IIS Manager

Internet Information Services (11IS) Manager is used to complete the integration.

1 Click Start > Administrative Tools > Internet Information Services (lIS) Manager.

2 Inthe Connections pane on the left side of the window, expand your server, then expand Sites.
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3 Right-click Default Web Site, then click Add Virtual Directory.
The Add Virtual Directory dialog box is displayed.

Site name:  Default Web Site
Path: !

Aligs:

Example: images

Physical path:

| ]

Pass-through authentication

Connect as... Test Settings. .. |

K I Cancel

4 In the dialog box, specify the following information:
Alias: Vi beResour cesl
Physical path: C:\ Program Fi |l es\ Novel I\ Vibe 11S Pl ugin\resourcesl\bin
5 Click OK.
6 Repeat Step 3 through Step 5 to add another virtual directory.
This time, specify the following information in the Add Virtual Directory dialog box:
Alias: Vi beResour ces2
Physical path: C:\ Program Fi |l es\ Novel I\ Vibe |I1S Pl ugi n\resources2\bin
7 Inthe Connections panel, select VibeResources1, then double-click Handler Mappings.

“E Internet Information Services (IIS) Manager =101 x|
@ (] [ & » PEN v Sites b DefaltWebSite b VibeResources1 b ] oo @ -
File View Help
| Handler Mappings I
€- 17|88 L PPing Add Managed Handler...
-5 Start Page Add Script Map...
e . \ Use this feature to specify the resources, such as DLLs and managed code,
B Pﬁf‘g"“ﬂgl"i @EI""'”'S‘”'““ that handle responses for specific request types. Add Wildeard Script Map...
e Ppicatan Fad Add Module Mapping.
B8] Sites Group by: State -
- Default web site Name ~ [ Patn [ State Edit Feature Permissions. .
] cRsoces R Disabled Revert To Tnherited
[Hfa| VibeResources2
CGl-exe *.exe Disabled View OniEE
15APTdI =dl Disabled @ tep
Online Help
Enabled
OPTIONSVerbHandler = Enabled
TRACEVerbHandler = Enabled
StaticFile ® Enabled
e i
Configuration: 'Default Web Site VibeResources 1’ web, config €.
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8 In the Actions pane, click Edit Feature Permissions.

The Edit Feature Permissions dialog box is displayed.

Permissions:
v Read
¥ script

v Execute

Ok I Cancel

9 Select Execute, then click OK.
10 Repeat Step 7 through Step 9 for the Vi beResour ces?2 virtual directory.
11 In the Connections pane, select Default Web Site, then double-click ISAPI Filters.
12 In the Actions panel, click Add.
The Add ISAPI Filter dialog box is displayed.

Add ISAPI Filter e |
Filter name:

Executable:

| .

Ok I Cancel

13 In the dialog box, specify the following information:
Filter name: Vi beResour ces1
You must name the filter Vi beResour ces1 for Windows Authentication to work successfully.

Executable: C:\ Program Fi | es\ Novel [\Vibe IIS
Pl ugi n\resour ces1\ bi n\i sapi _redirect.dl|

14 Click OK.

15 Repeat Step 12 through Step 14 to add another ISAPI filter.
This time, specify the following information in the Add ISAPI Filter dialog box:
Filter name: Vi beResour ces?2

You must name the filter Vi beResour ces2 in order for Windows Authentication to work
successfully.

Executable: C:\ Program Fil es\ Novel [\Vibe I1S
Pl ugi n\resour ces2\ bi n\i sapi _redirect.dl|

16 Inthe Connections pane, select the server, then double-click ISAPI and CGI Restrictions.
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1!E Internet Information Services (IIS) Manager

—loj x|

€3] EEEEE

[ - B e~

File  view Help

€-iH|7 8

& Start Page
Eiij PEN (LPTEAMING \administrator)
[ 2} Application Pools
- Sites
B4 Default Web Site
] VibeResources1
[ VibeResources2

4

| »

G‘;l_ ISAPI and CGI Restrictions

Use this feature to specify the ISAPI and CGI extensions that can run on the
Web server,

Group by: Mo Grouping <
I Restriction I Path
TeamingResourc... Allowed C:'\Program Files\Mavell\Teamir
TeamingResourc... Allowed C:'\Program Files\Movell\Teamir

Description =

« | i

Configuration: localhost’ applicationHost. config

17 Inthe Actions pane, click Add.

The Add ISAPI or CGI Restriction dialog box is displayed.

Add ISAPI or CGI Restriction

ISAPI or CGI path:

2 x

Description:

L

|_ Allow extension path to execute

0] I Cancel

18 In the dialog box, specify the following information:

ISAPI or CGI path: Specify C:\ Program Fi | es\ Novel I\Vibe IIS
Pl ugi n\resources1\ bi n\isapi _redirect.dll

Description: Vi beResour ces1

Add...

Edit Feature Settings...

@ Help

Online Help

ia51.:5

Allow extension path to execute: Select this option to allow the path to execute.

19 In the Actions pane, click Add.

The Add ISAPI or CGI Restriction dialog box is displayed.
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ISAPI or CGI path:

|| ]

Description:

[T allow extension path to execute

oK Cancel

20 In the dialog box, specify the following information:

ISAPI or CGI path: Specify C:\ Program Fi | es\ Novel [\Vibe 11S
Pl ugi n\resour ces2\ bi n\i sapi _redirect.dl|

Description: Vi beResour ces?

Allow extension path to execute: Select this option to allow the path to execute.
21 Inthe Connections pane, select VibeResourcesl, then double-click Authentication.
22 Select Anonymous Authentication, then click Disable in the Actions panel.
23 Select Windows Authentication, then click Enable in the Actions panel.
24 Exit the Internet Information Services Manager.

25 Perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe
Installation,” on page 125.

Running the Vibe Installation Program

See “Choosing Windows Authentication” on page 60 for information about how to configure the Vibe
installation program to support Windows Authentication, then follow the instructions for the advanced
installation as described in Chapter 15, “Performing an Advanced Vibe Installation,” on page 127.

Return here and continue with “Configuring Your Browser to Allow Access to the Vibe Site” on
page 1109.

Configuring Your Browser to Allow Access to the Vibe Site

After Windows Authentication has been enabled on the server, you need to configure the client
browser to allow access to the Vibe site.
+ “Internet Explorer” on page 119

+ “Firefox” on page 120

Internet Explorer

1 In an Internet Explorer window, click Tools > Internet Options.
The Internet Options dialog box is displayed.

2 Click the Security tab, select Local intranet, then click Sites.
The Local Intranet dialog box is displayed.

3 Click Advanced.
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4 In the Add this website to the zone field, specify the Vibe website.
5 Click Add > Close.

Firefox

1 In Firefox, specify about : confi g in the URL field.

2 Specify nt | min the Filter window, then locate and select the network.automatic-ntim-
auth.trusted-uris entry.

The Enter String Value dialog box is displayed.
3 Specify the DNS name of your Vibe site, then click OK.

For example, vi be. myconpany. com
4 Repeat Step 2 through Step 3 for network.negotiate-auth.trusted-uris and network.negotiate-
auth.delegation-uris.

Bypassing Windows Authentication to Configure LDAP and
Perform Other Tasks

After Windows Authentication is working on your Vibe server, you can bypass the Windows
Authentication functionality by including the Vibe listening port in the Vibe URL.

You need to do this in order to configure your LDAP directory.

1 In a web browser, specify your Vibe URL with the Vibe listening port.
For example, htt p://vi be: 8080.
The Vibe login page is displayed.

Novell. Vibe

User ID

Password

Forgat your password?

2 Log in to the Vibe site as the Vibe administrator.
3 Configure LDAP, as described in “Adding Vibe Users from Your LDAP Directory” on page 90.

You might also need to bypass Windows Authentication to access Vibe for the following reasons:

+ To access a specific Vibe node in a clustered environment
+ To troubleshoot the Vibe system

Planning an Advanced Vibe Installation



Logging In to the Vibe Site through Windows Authentication

After you have performed the configuration steps described in “Configuring the Vibe Server to
Support Windows Authentication” on page 114 through “Configuring Your Browser to Allow Access to
the Vibe Site” on page 119, users can access the Vibe site through Windows Authentication. Users
who have been configured through LDAP and are already logged in to their individual workstations do
not need to log in again to access the Vibe site. Users who are not already logged in before they
access Vibe see the following dialog box:

Authentication Required x|
0 Enter username and password for http://13.6.7.31
User Mame: I
Password: I sesnsssns
OK I Cancel |

Editing Files through WebDAV with Windows
Authentication

+ “Achieving Single Sign-On When Editing Files through WebDAV” on page 121
+ “Enabling Basic Authentication for WebDAV” on page 121

Achieving Single Sign-On When Editing Files through WebDAV

By default, when you edit a file in Vibe through WebDAYV, you are prompted for your system login
credentials before you can edit the file. However, when Windows Authentication is enabled on your
Vibe server, you are no longer prompted for your system login credentials before you edit a file
through WebDAV.

This functionality is supported only when you use Microsoft Office as your default document editor.
When you use OpenOffice 3.1 or later as your default document editor, Vibe allows you to edit files
through WebDAV, but it still requires you to enter your system login credentials. The single sign-on
experience is only available when you use Microsoft Office.

Enabling Basic Authentication for WebDAV

If you are using OpenOffice 3.0 or earlier, or any other document editor that requires basic
authentication (it does not support Windows Authentication), you need to configure your IIS server to
support basic authentication. Supporting basic authentication enables Vibe users to edit files through
WebDAV when using a document editor other than Microsoft Office or OpenOffice 3.1 or later.

NOTE: If you enable basic authentication on your IS server, all users who access the Vibe site
through Firefox are prompted for their login credentials. Single sign-on to the Vibe server no longer
functions. However, users who access the Vibe site using Internet Explorer retain the single sign-on
experience.

To enable basic authentication on your IIS server, you need to install the Basic Authentication Role
Service.

1 On the Windows 2008 server, click Start > Administrative Tools > Server Manager.
2 Expand Roles, then right-click Web Server (IIS).
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Click Add Role Services.

The Add Role Services window is displayed.

Scroll to the Security section, then select Basic Authentication.

Click Next, then complete the installation.

Click Start > Administrative Tools > Internet Information Services (IIS) Manager.

In the Connections pane on the left side of the window, expand your server, expand Sites, then
expand Default Web Site.

Select VibeResources1, then double-click Authentication.

9 Select Basic Authentication, then click Enable in the Actions panel.

10

Close the Internet Information Services (IIS) Manager.

Configuring lIS to Allow Uploading of Large Files to the Vibe
Site

By default, IS might not allow you to upload large files to the Vibe site. This is caused by timeout
restrictions as well as maximum upload size restrictions.

For information about how to configure IIS to allow you to upload large files, see article 925083 in the
Microsoft Support Knowledgebase (http://support.microsoft.com/kb/925083).

Configuring IIS to Load Balance in a Clustered Environment

If you have Vibe installed in a clustered environment where there are multiple Vibe nodes, you can
configure 1IS to balance the load of user requests from the multiple Vibe nodes, while still supporting
Windows Authentication.

1

On the IIS server, locate the C:\ Program Fi | es\ Novel I\Vibe |1S
Pl ugi n\ conf\wor kers. properti es. cl ust ered. t enpl at e file, then open the file in a text
editor.

Copy the contents of the file.

Locate the C:\ Program Fi | es\ Novel I\ Vibe IS Pl ugi n\ conf\workers. properti es file,
then open the file in a text editor.

Paste the contents of the C: \ Program Fi | es\ Novel I\ Vibe I1S

Pl ugi n\ conf\wor kers. properties. cl ustered. t enpl at e file that you copied in Step 2 and
into the C:\ Program Fi | es\ Novel I\ Vi be 11 S Pl ugi n\ conf\workers. properti es file,
overwriting the content that was previously there.

Replace the value of worker.workerl.host from first hostname or_ip with the hostname or IP
address of your first Vibe node.

Repeat Step 5 for each additional Vibe node that is running in your environment. If you have
more than two Vibe nodes, you should add an additional section to the wor ker s. properti es file
for each additional node.

The values that you specify in the wor ker s. proper ti es file (for example, wor ker 1, wor ker 2,
etc.) must exactly match the values that you specify as the JVM Route setting during the Vibe
installation, as described in “Installing the Vibe Software on Multiple Servers” on page 150.

Locate the C:\ Program Fil es\ Novel [\Vibe IIS
Pl ugi n\resour ces1\ conf\uriworker map. properti es file, then open the file in a text editor.

Replace all instances of wor ker 1 with bal ancer .
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9 Repeat Step 7 and Step 8 for each Vibe node.

10 Locate the C:\ Program Fil es\ Novel [\Vibe IS
Pl ugi n\resour ces2\ conf\uriwor ker map. properti es file, then open the file in a text editor.

11 Replace all instances of wor ker 1 with bal ancer.
12 Repeat Step 10 and Step 11 for each Vibe node.
13 Restart each Vibe node.
14 Restart the IIS server:
1l4a Click Start > Administrative Tools > Internet Information Services (IIS) Manager.

14b Select your server in the Connections panel, then click Restart in the Actions panel.

Configuring Mirrored Folder Resource Drivers

A mirrored folder is a directory, either local or shared on a SAN (storage area network), that is directly
accessible from the Micro Focus Vibe site. The files on the file system are accessed by the Micro
Focus Vibe program through a resource driver, not directly by individual Vibe users. A resource driver
defines how the Vibe program accesses the file system.

During installation, you define the users and groups that can access the mirrored folder resource
drivers. After installation, from the Vibe site, you associate resource drivers with specific Vibe folders
and use folder access controls to govern which users and groups can access the data in the mirrored
folder. As a result, you can set up a small number of users who can create mirrored folders, and allow
a larger number of users to access the mirrored folders.

Vibe attempts to keep the metadata about each mirrored folder synchronized with the contents of the
actual file system. Therefore, mirrored folders are most appropriate for large sets of relatively static
data. Mirrored folders are also useful for making extremely large files available from your Vibe site
without including them in the Vibe file repository.

Although the installation program allows you to set up three mirrored folder resource drivers during
installation, you can set up and test just one to start with, and then set up additional resource drivers
later.

+ “File System Type” on page 123

+ “File System Directory” on page 124

+ “File System Access” on page 124

+ “Mirrored Folder Setup” on page 125
After planning mirrored folders, complete the planning process for additional Advanced installation

features as needed, then perform the Advanced installation as described in Chapter 15, “Performing
an Advanced Vibe Installation,” on page 127.

File System Type

Vibe provides resource drivers for two different types of file systems:

+ file: Adirectory in a regular file system on a Linux or Windows server.

+ webdav: A directory on a web server that supports WebDAV (Web-based Distributed Authoring
and Versioning). The WebDAV server must support HTTP Basic Authentication (http://
en.wikipedia.org/wiki/Basic_access_authentication) so that Vibe can provide a user name and a
password when making a request from the WebDAV server.
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ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, mark the type of directory that you want to
mirror in your Vibe site.

File System Directory

The file system that a Vibe mirrored folder uses can be on Linux, NetWare, or Windows, as long as
the following conditions are met:

+ The file system is accessible from the Vibe server by using a directory path specification that the
Vibe server operating system understands.

+ The file system is accessible through the standard j ava. i o package interface.

IMPORTANT: On Windows, you must use forward slashes (/) in the path nhame, not the typical
Windows backslashes (\). For example, use c: / Docunent s rather than c: \ Docunent s.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, specify the full path for the directory that you
want to mirror in your Vibe site. Also, provide a title for the mirrored folder resource driver that indicates
what directory or data is being mirrored. For WebDAV mirrored folders, you must also specify the URL of
the WebDAV host where the data is located.

If you need to eventually set up more than three directories as mirrored folders in your Vibe site, you
can edittheinstall er. xn file in the directory where you run the Installation program.

File System Access

Vibe offers several security options for controlling access to the data that resides on the file system.
+ You can restrict the Vibe program to read-only access to the mirrored data, or you can allow full
read/write access.

+ You can list specific Vibe users who are allowed to access the mirrored folder resource drivers
and thereby create mirrored folders.

+ You can list specific Vibe groups whose members are allowed to access the mirrored folder
resource drivers and thereby create mirrored folders.

+ For WebDAV mirrored folder resource drivers, you must also specify a user name and password
that the Vibe program can use to access the WebDAV server.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, list the file access (read/write or read-only) for
the mirrored data, along with users and groups that you want to have access to the resource driver. For a
WebDAV mirrored folder, list a user name and password that provides access to the WebDAV server.
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Mirrored Folder Setup

After you run the Vibe Installation program to configure the Vibe site for mirrored folder resource
drivers, additional folder setup is required. Follow the instructions in “Setting Up Mirrored Folders” in
“Site Setup” in the Micro Focus Vibe 4.0.4 Administration Guide.

Installing the Vibe Software in a Clustered
Environment

You must use an Advanced installation in order to install the Micro Focus Vibe software on multiple
servers and set up a clustered environment. Setting up multiple Vibe servers, along with other
clustering options, are described in Chapter 20, “Running Vibe on Multiple Servers,” on page 149.
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Performing an Advanced Vibe
Installation

You should already have reviewed Chapter 8, “Planning a Basic Vibe Installation,” on page 51 and
filled out the Basic Vibe Installation Summary Sheet. You should also have reviewed Chapter 14,
“Planning an Advanced Vibe Installation,” on page 103 and filled out the Advanced Vibe Installation
Summary Sheet for those aspects of an Advanced installation that you want to implement for your
Micro Focus Vibe site.

1 Follow the Basic installation instructions provided in Chapter 9, “Installing and Setting Up a Basic
Vibe Site,” on page 71 for the platform where you are installing Vibe.
2 When you run the installation program, select Advanced on the Choose Installation Type page.

Novell Vibe 4 Installation Program = x
Choose Installation Type

Select the type of installation you want to perform

Hasit Select the Advanced installation if you want to configure any
of the optional features.

3 Use the information that you have gathered on the Basic Vibe Installation Summary Sheet and
the Advanced Vibe Installation Summary Sheet to provide the information that the Vibe
Installation program prompts you for:

Basic Installation Pages:

Installation Locations

Location of TrueType Fonts for Stellent Converters
Default Locale for Micro Focus Vibe

User ID for Micro Focus Vibe (Linux only)

Network Information

WebDAV Authentication Method

Database Selection

Java JDK Location

Outbound Email Configuration

Inbound Email Configuration

Some Basic installation pages have additional options available when you perform an Advanced
installation.

Advanced Installation Pages:

Web Services

Lucene Configuration

RSS Configuration

Presence Configuration
Reverse Proxy Configuration
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Integration with IIS for Windows Authentication
Mirrored Folder Resource Driver Configuration
Vibe Cluster Configuration

The Installation program stores the information it gathers in the i nstal | er. xnl file in the same
directory where you started the Installation program.

4 After you have provided all the requested information, click Install to begin the Advanced
installation.

5 When the installation is complete, click Finish to exit the Vibe installation program.

Information about the installation process is written to the i nst al | er. | og file in the same
directory where you ran the Installation program. If a problem occurs during the installation, the
i nstal | er. | og file provides information that can help you resolve the problem.

6 After you complete the Advanced installation, continue setting up your Vibe site, as described in
Chapter 10, “Adding Users to Your Vibe Site,” on page 89.
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Setting Configuration Options after
Installation

After you install Micro Focus Vibe, following the instructions in Part I, “Basic Installation,” on page 49
or Part 1V, “Advanced Installation and Reconfiguration,” on page 101, you can rerun the Vibe
installation program to change configuration options or add new functionality to your Vibe site.

1 Stop Vibe.

2 Start the Vibe installation program as described in “Running the Linux Vibe Installation Program”
on page 72 and “Running the Windows Vibe Installation Program” on page 83.

Novell Vibe 4 Installation Program = x

Installation Options

Select the action you want to perform.

" New installation
" Update software and settings
" Reconfigure settings

Because the Installation program finds an existing i nst al | er. xni file, it defaults to Reconfigure
settings.

3 Click Next.
The Vibe Installation program asks you to verify that you have stopped Vibe.
4 Click Yes.

Novell Vibe 4 Installation Program = x
Choose Installation Type

Select the type of installation you want to perform

Qs Selest the Advanced installation if you want to configure any
| of the optional features.

5 Select Basic or Advanced, depending on the configuration settings that you want to change,
then click Next.

6 Click Next until you reach an installation page where you want to reconfigure settings.

Basic Installation Pages:

Installation Locations

Location of TrueType Fonts for Stellent Converters
Default Locale for Micro Focus Vibe

User ID for Micro Focus Vibe (Linux only)

Network Information
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WebDAV Authentication Method
Database Selection

Java JDK Location

Outbound Email Configuration
Inbound Email Configuration

Advanced Installation Pages:

Web Services

Lucene Configuration

RSS Configuration

Presence Configuration

Reverse Proxy Configuration

Integration with 11S for Windows Authentication
Mirrored Folder Resource Driver Configuration
Vibe Cluster Configuration

7 When you reach the Ready to Install page, click Install to implement the reconfigured settings.
8 Start Vibe.
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Advanced Vibe Installation Summary

Sheet

Installation Program Field

Value for Your Vibe Site

Explanation

Data Locations:
Linux default:
/var/opt/novel | /t eam ng
Windows default:
c:\ Novel I'\ Team ng

+ Simple file repository

+ Jackrabbit repository

+ Extensions repository

+ Cache store

¢ Lucene index

See “Distributing Different Data
Types to Different Locations” on
page 104.

Network Information:
+ Enable web services:

No / Yes

¢ Session timeout
Default: 240 minutes

+ Enable Tomcat access log:
No / Yes

+ Keystore file:

See “Using Advanced Network
Information Settings” on page 105.

Network Information:
¢ Max Threads

Default: 200
+ Max Active

Default: 50
+ Max Idle

Default: 20

See “Configuring Requests and
Connections Configuration” on
page 106.

WebDAV Authentication Method

+ basic

+ digest

See “Planning the WebDAV
Authentication Method” on page 58.
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Installation Program Field Value for Your Vibe Site

Explanation

Web Services:

+ Enable WSS authentication
+ Enable Basic authentication

+ Enable token-based
authentication

+ Enable anonymous access

See “Configuring Web Services” on
page 107.

Lucene Configuration:
Configuration type: all
¢ Max booleans:

Default: 10000
+ Merge factor:
10

See “Changing Lucene
Configuration Settings” on
page 108.

Server Lucene Configuration:
Configuration type: server only

* Host:
* RMI port:
Default: 1199

See “Running the Lucene Index
Server in Its Own JVM” on
page 108.

High Availability Lucene
Configuration:

Configuration type: high availability
only

Number of high availability search
nodes:

* Service name:
* Service title:
¢ Host:

+ RMI port:

* Service name:
* Service title:
* Host:

* RMI port:

See Chapter 21, “Running Multiple
Lucene Index Servers,” on
page 157.

RSS Configuration:

Enable RSS: No / Yes

+ Max elapsed days:

¢ Max inactive days:

See “Managing RSS Feeds” on
page 109.
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Installation Program Field Value for Your Vibe Site Explanation

Presence Configuration: See “Configuring Presence” on

page 110.
Enable presence: No / Yes

+ Server address:
* Port:

* Server user:

* Password:

* Server Certificate:

Reverse Proxy Configuration: See “Configuring Single Sign-On
with Novell Access Manager” on
Enable Access Gateway: No / Yes page 111.
* Access Gateway address(es):
¢ Logout URL:
+ Use Access Gateway for
WebDav connections: No / Yes
* WebDAV Access Gateway
address:
Integration with IIS for Windows See “Configuring Single Sign-On
Authentication: with Internet Information Services

] ) for Windows” on page 111.
Enable Integration with 1IS for

Windows Authentication: No / Yes

+ |IS address(es):

* Logout URL:

Mirrored Folder Resource Driver See “Configuring Mirrored Folder
Configuration: Resource Drivers” on page 123.

Enable file share: No / Yes

¢ Share type

+ File

+ WebDav
+ Read only: No / Yes
+ Title
+ Root path
+ Allowed users
+ Allowed groups
¢ User
¢ Password
¢+ Host URL
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Multi-Server Configurations and
Clustering

+ Chapter 18, “Creating the Vibe Database on a Remote Server,” on page 137

+ Chapter 19, “Installing the Lucene Index Server on a Remote Server,” on page 145
+ Chapter 20, “Running Vibe on Multiple Servers,” on page 149

+ Chapter 21, “Running Multiple Lucene Index Servers,” on page 157

+ Chapter 22, “Running Multiple Database Servers,” on page 175
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Creating the Vibe Database on a Remote
Server

The default database location for Micro Focus Vibe is on the same server with the Vibe software, as
described in “Database Location” on page 61. However, for better performance and scalability, you
can install the database server (MySQL, MariaDB, Microsoft SQL, Oracle, or PostgreSQL) on a
remote server, and then use the scripts that are included with the Vibe software to manually create
the Vibe database in any location that you prefer.

+ “Creating a MySQL/MariaDB Database” on page 137

+ “Creating a Microsoft SQL Database” on page 139

+ “Creating an Oracle Database” on page 140

+ “Creating a PostgreSQL Database” on page 142

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructions in Part I, “Basic Installation,” on
page 49 before attempting a more complex Vibe configuration.

Creating a MySQL/MariaDB Database

Before you begin, you should be familiar with standard database maintenance procedures.
For more information about MySQL, see the following references:

+ MySQL 5.0 Reference Manual (http://dev.mysql.com/doc/refman/5.0/en)
+ MySQL 5.1 Reference Manual (http://dev.mysqgl.com/doc/refman/5.1/en)

For information on installing SLES 12 and using MariaDB, see the SLES 12 Documentation (https://
www.suse.com/documentation/sles-12/) and MariaDB (http://www.mariadb.com) web sites.

The following database tools can be helpful:

+ MySQL GUI Tools (http://dev.mysqgl.com/downloads/gui-tools)
+ SQLyog (http://www.webyog.com)
+ Squirrel SQL Client (http://squirrel-sql.sourceforge.net)

To create the MySQL database:

1 Review the MySQL requirements listed in “Vibe Server Requirements” on page 19.

2 Ensure that the MySQL database server and client have been installed and configured, as
described in “MySQL or MariaDB SQL Database Server” on page 234.

3 Ensure that the MySQL database client is also installed on the Vibe server.

The Vibe installation program needs the MySQL client in order to communicate with the remote
MySQL database server.

4 Ensure that you know the password for the MySQL r oot administrator user.
5 Ensure that i nnodb support is enabled.
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It is enabled by default. To verify that i nnodb support is enabled:
5a Enter the following command to access the MySQL monitor:

nysql -u root -p

For information on how to set a password for your MySQL database if you have not already
done so, see “Configuring MySQL/MariaDB” on page 235.

5b Specify your password.

5¢ From the MySQL prompt, enter the following command to display status information about
the server’s storage engines:
SHOW ENG NES\ G

5d Locate the InnoDB engine, and ensure that i nnodb support is enabled.
6 Update the MySQL configuration file:
6a Locate the MySQL configuration file and open it in a text editor.

Linux: /etc/ ny. cnf

Windows: c:\Program Fi | es\ MySQ\ MySQL Server version\ny.ini

6b Underthe [client] section, add the following line:
default _character_set = utf8

6¢c Under the [ nysql d] section, add the following line:
character_set_server = utf8
Setting the character set to UTF-8 ensures that extended characters are handled correctly
in the database.

6d (Conditional) For a system with multiple network interfaces, in the [ nysql d] section, add
the following line:
bi nd- address = nysql _server _address
Replace nysql _server _addr ess with the IP address that you want MySQL to bind to and
to listen on.

6e Save the updated configuration file, then exit the text editor.

7 Copy the t eam ng- 4. 0. n- db. zi p file from the Vibe server where the Vibe installation program
is located and copy it to the database server.

or
Download and unzip the Vibe software onto the database server.

8 In the directory where the Vibe Installation program is located on the database server, or in the
location where you copied the t eami ng- 4. 0. n- db. zi p file, unzip the t eani ng- 4. 0. n-db. zi p
file.

9 Change to the db subdirectory.
10 Change to the db/ scri pt s/ sql subdirectory.

11 Copy the nysqgl - cr eat e- enpt y- dat abase. sql script to a convenient temporary location on the
server where you want to create the database, and ensure that your database management
utility is on your path so that you can run it from that directory.

12 Specify the following command to run the MySQL database creation script:
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13

14

15

16

17

18

19

nysql -uuser -ppassword < nysql -create-enpty-dat abase. sql
Configure MySQL to allow access from a remote server:

nysql -uuser -ppassword

nysql > grant all privileges on *.*
-> to 'username' @%
-> identified by 'password'
-> with grant option

-> ’
Edit the nmysql -1 i qui base. properti es file to use your specific credentials.
For example:
vi nysql -1iqui base. properties

Populate the database that you just created:

./ manage- dat abase. sh nmysql updat eDat abase

Verify that the database tables were created:

nysql -uuser -p

Specify the password for the MySQL user.

Specify the following command to use the default Vibe database:

nysql > use sitescape;

A message indicating that the database has been changed is displayed.
Specify the following command to show that the tables were created:

nysql > show t abl es;

Creating a Microsoft SQL Database

Before you begin, you should be familiar with standard database maintenance procedures.

For more information about Microsoft SQL, see the following references:

*

Microsoft SQL Server 2008 Learning Resources (http://www.microsoft.com/sqlserver/2008/en/
us/learning.aspx)

Microsoft SQL Server 2005 Learning Resources (http://www.microsoft.com/sqlserver/2005/en/
us/learning-resources.aspx)

The following database tool can be helpful:

*

Squirrel SQL Client (http://squirrel-sgl.sourceforge.net)

To create a Microsoft SQL database:

1
2

Review the Microsoft SQL requirements listed in “Vibe Server Requirements” on page 19.
Ensure that the Microsoft SQL Server and Client have been installed and configured properly.

IMPORTANT: Ensure that TCP/IP is enabled for the Microsoft SQL Server.

For more information, see “Microsoft SQL Server” (http://msdn.microsoft.com/en-us/library/
bb545450.aspx).

Ensure that the Microsoft SQL database client is also installed on the Vibe server.
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10
11

12

13
14

The Vibe installation program needs the Microsoft SQL client in order to communicate with the
remote Microsoft SQL database server.

When you install Microsoft SQL Server, select SQL Server and Windows for authentication.
The default is Windows Only, which is not appropriate for Vibe.

Copy the t eani ng- 4. 0. n- db. zi p file from the Vibe server where the Vibe installation program
is located and copy it to the database server.

or
Download and unzip the Vibe software onto the database server.

In the directory where the Vibe Installation program is located on the database server, or in the
location where you copied the t eam ng- 4. 0. n- db. zi p file, unzip the t eani ng- 4. 0. n-db. zi p
file.

Change to the db subdirectory.
Change to the db/ scri pt s/ sql subdirectory.
Use Microsoft SQL Server Management Studio to create the empty database:

9a Copy the sql server-creat e- enpt y- dat abase. sql file from the db/ scri pt s/ sql
subdirectory .

9b Execute the query to create the empty database.

When the database is created, you should see Command(s) conpl eted successful lyin
the messages window.

Change to the db directory.

Edit the sqgl server-1i qui base. properti es file to use your administrator user name and
password for the SQL database server.

Populate the database that you just created (requires that Java is installed):

run manage- dat abase. bat sql server updat eDat abase

Verify that the database tables were created by using Microsoft SQL Server Management Studio.
If desired, you can now uninstall Java.

Creating an Oracle Database

Before you begin, you should be familiar with standard database maintenance procedures.

For more information about your Oracle database, see the following references:

*

*

Oracle Product Documentation (http://www.oracle.com/technetwork/indexes/documentation/)

Oracle SQL Plus Documentation (http://download.oracle.com/docs/cd/B19306_01/server.102/
b14357/toc.htm)

The following database tool can be helpful:

*

1
2

3

Squirrel SQL Client (http://squirrel-sqgl.sourceforge.net)

Review the Oracle database requirements listed in “Vibe Server Requirements” on page 19.
Ensure that the Oracle database server software has been installed and configured properly.
For more information, see Oracle Database (http://www.oracle.com/database).

Set up the Oracle database character set to support Unicode character encodings.
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Vibe requires either the UTF-8 or AL32UTF8 character set for proper operation. Oracle
recommends AL32UTF8, because it has increased support for certain Asian languages. For
more information, see “Choosing a Character Set” (http://download.oracle.com/docs/cd/
B19306_01/server.102/b14225/ch2charset.htm) in the Oracle Database Globalization Support
Guide.

Copy the t eani ng- 4. 0. n- db. zi p file from the Vibe server where the Vibe installation program
is located and copy it to the database server.

or
Download and unzip the Vibe software onto the database server.

In the directory where the Vibe Installation program is located on the database server, or in the
location where you copied the t eami ng- 4. 0. n- db. zi p file, unzip the t eani ng- 4. 0. n-db. zi p
file.

6 Change to the db subdirectory.

7 Change to the db/ scri pt s/ sql subdirectory.

8 Edit the or acl e- creat e- enpt y- dat abase. sqgl script with your Oracle database password.

10
11

12

13

Original:

drop user sitescape cascade;

create user sitescape identified by sitescape;
grant connect, resource to sitescape;

connect sitescape/sitescape;

(SiteScape is the name of the company that previously developed the Vibe software.)
Updated:

drop user sitescape cascade;

create user sitescape identified by your_oracl e_password;

grant connect, resource to sitescape;
connect sitescape/your_oracl e_passwor d;

IMPORTANT: Unless you are very familiar with editing scripts, change only the password. Do
not attempt to change the name of the database from the legacy default of si t escape.

Enter the following commands to run the database creation script:

sql plus "/ as sysdba"

SQ.> spool oracl e-create-enpty-database. out;

SQ.> @r acl e-creat e- enpt y- dat abase;

SQL> quit

Check the resulting or acl e- cr eat e- enpt y- dat abase. out file for errors and resolve them.

Edit the or acl e- | i qui base. properti es file to use your administrator user name and
password.

For example:

vi oracle-liquibase.properties

Populate the database that you just created:

run ./ manage- dat abase. sh oracl e updat eDat abase
Verify that the database tables were created.
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Creating a PostgreSQL Database

Before you begin, you should be familiar with standard database maintenance procedures.

For more information about PostgreSQL, see the PostgreSQL documentation on the web (https://
www.postgresql.org/docs/manuals/).

To create the PosgreSQL database:

1
2

Review the PostSQL requirements listed in “Vibe Server Requirements” on page 19.

Ensure that the PostgreSQL database server and client have been installed and configured, as
described in “PostgreSQL Database Server” on page 236.

Ensure that the PostgreSQL database client is also installed on the Vibe server.

The Vibe installation program needs the PostgreSQL client in order to communicate with the
remote PostgreSQL database server.

Ensure that you know the password for the PostgreSQL post gr es administrator user.

5 Configure the socket connection method.

10

11

12

5a Astheroot user, browse to/var/lib/ pgsql/data.

5b Edit the pg_hba. conf file and change the following local and host lines to specify md5
encryption, as follows:

local all al | 5
host al | al | 127.0.0.1/ 32 nmd5
host al | al | 011/ 128 nd5

5¢c Save the file.
5d Edit the post gres. conf file.

5e Make sure that the listen_addresses line is uncommented and configured to allow
connection requests from all Vibe servers by specifying individual IP addresses or by
replacing localhost with an asterisk (*).

5f Save and close the file.
5g Stop and restart the PostgreSQL system process.

Copy the t eani ng- 4. 0. n- db. zi p file from the Vibe server where the Vibe installation program
is located and copy it to the database server.

or
Download and unzip the Vibe software onto the database server.

In the directory where the Vibe Installation program is located on the database server, or in the
location where you copied the t eam ng- 4. 0. n- db. zi p file, unzip the t eam ng-4. 0. n-db. zi p
file.

Change to the db subdirectory.
Change to the db/ scri pt s/ sql subdirectory.

Copy the post gresql - cr eat e- enpt y- dat abase. sql script to a convenient temporary location
on the server where you want to create the database, and ensure that your database
management utility is on your path so that you can run it from that directory.

Run the script to create your Vibe database:

psql -Uadm n-usernane < "postgresql -creat e-enpt y- dat abase. sql "
You are prompted for the admin-user password.

Change to the db directory:
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13

14

15

16
17

18

In a text editor, open the post gresql -1 i qui base. properti es file and make the following
changes:

+ Change the user nane, passwor d, r ef er enceUser nane, and r ef er encePasswor d fields to
reflect the admin-username and password for accessing your database.

+ Replace | ocal host with the addresses specified in Step 5e on page 142.

+ (Optional) If you changed the database name, change the ur| and r ef er enceURL fields to
reflect name of your Vibe database.

Save and close the text editor.

In the same directory, make the nanage- dat abase. sh file executable by entering the following
command:

chmod +x manage- dat abase. sh
Use the following command to create the database schema:

./ manage- dat abase. sh post gresql updat eDat abase

NOTE: You can safely ignore the following Liquibase log messages:

* Warning: nodifyDataType will lose primary key/autoincrenent/not null
settings for nysql

+ Any messages that contain the words i nfo: failureorinfo: failed, aslong as they
are associated with a type | NFOmessage

Start the Vibe server as described in “Starting Vibe on Linux” on page 80.

For security reasons, delete the password that you specified in Step 13 by opening the
post gresql -1i qui base. properti es file and removing the password from the passwor d and
r ef er encePasswor d fields.

Save and close the properties file.
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Installing the Lucene Index Server on a
Remote Server

You can install the Lucene Index Server on a different server from where Micro Focus Vibe is running.
If the Lucene Index Server is already running on the same server as Vibe, you can move the Lucene
Index Server to a different server.

Running the Lucene Index Server on a remote server allows both the Lucene Index Server and the
Vibe server to have access to more server memory, disk space, and CPU resources.

Complete the following sections whether you are installing the Lucene Index Server on a remote
server, or moving the Lucene Index Server to a remote server.

IMPORTANT: The Vibe server and the Lucene Index Server must not have a firewall between them.
The RMI protocol used for the Lucene Index Server port works only within a trusted local area
network (LAN).

+ “Installing the Lucene Software” on page 145
+ “Updating Your Vibe Site” on page 147
+ “Managing a Remote Lucene Index Server” on page 147

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructions in Part I, “Basic Installation,” on
page 49 before attempting a more complex Vibe configuration.

Installing the Lucene Software

1 Ensure that the Java Developer Kit (JDK) is installed on the remote server where you want to
install the Lucene Index Server.

You must use the same JDK that is being used on the server where Vibe is running. For
example, if you are using the IBM JDK on the server where Vibe is running, you must use the
IBM JDK on the remote Lucene Index Server.

For instructions, see Appendix A, “Vibe System Requirements Assistance,” on page 231.
2 Ensure that there is no firewall between the Vibe server and the Lucene Index Server.

3 Copy the Lucene installation program from its original location in the same directory with the
Vibe installation program to a convenient temporary directory on the remote server.

The file name for the Lucene Installation program varies by platform:

Linux: | ucene-installer.!linux

Windows: | ucene-installer.exe

4 Change to the directory where you copied the Lucene installation program, then start it.

5 Accept the License Agreement, then click Next.
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6 Select New installation, then click Next.

7 Browse to and select the directory where you want to install the Lucene Index Server, then click
Next.

The default location varies by platform:

Linux: / opt/ novel | / t eam ng/ | uceneserver

Windows: c:\Program Fi | es\ Novel I \ Team ng\ | uceneser ver

8 Browse to and select the directory where you installed the JDK, then click Next.

9 Adjust the configuration of the Lucene Index Server, as described in “Changing Your Lucene
Index Server Configuration” on page 107, then click Next.

10 Click Install to install the Lucene software.
11 (Conditional) On Linux, deselect Start Lucene server.

You must edit the Lucene Index Server startup script before you start the Lucene Index Server.
Instructions are provided later in this procedure.

12 (Conditional) On Windows, if you do not want to start the Lucene Index Server immediately,
deselect Start Lucene server.

For instructions on starting and stopping the Lucene Index Server manually, see “Managing a
Remote Lucene Index Server” on page 147.

13 Click Finish.
14 (Conditional) On Linux:
1l4a Change to the following directory:

/ opt/ novel | /t eam ng/ | uceneserver/i ndexserver/bin

14b Open thei ndexserver-startup. shfile in a text editor.
14c Add the following switch to the j ava launch command at the end of the script:

-Djava. rm . server. host name=i p_addr ess

Rename i p_addr ess with the IP address of the server where you installed the Lucene
Index Server.

14d Save the i ndexserver- st art up. sh file, then exit the text editor.
1l4e Start the Lucene Index Server.

For instructions on starting and stopping the Lucene Index Server manually, see “Managing
a Remote Lucene Index Server” on page 147.

Moving the Lucene Index Server from the Vibe server to a remote server increases the scalability of
your Vibe system, because the workload is distributed between two different physical servers.
However, in this configuration, the Lucene Index Server still runs on a single server. Your Vibe site
depends on the Lucene Index Server for full functionality. If that server goes down for some reason,
the Vibe site becomes inaccessible until access to the Lucene Index Server is restored. You can
further expand your Vibe system by setting up multiple Lucene Index Servers to provide high
availability, as described in Chapter 21, “Running Multiple Lucene Index Servers,” on page 157.
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Updating Your Vibe Site

Complete this section only if you are moving the Lucene Index Server. If you are performing a fresh
Lucene Index Server installation, disregard this section.

1 Stop Micro Focus Vibe.

2 Start the Vibe installation program to reconfigure the Lucene Index Server settings.

For information on how to start the installation program, see “Running the Linux Vibe Installation
Program” on page 72 or “Running the Windows Vibe Installation Program” on page 83.

3 On the Choose Installation Type page, select Advanced, then click Next.
4 Click Next until you reach the Lucene Configuration page.

Novell Vibe 4 Installation Program o x

Lucene Configuration

N

Use the following fields to configure the Lucene index.

To run the Lucene index as a server, select Server from the drop-down list.
‘You can run Lucene as a server on the same machine where the Vibe software Is installed or on a
remote machine.

Enter the host name and edit the RMI port If the default port cannot be used.

Max boaleans 100000
Merge factor .ID

Lucene configuration type: local j

5 Inthe Lucene configuration type field, select server to activate additional fields.
Host: Specify the hostname of the server where you installed the Lucene Index Server software.

RMI Port: Use the same port number that you used when you installed the Lucene Index Server
software. The default RMI port is 1199.

6 Click Next until you reach the Ready to Install page, then click Install.
7 When the installation is complete, click Finish.
8 Start Vibe.

Managing a Remote Lucene Index Server

+ “Linux: Managing a Remote Lucene Index Server” on page 147

+ “Windows: Managing a Remote Lucene Index Server” on page 148

Linux: Managing a Remote Lucene Index Server

Use the following commands to start and stop the Lucene index server manually:

/etc/init.d/indexserver start
/etc/init.d/indexserver stop

To configure the Lucene Index Server to start automatically when the Linux server reboots, use:
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chkconfig --add i ndexserver

Windows: Managing a Remote Lucene Index Server

Use the following commands at a DOS command prompt to start and stop the Lucene index server
manually:

c:\Program Fi | es\ Novel | \ Team ng\ | uceneserver\i ndexserver\ bi n\

i ndexserver -startup. bat

c:\ Program Fi | es\ Novel | \ Teani ng\ | uceneserver\i ndexserver\ bi n\

i ndexser ver - shut down. bat

To configure the Lucene Index Server to start automatically when the Windows server reboots, you
can set it up as a scheduled task that runs at system startup.

1

o N o o

On the Windows server where the Lucene Index Server is installed, click Start > All Programs >
Accessories > System Tools > Scheduled Tasks.

Double-click Add Scheduled Task to open the Scheduled Task Wizard, then click Next to
continue.

Click Browse, then browse to and double-click the i ndexser ver - st art up. bat file in the
following directory:
c:\ Program Fi | es\ Novel |\ Team ng\ | uceneserver\indexserver\bin

In the Task name field, specify an informative name for the task, such as Lucene Index Server.
The default task name is the name of the batch file.

In the Perform this task field, select When my computer starts, then click Next.

Specify and confirm the Administrator password for the Windows server, then click Next.
Select Open advanced properties for this task when I click Finish, then click Finish.

Verify that Run only if logged on is deselected, then click OK.

A new task with the name you specified in Step 4 is added to the list in the Scheduled Tasks
window.

Click File > Exit to close the Scheduled Task Wizard.
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20 Running Vibe on Multiple Servers

By running Micro Focus Vibe on multiple servers, you can achieve high availability, including failover
and load balancing, depending on how you configure your servers. You must perform an Advanced
installation on each server in order to configure the Vibe software for such a clustered environment.
+ “Planning a Multi-Server Vibe Configuration” on page 149
¢ “Installing the Vibe Software on Multiple Servers” on page 150

+ “Configuring a Web Application to Provide High Availability Functionality for Your Vibe Site” on
page 153

+ “Configuring Internet Information Services to Support Multiple Vibe Servers” on page 155

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommended that you follow the instructions in Part 1, “Basic Installation,”
on page 49 before attempting a more complex Vibe configuration.

Planning a Multi-Server Vibe Configuration

¢ “Lucene Index Server Considerations” on page 149
+ “Vibe File Repository Considerations” on page 149
+ “Configuring Routing for Multicast IP on the Vibe Server” on page 150

Lucene Index Server Considerations

Before you can implement a multi-server Micro Focus Vibe configuration, you must move your
Lucene Index Server away from the initial Vibe server, as described in Chapter 19, “Installing the
Lucene Index Server on a Remote Server,” on page 145.

Vibe File Repository Considerations

Before you implement a multi-server Micro Focus Vibe configuration, you must plan the Vibe file
repository for the clustered Vibe servers. Your configuration must comply with the following
restrictions:

+ The Vibe file repository must be placed in a shared location that is accessible to each Tomcat
instance.

+ All Tomcat instances must be configured with the same path leading to the shared storage.

For background information on the contents of the Vibe file repository, see “Distributing Different Data
Types to Different Locations” on page 104.
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Configuring Routing for Multicast IP on the Vibe Server

If you are planning to use ehcache as your hibernate caching provider, you might need to set up the
routing for multicast IP on each server where Vibe is installed. If this is not done, then depending on
your Vibe system, you might see a communication error when you start the Vibe server. For example,
in the log file you might see the following:

Error starting heartbeat. Error was: No such device.

To prevent this error, or to fix the Vibe system after the error occurs:

1 Run the following command:

route add -net 232.0.0.0/8 dev ethO

Installing the Vibe Software on Multiple Servers

1 Update your existing Micro Focus Vibe server to participate in a multi-server configuration:

la
1b

1c
1d
le

1f

1g

1h

1i

Stop Vibe.
Start the Vibe Installation program.

For information on how to start the installation program, see “Running the Linux Vibe
Installation Program” on page 72 or “Running the Windows Vibe Installation Program” on
page 83.

On the Installation Settings page, select Reconfigure Settings, then click Next.
On the Choose Installation Type page, select Advanced, then click Next.
Click Next to proceed through the installation pages where no changes are needed.

(Conditional) If you do not have the Basic Vibe Installation Summary Sheet and Advanced
Vibe Installation Summary Sheet from the initial Vibe server installation, record the
configuration of the initial Vibe server as you proceed through the installation pages.

Subsequent Vibe servers in the multi-server configuration must be installed with the same
configuration settings as the initial Vibe server.

On the Vibe Cluster Configuration page, select Enable clustered environment to enable
clustering.

On the first Vibe node, in the JVM Route field, specify wor ker 1. On the second Vibe node,
in the JVM Route field, specify wor ker 2, and so forth for each Vibe node, incrementing the
JVM Route setting. Each Tomcat instance should have a unique JVM Route setting.

wor ker 1, wor ker 2, and so forth are the default names for the matching values used for the
reverse proxy configuration. For example, if you have set up Apache or IIS as a reverse
proxy, these are the default values. The JVM Route setting in the Vibe installer must match
these values.

Select one of the following options for your hibernate caching provider:

ehcache: Ehcache is recommended for small clustered Vibe sites, and is included in the
Vibe software. If you select this option, no further configuration is necessary. For more
information, see Ehcache (http://ehcache.sourceforge.net).

memcached: Memcached is recommended for medium to large clustered Vibe sites.
Memcached is not included in the Vibe software. If you select this option, you must
download and install memcached on each server that you plan to use for caching in your
Vibe cluster. For information about downloading and installing memcached, see
Appendix B, “Memcached Caching with Micro Focus Vibe,” on page 241.
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Depending on the cache provider you select, different options are displayed.

Novell Vibe 4 Installation Program i E

Vibe Cluster Configuration

Select the checkbox to configure this Vibe installation to participate in a cluster.

v Enable clustered environment

JVM Route:

Hibernate caching provider: [encache |~

Metwork interface for distributed cache service (Optional: IP address or hostname expected)

HostName:
Multicast Group Address (Ip Address): [232.0.0.1

Multicast Group Port: |4446

Novell Vibe 4 Installation Program i X

Vibe Cluster Configuration

Select the checkbox to configure this Vibe installation to participate in a cluster.

v Enable clustered environment

JVM Route: |

Hibemnate caching provider: Ir'm-mmachad |'|

Enter a space delimited list of memcached instances in the format host:port
For example, 192.168.1.5:11211 192.168.1.7:11212

Server Addresses: ..

1j (Conditional) If you selected ehcache as the hibernate caching provider in Step 1g, specify
the following information on the Vibe Cluster Configuration page to configure ehcache:

Network interface for distributed cache service: Specify the IP address or hostname of
the distributed cache service.

Multicast Group Address: (Optional) Specify the common multicast group IP address.
Each clustered node recognizes other nodes in the cluster by means of this IP address.

IMPORTANT: Ensure you specify the same IP address on all Vibe nodes in the cluster.
After you have set this IP address for each Vibe node, restart each node in succession,
allowing each node to initialize before restarting the next.

The default multicast group IP address is 232.0.0.1. If you have more than one clustered
Vibe system (for example, one in the lab and one in production), or if you have another
software product that is already using the default multicast group IP address, you must
update this field for one system so that it uses an IP address other than the default.

Use an IP address in the range of 224.0.0.1 to 239.255.255.255.
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1k

1l

Multicast Group Port: (Optional) Specify the port number through which the Vibe nodes
will communicate.

(Conditional) If you selected memcached as the hibernate caching provider in Step 1g,
specify the following information on the Vibe Cluster Configuration page to configure
memcached:

Server Addresses: Specify a list of memcached servers, with each server separated by a
space. For example, host nanel: port host nanme2: port host nane3: port

The server addresses listed here are all nodes within the Vibe cluster. Changes made to
one Vibe node are immediately visible in other Vibe nodes. Ensure that the clock settings
for each Vibe node are synchronized. Failure to do so can significantly degrade overall
system performance.

Memcached is not included in the Vibe software. If you select memcached as your
hibernate caching provider, you must download and install memcached on each server in
your Vibe cluster. For information about downloading and installing memcached, see
Appendix B, “Memcached Caching with Micro Focus Vibe,” on page 241.

On the Ready to Install page, click Install.

1m On the Installation Complete page, click Finish.

2 Install the Vibe software on each additional server, using the same installation settings that you
used for the initial Vibe server.

3 (Conditional) If you set up ehcache as the caching provider, on each Linux server where you
installed the Vibe software, set the multicast route to enable the servers to function as a cluster:

3a Use the following command on the command line to immediately set the multicast route for

*

*

*

the server:

route add -net 232.0.0.0/8 dev ethO

3b To run this command each time the server reboots, add the command to the following file on

each server:

/etc/init.d/boot.|ocal

4 Start Vibe on each server, as described for the platform where you are installing Vibe:

“Starting Vibe on Linux” on page 80
“Running Vibe as a Windows Service” on page 86

“Running Vibe as a Windows Application” on page 88

5 (Conditional) If you set up ehcache as the caching provider and the Vibe servers fail to start
because of a communication error, ensure that you have followed the steps in “Configuring
Routing for Multicast IP on the Vibe Server” on page 150.

6 Continue with Configuring a Web Application to Provide High Availability Functionality for Your
Vibe Site.
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Configuring a Web Application to Provide High
Availability Functionality for Your Vibe Site

After Micro Focus Vibe is installed and running on multiple servers, you must provide additional
software to provide high availability functionality. Because Vibe is based on Tomcat, you can use
software that provides high availability for Tomcat.

1 Install and configure one of the following web applications to provide high availability for your
Vibe site:
+ Apache web server (http://www.apache.org)
+ Linux Virtual Server (http://www.linuxvirtualserver.org)
+ Novell Access Manager (https://www.netiq.com/products/access-manager/)
+ Microsoft Internet Information Services (http://www.iis.net)

2 Configure the web application to establish the Vibe site URL, which then stays constant for Vibe
users regardless of which Vibe server they access at any given time.

3 Start the web application with its new configuration settings.
4 Test your Vibe site for high availability.

+ If you are using Apache web server, Linux Virtual Services, or Microsoft Internet Information
Services, users can immediately log in to the Vibe site again after a failover has occurred.
The connection between the user’s browser and the Vibe site is maintained as the failover
occurs.

+ If you are using Novell Access Manager, users must start a new browser session, and then
log in to the Vibe site after a failover has occurred. They cannot log in again from the same
browser session, because the connection between the user’s browser and the Vibe site
must be reestablished after the failover.

The following sections provide examples of how to configure the web applications:

+ “Configuring Apache as a Load Balancer” on page 153
+ “Configuring Linux Virtual Server as a Load Balancer” on page 155

Configuring Apache as a Load Balancer

The following example configuration uses the balancer module built into the newer Apache (version
2.2.4 and later) web server. It is based on a widely used sticky session technique. Micro Focus Vibe
does not support session sharing/replication among Tomcat instances.

If you are using Novell Access Manager as described in “Configuring Single Sign-On with Novell
Access Manager” on page 111, you do not need to configure Apache to load balance as described in
this section, because Access Manager provides this service.

NOTE: When you update your Vibe system, these settings are not preserved. You must redefine
these settings each time you update your Vibe system.

To configure Apache to load balance:

1 Install the Apache web server (http://httpd.apache.org) on one server.
2 Editthe /et c/ sysconfi g/ apache2 file:
2a Locate the following line:
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2b

2c

2d

APACHE_MODULES=

Then add the following lines:

pr oxy
proxy_aj p
proxy_bal ancer

The end result should look similar to the following:

APACHE _MODULES="actions alias auth_basic authn file authz_host
authz_groupfile authz_default authz_user authn_dbm autoindex cgi dir env
expires include log_config mme negotiation setenvif ssl suexec userdir
php5 reqtineout proxy proxy_ajp proxy_bal ancer™”

Create the following new configuration file:
/ et c/ apache2/ htt pd. conf. vi be

Add the following section to the / et ¢/ apache2/ ht t pd. conf . vi be file, providing a
Bal ancer Menber line for each j vinRout e value in a Tomcat ser ver. xni file.

<Locati on /bal ancer - manager >
Set Handl er bal ancer - nanager
Order deny, al | ow
Deny from all
Allow from 127.0.0.1
</ Locati on>
<Proxy bal ancer://cl uster_nanme>
Bal ancer Menber aj p://vi be_server_1: 8009 rout e=wor ker 1
Bal ancer Menber aj p://vi be_server _2: 8009 rout e=wor ker 2
</ Proxy>
<Location />
ProxyPass bal ancer://cluster_nane/ stickysessi on=JSESSI ONI D
</ Locati on>

The values that you specify for the r out e setting (for example, wor ker 1, wor ker 2, etc.)
must exactly match the values that you specify as the JVM Route setting during the Vibe
installation, as described in “Installing the Vibe Software on Multiple Servers” on page 150.

Save the ht t pd. conf . vi be file.

3 Reconfigure each Vibe server in the cluster so that each server has the same network
information (hostname and ports) as the Apache web server.

For each Vibe server in the cluster:

3a Run the Vibe installation program by reconfiguring the Vibe server.

3b

3c

For information about how to reconfigure your Vibe server, see Chapter 16, “Setting
Configuration Options after Installation,” on page 129.

On the Network Information page in the Vibe installation program, change the hostname in
the Host field for each Vibe server. The hostname must match the DNS name that users
use to access the Vibe service.

For example, if the URL for you Vibe site is vi be. acnme. com you would specify
vi be. acre. comin this field.

Continue through the Vibe installation program for each Vibe server in the cluster, as
described in Chapter 16, “Setting Configuration Options after Installation,” on page 129.

4 Restart Apache.
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TIP: For enhanced performance when using the Internet Explorer browser to access a Vibe system
that is using Apache as an SSL reverse-proxy server, change the Apache SSL exclusion regular
expression configuration from the following:

Set Envlf User-Agent ".*MSIE *" \
nokeepal i ve ssl -uncl ean- shut down \
downgrade-1.0 force-response-1.0

to the following:

Set Envlf User-Agent ".*MBIE [1-5].*"
nokeepal i ve ssl -uncl ean- shut down
downgrade-1.0 force-response-1.0

Set Envlf User-Agent ".*MSIE [6-9].*"
ssl - uncl ean- shut down

Configuring Linux Virtual Server as a Load Balancer

Consult the following online sources for instructions on setting up Linux Virtual Server as a load
balancer for your Micro Focus Vibe site:

+ The Linux Virtual Server Project (http://www.linuxvirtualserver.org)
¢ Linux Virtual Server (LVS) Project (http://www.austintek.com/LVS)

¢ Linux Virtual Server Tutorial (http://www.ultramonkey.org/papers/Ivs_tutorial/html)

Configuring Internet Information Services to Support
Multiple Vibe Servers

You can configure Internet Information Services (IIS) to support multiple Micro Focus Vibe servers.
For more information, see “Configuring IIS to Load Balance in a Clustered Environment” on
page 122.
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Running Multiple Lucene Index Servers

Your Micro Focus Vibe site depends on the Lucene Index Server for full functionality. Different Lucene
configurations provide different levels of scalability and reliability.

You can install the Lucene Index Server on a different server from where Vibe is running so that both
programs have access to more server memory, disk space, and CPU resources. However, the Vibe

server and the Lucene Index Server must not have a firewall between them. The RMI protocol used

for the Lucene Index Server port works only within a trusted local area network (LAN).

+ A Basic installation of Vibe places the Lucene Index Server on the same server where the Vibe
software is installed.

+ To provide additional memory for the Lucene Index Server, you might already have configured it
to run in its own memory space, as described in “Running the Lucene Index Server in Its Own
JVM” on page 108.

+ To provide additional disk space and memory for the Lucene Index Server, you might already
have moved it to a different server, as described in Chapter 19, “Installing the Lucene Index
Server on a Remote Server,” on page 145.

These configurations provide additional resources for the Lucene Index Server, but it is still a single
point of failure for your Vibe site. If the Lucene Index Server goes down, the Vibe site becomes
inaccessible until access to the Lucene Index Server is restored.

Running multiple Lucene Index Servers provides high availability functionality, so that if one Lucene
Index Server goes down, Vibe users can still access the Vibe site because other Lucene Index
Servers are still available.

+ “Planning a High Availability Lucene Configuration” on page 157

+ “Setting Up a High Availability Lucene Configuration” on page 158

+ “Testing Your Lucene High Availability Configuration” on page 170

+ “Synchronizing a High Availability Lucene Configuration” on page 172

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructions in Part Ill, “Basic Installation,” on
page 49 before attempting a more complex Vibe and Lucene configuration.

Planning a High Availability Lucene Configuration

A high availability Lucene Index Server configuration must include at least two different servers
(either physical or virtual), referred to as “nodes” in the Vibe installation program. Lucene nodes in a
high availability configuration can be set up on Linux servers, Windows servers, or both.

Each Lucene node must have its own independent directory structure for index files. The default
location for the index files for the Lucene Index Server varies by platform:

Linux: /var/opt/novel | /team ng/l ucene

Windows: c:\ Novel I\ Teami ng\ | ucene
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As you plan your high availability Lucene configuration, you can use the Advanced Vibe Installation
Summary Sheet to record the options you want to use.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under High Availability Lucene Configuration, specify the number of Lucene nodes that you want in
your high availability Lucene configuration.

Each Lucene node needs a unique name, a descriptive title, and a static IP address. The name and
title identify the node in the Vibe administrative interface. Typically, the Lucene Index Server listens
on RMI port 1199 on its server, but you can configure it to use a different port number if the default

port number is already in use.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under High Availability Lucene Configuration, specify the name, description, IP address, and RMI port
number for each Lucene node.

If you have already accumulated index data on your initial Vibe server, you can choose to copy the
index files to the Lucene nodes, or you can reindex the Vibe site after the new Lucene nodes are
running. Depending on the amount of accumulated index data, reindexing can be a time-consuming
process.

The Vibe server and the Lucene nodes must not have a firewall between them. The RMI protocol
used for the Lucene Index Server port works only within a trusted local area network (LAN).

Setting Up a High Availability Lucene Configuration

+ “Changing from a Local Lucene Index Server” on page 158
+ “Changing from a Single Remote Lucene Index Server” on page 161
+ “Expanding an Existing High Availability Lucene Configuration” on page 163

+ “Changing Your Lucene Configuration without Vibe Site Down Time” on page 166

Changing from a Local Lucene Index Server

To change from a local Lucene Index Server running on the Micro Focus Vibe server, you must install
the Lucene Index Server on two or more remote servers, and then reconfigure Vibe for a high
availability Lucene configuration.

NOTE: Although it is possible to use the Lucene Index Server on the Vibe server as one of the
“remote” Lucene nodes, this is not a recommended configuration. Consider it only if you are restricted
to two servers for your Vibe site.

1 Set up two or more Lucene nodes:

la Install the Lucene Index Server on each node, as described in “Installing the Lucene
Software” on page 145.

1b (Optional) Copy accumulated index data from the initial Lucene Index Server to each
additional Lucene node.

The default location for the index files varies by platform:
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Linux: /var/opt/novel | /team ng/l ucene

Windows: c:\Novel | \ Team ng\ | ucene

Start the Lucene Index Server on each Lucene node, as described in “Managing a Remote
Lucene Index Server” on page 147.

2 Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 20, “Running
Vibe on Multiple Servers,” on page 149, stop Vibe on all servers, or follow the instructions in
“Changing Your Lucene Configuration without Vibe Site Down Time” on page 166.

3 Run the Vibe installation program to configure the Vibe server for multiple Lucene nodes:

3a
3b
3c
3d

3e
3f

On the Installation Settings page, select Reconfigure Settings, then click Next.

On the Choose Installation Type page, select Advanced, then click Next.

Click Next to proceed through the installation pages where no changes are needed.
On the Lucene Configuration page, fill in the following fields:

Lucene configuration type: Select high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where
you have installed and started the Lucene Index Server.

Novell Vibe 4 Installation Program - x

N

Lucene Configuration

Use the following fields to configure the Lucene index.

To run the Lucene index as a server, select Server from the drop-down list.
‘You can run Lucene as a server on the same machine where the Vibe software is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannot be used.

Max booleans 100000

Merge factor 10

Lucene configuration type: high avallability j

Connection credentials to the lucene server(s):
Login name: ‘iucene service

Password:

e m—
——

Number of high availability search nodes: 2

Click Next.

On the Configure High Availability Search Nodes page, specify the configuration information
for each Lucene node from the Advanced Vibe Installation Summary Sheet that you filled
out in “Planning a High Availability Lucene Configuration” on page 157, then click Next.
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Novell Vibe 4 Installation Program o x
Configure High Availablity Search Nodes

Gonfigure the high availability search nodes specified in the previous panel.

Use the following fields to configure each high availability search node.
To remove one of the high avallable search nodes, unselect Its "Keep" check box.
Enter the high availability service name, host name and edit the RMI Port if the default port cannot

be used.

High Availability Search Node 1
¥ Keep service nameiLuceneLlnux

Service title |Lucene on Linux

Host [172.16.5.2

AMI port [1199

~High Avallability Search Node 2
Iv Keep Service name ILucene Windows

Service title iLucene on Windows

Host [172.16.5.9

RMI port|1199

If you need more than 2 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.
3i Start Vibe.
3j (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.
4 Configure the Vibe site for the additional Lucene nodes:
4a Log in to the Vibe site as the Vibe administrator.
4b Click your linked name in the upper right corner of the page, then click the Administration
Consoleicon *'.
4c Under Search Index, click Nodes.

Lucene on Linux {lucenelinux)

Host 1721652
RMI port: 1199

User Mode Access
@ Read and Write
© write Only
© No Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host: 172.16.5.19
RMI port: 1198

User Mode Access
© Read and Write
@ Write Only
© No Access

Enable Deferred Update Log

No Deferred Update Log Record Exists
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By default, the first Lucene node in the list has Read and Write access, meaning that Vibe

updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. This setting is useful when you need to perform maintenance on
a Lucene node, but it is not the setting you want when you set up a hew Lucene node.

4d Inthe User Mode Access box, select Read and Write for all Lucene nodes, click Apply, then
click Close.

The new setting is put into effect immediately, so that users immediately have access to the
additional Lucene nodes.

5 Skip to “Testing Your Lucene High Availability Configuration” on page 170.

Changing from a Single Remote Lucene Index Server

To change from a single remote Lucene Index Server to a high availability configuration, you must
install the Lucene Index Server on one or more additional remote servers, and then reconfigure Micro
Focus Vibe for additional Lucene nodes.
1 Bring down your Vibe site:
la Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 20,
“Running Vibe on Multiple Servers,” on page 149, stop Vibe on all servers, or follow the
instructions in “Changing Your Lucene Configuration without Vibe Site Down Time” on
page 166.

1b Ensure that the existing remote Lucene Index Server also stops.
2 Set up one or more additional Lucene nodes:

2a Install the Lucene Index Server on each additional remote server, as described in “Installing
the Lucene Software” on page 145.

2b (Optional) Copy accumulated index data from the initial remote Lucene node to each
additional Lucene node.

The default location for the index files varies by platform:

Linux: /var/opt/novel |/t eam ng/l ucene

Windows: c:\Novel |\ Team ng\ | ucene

2c Start the Lucene Index Server on each Lucene node, as described in “Managing a Remote
Lucene Index Server” on page 147, but do not bring up your Vibe site.

3 Run the Vibe installation program to configure the Vibe server for multiple Lucene nodes:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields:
Lucene configuration type: Change server to high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where
you have installed the Lucene Index Server.
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Novell Vibe 4 Installation Program = x
Lucene Configuration

Use the following fields to configure the Lucene index.

To run the Lucene index as a server, select Server from the drop-down list.
‘You can run Lucene as a server on the same machine where the Vibe software Is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannol be used.

Max booleans }1b6600
Merge factor ‘1 0

Lucene configuration type: high availability j

Connection credentials o the lucene server(s):
Login name: \I-ucene service

Password:

T m—
—

Number of high availability search nodes: 1‘2

3e Click Next.

3f On the Configure High Availability Search Nodes page, specify the configuration information
for each Lucene node from the Advanced Vibe Installation Summary Sheet that you filled
out in “Planning a High Availability Lucene Configuration” on page 157, then click Next.

Novell Vibe 4 Installation Program = x
Configure High Availablity Search Nodes

Configure the high availability search nodes specified in the previous panel. N

Use the following fields to configure each high availability search node.
To remove one of the high available search nodes, unselect its "Keep" check box.

Enter the high availability service name, host name and edit the RMI Port If the default port cannot
be used.

rHigh Availability Search Node 1

v Keep Service name |LucenelLinux

Service title ELLscene on Linux

Host [172.16.5.2

RAMI port |1199

rHigh Avallability Search Node 2

¥ Keep Service name |Lucene Windows

Service title |Lucene on Windows

Host[172.16.5.9

RMI port 1199

If you need more than 2 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.
3i Start Vibe.
3j (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.
4 Configure the Vibe site for the additional Lucene nodes:
4a Log in to the Vibe site as the Vibe administrator.
4b Click your linked name in the upper right corner of the page, then click the Administration
Consoleicon '+,

4c Under Search Index, click Nodes.
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4d
4e

la

Lucene on Linux (lucenelinux)

Host 1721652
RMI port. 1199

User Mode Access
© Read and Write
© write Only
© No Access

Enable Deferred Update Log

Mo Deferred Update Log Record Exists
Lucene on Windows (lucenewindows)
Host 17216519

RMI port. 1199

User Mode Access

© Read and Write

@ write Only

© No Access

Enable Deferred Update Log

Mo Deferred Update Log Record Exists

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe

updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. This setting is useful when you need to perform maintenance on
a Lucene node, but it is not the setting you want when you set up a hew Lucene node.

In the User Mode Access box, select Read and Write for all Lucene nodes.

Click Apply, then click Close.

The new setting is put into effect immediately, so that users immediately have access to the

additional Lucene nodes.

1 Bring down your Vibe site:

Stop Vibe.

5 Skip to “Testing Your Lucene High Availability Configuration” on page 170.

Expanding an Existing High Availability Lucene
Configuration

After you have set up an initial high availability Lucene configuration, you can add additional Lucene
nodes at any time.

If you have installed the Vibe software on multiple servers, as described in Chapter 20,
“Running Vibe on Multiple Servers,” on page 149, stop Vibe on all servers, or follow the
instructions in “Changing Your Lucene Configuration without Vibe Site Down Time” on

page 166.

1b Stop all Lucene nodes, as described in “Managing a Remote Lucene Index Server” on

page 147.

2 Set up one or more additional Lucene nodes:

2a Install the Lucene Index Server on each additional remote server, as described in “Installing

the Lucene Software” on page 145.

2b (Optional) Copy accumulated index data from an existing Lucene node to each additional

Lucene node.

The default location for the index files varies by platform:
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Linux: /var/opt/novel | /team ng/l ucene

Windows: c:\Novel | \ Team ng\ | ucene

2c Start the Lucene Index Server on each Lucene node, as described in “Managing a Remote
Lucene Index Server” on page 147, but do not bring up your Vibe site.

3 Run the Vibe installation program to configure the Vibe server for the additional Lucene nodes:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.

3d On the Lucene Configuration page, increase the number of nodes in the Number of high
availability search nodes field, then click Next.

Novell Vibe 4 Installation Program - x

N

Lucene Configuration

Use the following fields to configure the Lucene index.

To run the Lucene index as a server, select Server from the drop-down list.
‘You can run Lucene as a server on the same machine where the Vibe software is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannot be used.

Max booleans 100000

Merge factor 10

Lucene configuration type: high avallability j

Connection credentials to the lucene server(s):
Login name: iucene service

Password:

e m—
——

Number of high availability search nodes: 2

3e On the Configure High Availability Search Nodes page, specify the configuration information
for each additional Lucene node, then click Next.

164  Running Multiple Lucene Index Servers



Novell Vibe 4 Installation Program = X
Configure High Availablity Search Nodes

Configure the high availability search nodes specified in the previous panel.

Use the following fields to configure each high availability search node.
To remove one of the high available search nodes, unselect its "Keep" check box.

Enter the high availabllity service name, host name and edit the RMI Port if the default port cannot
be used.

RMI port 1199 ‘ A

~High Availability Search Node 2
v Keep service name !Lucene Windows

Service title |Lucene on Windows

Host 172.16.5.3

RMI port 1199

rHigh Availability Search Node 3
¥ Keep Service name |

Service title |

Host |

RMI port 1199

If you need more than 3 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

3f Click Next until you reach the Ready to Install page, then click Install.
3g On the Installation Complete page, click Finish.
3h Start Vibe.
3i (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.
4 Configure the Vibe site for the additional Lucene nodes:
4a Log in to the Vibe site as the Vibe administrator.
4b Click your linked name in the upper right corner of the page, then click the Administration
Consoleicon *'.

4c¢ Under Search Index, click Nodes.

Lucene on Linux (lucenelinux)

Host 1721652
RMI port. 1199

User Mode Access
© Read and Write
@ Write Only
© No Access

Enable Deferred Update Log

Mo Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host 172.16.5.19
RMI port: 1199

User Mode Access
© Read and Write
@ Write Only
© No Access

Enable Deferred Update Log

Mo Deferred Update Log Record Exists
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By default, the first Lucene node in the list has Read and Write access, meaning that Vibe

updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. This setting is useful when you need to perform maintenance on
a Lucene node, but it is not the setting you want when you set up a hew Lucene node.

4d In the User Mode Access box, select Read and Write for all Lucene nodes.
4e Click Apply, then click Close.

The new setting is put into effect immediately, so that users immediately have access to the
additional Lucene nodes.

5 Skip to “Testing Your Lucene High Availability Configuration” on page 170.

Changing Your Lucene Configuration without Vibe Site
Down Time

Vibe site down time can be avoided only if you have installed the Vibe software on multiple servers,
as described in Chapter 20, “Running Vibe on Multiple Servers,” on page 149.

To change to a high availability Lucene configuration in a multiple Vibe server configuration:

1 Set up two or more Lucene nodes:

la Install the Lucene Index Server on each node, as described in “Installing the Lucene
Software” on page 145

1b Start the Lucene Index Server on each Lucene node, as described in “Managing a Remote
Lucene Index Server” on page 147.

2 Stop Vibe on one server.

The other Vibe servers remain in service for users and continue to communicate with the original
Lucene Index Server.

3 Run the Vibe installation program on the Vibe server that you stopped to configure it for multiple
Lucene Index Servers:

3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields.
Lucene configuration type: Select high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where
you have installed the Lucene Index Server.
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Novell Vibe 4 Installation Program = x
Lucene Configuration

Use the following fields to configure the Lucene index. N

To run the Lucene index as a server, select Server from the drop-down list.
‘You can run Lucene as a server on the same machine where the Vibe software Is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannol be used.

Max booleans ‘166000
Merge factor {1 ]

Lucene configuration type: inigh availability j

Connection credentials o the lucene server(s):
Login name: ll-ucene service
Password: |

Number of high availability search nodes: ‘2

3e Click Next.

3f On the Configure High Availability Search Nodes page, specify the configuration information
for each Lucene node from the Advanced Vibe Installation Summary Sheet that you filled

out in “Planning a High Availability Lucene Configuration” on page 157, then click Next.

Novell Vibe 4 Installation Program = x
Configure High Availablity Search Nodes

Configure the high availability search nodes specified in the previous panel. N

Use the following fields to configure each high availability search node.
To remove one of the high available search nodes, unselect its "Keep" check box.

Enter the high availability service name, host name and edit the RMI Port If the default port cannot
be used.

rHigh Availability Search Node 1

v Keep Service name |LucenelLinux

Service title ELLscene on Linux

Host [172.16.5.2

RMI port |1199

rHigh Avallability Search Node 2

¥ Keep Service name Lucene Windows

Senvice title [Lucene on Windows

Host[172.16.5.9

RMI port [1199

If you need more than 2 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.
4 Start the reconfigured Vibe server.

5 Access the reconfigured Vibe server and prevent access to the additional Lucene nodes:
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IMPORTANT: All Vibe servers must be reconfigured before any of them access the additional
Lucene nodes.

5a Log in to the reconfigured Vibe server as the Vibe administrator, using the server hostname
rather than your Vibe site URL.

5b Click your linked name in the upper right corner of the page, then click the Administration
Consoleicon *'.

5¢ Under Search Index, click Nodes.

Lucene on Linux (lucenelinux)
Host: 172.16.5.2
RMi port: 1199
User Mode Access
@ Read and Write
~) Write Only
2 No Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host 172.16.5.19
RMI port: 1199

User Mode Access
) Read and Write
@ Write Only
2 No Access
Enable Deferred Update Log

Mo Deferred Update Log Record Exists

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. When you set up a high availability Lucene configuration without
Vibe site down time, you need to prevent write access during the reconfiguration process.

5d In the User Mode Access box, change Write Only to No Access for the additional Lucene
nodes.

5e Click Apply, then click Close.

The new setting is put into effect immediately, so that the reconfigured Vibe server does not
communicate with the additional Lucene nodes.

6 Reconfigure the rest of the Vibe servers:
6a Stop each Vibe server.
6b Repeat Step 3 to configure each Vibe server for the additional Lucene nodes.
6¢c Start each reconfigured Vibe server.
7 Access the reconfigured Vibe site and allow write access to the additional Lucene nodes:
7a Log in to the reconfigured Vibe as the Vibe administrator.
7b Click your linked name in the upper right corner of the page, then click the Administration
Consoleicon '+,

7c Under Search Index, click Nodes.
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Lucene on Linux {LuceneLinux)

Host172.16.5.19
RMI port: 1183

User Mode Access
@ Read and Write
O write Only
O No access

Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows (LuceneWindows)

Host: 137.65.67 222
RMI port: 1133

User Mode Access
O Read and Witz
© write Only
@ NoAccess

Enable Deferred Update Log

No Deferred Update Log Record Exists

Apply

7d In the User Mode Access box, change No Access to Write Only for the additional Lucene
nodes.

7e Click Apply, then click Close.

The new setting is put into effect immediately, so that the reconfigured Vibe servers can

now communicate with the additional Lucene nodes, although user access is still
disallowed.

8 Reindex the Vibe site, so that the additional Lucene nodes are updated with the same index data
that the original Lucene Index Server has:

8a On the Administration page, under Search Index, click Index.

Search Index @

Manage Search Index

Re-Index Everything

Select the Places to Be Re-Indexed:
Selecting a folder or workspace automatically indexes all folders and workspaces within it.

- Home Workspace

{.-5J Users and Groups
9 Global Workspaces
By Net Folders

-5 Personal Workspace
- Team Workspaces

Select the Nodes to Apolv Re-Indexina to:

Ifre-indexing all or large part ofthe tree, it is strongly recommended to change the access mode of the node(s) to write-only before starting
re-indexing so that all read requests can go to the other unselected node(s) while re-indexing is in progress. Atleast one node must allow

read-write at any given time. Once re-indexing is completed, change the access mode of the node(s) back to read-write so that search
requests can use them again

Lucene on Linux (lucenelinux) - Read and Write, Deferred Update Log Enabled, No Deferred Update Log Record Exists
Lucene on Windows (lucenewindows) - Write Only, Deferred Update Log Enabled, No Deferred Update Log Record Exists

8b Onthe Manage Search Index tab, select Re-Index Everything, so that the entire Vibe site is
reindexed.

8c Select the additional Lucene nodes, but do not select any previously existing nodes.
8d Click OK to start the indexing.
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Depending on the size of your Vibe site, reindexing can be a time-consuming process.
However, because one or more previously existing Lucene Index Servers are still servicing
the Vibe site, users are not affected by the reindexing process.

8e When the reindexing is complete, click Close.
9 Make the additional Lucene nodes available to Vibe users:
9a On the Administration page, under Search Index, click Nodes.

Lucene on Linux (lucenelinux)

Host: 172.16.5.2
RMi port: 1199

User Mode Access
@ Read and Write
2 Write Only

) No Access

Enable Deferred Update Log
No Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)
Host 172.16.5.19
RMi part: 1199
User Mode Access
) Read and Write
@ Write Only
) No Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

9b In the User Mode Access box, change Write Access to Read and Write for the additional
Lucene nodes.

9c Click Apply, then click Close.

The new setting is put into effect immediately, so that Vibe users have additional Lucene
Index Servers available as they use the Vibe site.

Testing Your Lucene High Availability Configuration

When you first set up your high availability Lucene configuration, you can configure Micro Focus Vibe
to write Lucene node information to the Tomcat log file so that you can observe the behavior of the
Lucene nodes. Then you can take nodes down and bring them up again to see the effect on your Vibe
site. This process helps you prepare for the situation where a Lucene node goes down unexpectedly
or you need to take one down on purpose, perhaps for maintenance.

+ “Configuring Vibe to Log Lucene Node Activity” on page 171
+ “Observing Lucene Node Activity” on page 171

NOTE: For background information about the Tomcat log file, see “Tomcat Log File” in “Site
Maintenance” in the Micro Focus Vibe 4.0.4 Administration Guide.
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Configuring Vibe to Log Lucene Node Activity

By default, Vibe writes an error to the Tomcat log file whenever it cannot communicate with a Lucene
node. For testing purposes, you can change the logging level so that the Tomcat log file includes a
message for each time Vibe contacts a Lucene Index Server.

After observing and understanding the behavior, you should return the logging to normal levels.

1 Openthel og4j . properti es file in a text editor.
The location of the | og4j . properti es file varies by platform.

Linux: / opt/ novel | / t eanmi ng/ apache-t oncat / webapps/ ssf/WEB- | NF

Windows: c:\Program Fi | es\ Novel | \ Teani ng\ apache-t oncat\
webapps\ ssf\ VEB- | NF

2 Search for the following line:
#| og4j . cat egory. com novel | . t eani ng. sear ch=DEBUG

3 Remove the pound sign (#) from the beginning of the line to activate the DEBUG logging level for
the Lucene Index Server.

The DEBUG logging level adds a message for each time Vibe contacts a Lucene Index.
4 Save the | og4j . properti es file, then exit the text editor.
5 Stop Vibe, then start Vibe to put the new logging level into effect.

Observing Lucene Node Activity

After changing the Vibe logging level to include Lucene node activity, you can monitor the Tomcat log
file to see which Lucene nodes Vibe is contacting.
1 Change to the directory where the Tomcat log file is located.

For background information about the Tomcat log file, see “Tomcat Log File” in “Site
Maintenance” in the Micro Focus Vibe 4.0.4 Administration Guide.

2 On Linux, use the tai | command to monitor the end of the Tomcat log file.
tail -f catalina.out
or

On Windows, download an equivalent command from the Internet in order to perform the
following steps.

For example, there is a command available at SourceForge.net (http://sourceforge.net/projects/
tailforwin32).

3 Perform some activities on the Vibe site to create new content.

For example, you could create a blog entry. The Tomcat log file shows that Vibe is contacting
each available Lucene Index Server in turn as it submits the new information for indexing. Nodes
are considered available if they are marked Read and Write in the User Mode Access box on the
Lucene Nodes page.

4 Bring down one of the Lucene nodes.

For example, you might reboot the Lucene server, stop the Lucene Index Server on the node, or
otherwise prevent Vibe from contacting the Lucene node.

5 Observe that the Tomcat log file displays an error when the Lucene node becomes unavailable.
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6 Perform some additional activities on the Vibe site that create new content.

You might notice a pause as Vibe tries to connect with the Lucene node that is no longer
available.

7 Observe that the Tomcat log file shows when normal Vibe processing has resumed without
access to the unavailable Lucene node.

8 Make the unavailable Lucene node available again.

9 Observe that the Tomcat log file indicates that Vibe has created a journal record on the Lucene
node that was temporarily unavailable.

The journal record contains the indexing operations that failed to take place while the Lucene
node was unavailable. Even though the Lucene node is back up, Vibe does not start accessing it
until it has been synchronized with the latest index information.

10 To synchronize the out-of-date Lucene node, follow the steps in “Synchronizing a High
Availability Lucene Configuration” on page 172.

After the out-of-date Lucene node has been synchronized, Vibe starts accessing it again.

If a situation arises where no Lucene node is marked Read and Write in the User Mode Access box
on the Lucene Nodes page, Vibe temporarily accesses the first node in the list that is set to Write
Only. If no nodes are set to Write Only or Read and Write, Vibe temporarily accesses the first node in
the list, even though it is set to No Access. This functionality is required because you cannot log in to
the Vibe site without access to a Lucene Index Server.

Synchronizing a High Availability Lucene
Configuration

You should ensure that your Lucene node servers remain in sync with each other. Whenever a
Lucene node is down for a relatively short period of time (no more than one or two days), you can
synchronize it with other Lucene nodes whose index files are up-to-date.

1 Ensure that the out-of-date Lucene node is running reliably again.

2 Log in to the Micro Focus Vibe site as the Vibe administrator.

3 Click your linked name in the upper right corner of the page, then click the Administration

Consoleicon * .

4 Under Search Index, click Nodes.
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5 To repair the out-of-date Lucene node, select Apply Deferred Update Log Records to the Index,
then click Apply.

The Deferred Update Log options disappear if the update is successful. If for some reason the
deferred update log records cannot be applied to the index, you can rebuild the index, as
described in “Rebuilding the Lucene Index” in “Site Maintenance” in the Micro Focus Vibe 4.0.4
Administration Guide.

6 Click Close.
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Running Multiple Database Servers

Each of the four databases supported by Micro Focus Vibe (MySQL, MariaDB, Microsoft SQL,
Oracle, and PostgreSQL) has its own approach to clustering the database server. Information about
clustering database servers is available on the Internet, for example:

*

*

*

MySQL Cluster (http://www.mysqgl.com/products/database/cluster)
MariaDB (https://mariadb.com/kb/en/mariadb/galera-cluster/)

SQL Server Clustering (http://www.sql-server-performance.com/articles/clustering/
clustering_intro_p1.aspx)

Oracle Real Application Clusters (http://www.oracle.com/technology/products/database/
clustering)

PostgreSQL High Availability (https://www.postgresql.org/docs/9.6/static/high-availability.html)

NOTE: We highly recommend that you follow the instructions in Part Ill, “Basic Installation,” on
page 49 before attempting a more complex Vibe configuration.
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I Upgrade

+ Chapter 23, “Upgrading From Novell Vibe 4.0 to Micro Focus Vibe 4.0.4,” on page 179
+ Chapter 24, “Upgrading From Novell Vibe 3.4 to Micro Focus Vibe 4.x,” on page 191

+ Chapter 25, “Upgrading From Novell Vibe 3.3 to Micro Focus Vibe 4.x,” on page 203

+ Chapter 26, “Upgrading to Novell Vibe 3.3 from Previous Versions,” on page 213

+ Chapter 27, “Updating the Operating System Where Vibe Is Running,” on page 215
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Upgrading From Novell Vibe 4.0 to Micro
Focus Vibe 4.0.4

This section describes how to upgrade from Novell Vibe 4.0 to Micro Focus Vibe 4.0.4. You can also
upgrade from Vibe 3.4. to Vibe 4.0.4, as described in Chapter 24, “Upgrading From Novell Vibe 3.4 to
Micro Focus Vibe 4.x,” on page 191.

IMPORTANT: If you have not yet upgraded to Vibe 3.3, upgrade to Vibe 3.3 as described in
Chapter 26, “Upgrading to Novell Vibe 3.3 from Previous Versions,” on page 213. You cannot
upgrade from a version prior to Vibe 3.3 to Vibe 4.0.

After you upgrade your Vibe system, ensure that you check the Vibe download site where you
downloaded the Vibe software for any hot patches that might be available.

+ “Understanding the Upgrade Process” on page 179

+ “Backing Up Vibe Data” on page 180

+ “Updating the Java Development Kit (JDK)” on page 180

+ ‘“Installing the Java Cryptography Extension (JCE)” on page 180
+ “Remote Lucene Index Server Upgrade” on page 180

+ “Upgrading the Vibe Software” on page 182

+ “Upgrading the Vibe Database from 4 to 4.0.4” on page 184

+ “Performing Post-Upgrade Tasks” on page 186

Understanding the Upgrade Process

During the upgrade from Novell Vibe 4.0 to Vibe 4.0.4, the following aspects of your Vibe system are
modified:

+ The software is upgraded from Vibe 4.0 to Vibe 4.0.4.
+ Abackup copy of your existing Vibe 4.0 installation is created in the following directory:

Linux: [ opt/novel | / t eani ng/ t eam ng- backup

Windows:  C:\ Program Fi | es\ Novel | \ Teani ng\ t eam ng- backup

If your original Vibe system began with version 1.0 (this version of Novell Vibe is called Novell
Teaming), the backup copy is located in the following directory:

Linux: /opt/icecore

Windows: C:\Program Files\icecore

Upgrading From Novell Vibe 4.0 to Micro Focus Vibe 4.0.4 179



180

Backing Up Vibe Data

Ensure that your Vibe data is backed up before you begin the upgrade process. For information about
the data that needs to be backed up, see “Backing Up Vibe Data” in the Micro Focus Vibe 4.0.4
Administration Guide.

Because of significant changes to the database schema, Micro Focus recommends that you use your
database backup software to back up your Vibe database before upgrading to Vibe 4.0.4.

Updating the Java Development Kit (JDK)

Vibe 4.0.4 requires the latest version of the IBM or Oracle JDK.

Before you begin the upgrade process, update to the latest JDK, as described in “Java Development
Kit (JDK)” on page 231.

Installing the Java Cryptography Extension (JCE)

Vibe 4.0.4 requires that you also install the Java Cryptography Extension (JCE) in addition to the JDK
on each server in your Vibe system. (This was not a requirement in Vibe 3.4 HP1 and eatrlier.)

Before you begin the upgrade process, install the JCE on each server in your Vibe system, as
described in “Java Cryptography Extension (JCE)” on page 232.

Remote Lucene Index Server Upgrade

IMPORTANT: If your Lucene search index is running on the same server as the Vibe software, you
do not need to upgrade it separately. Skip to “Upgrading the Vibe Software” on page 194.

You have the following options when upgrading your remote Lucene search index to Vibe 4.0.4:
+ Create a new search index

Because a full re-index is required after upgrading to Vibe 4.0.4, creating a new search index is
less time-consuming than upgrading your existing search index. The benefit to creating a new
Lucene search index is that you are able to maintain the original search index in the unlikely
case of an emergency rollback.

+ Upgrade your existing Lucene search index

If you choose to upgrade your existing Lucene search index, you must perform a re-index after
the upgrade, as described in “Resetting the Search Index” on page 198.

These options are described in the following sections:

+ “Creating a New Search Index” on page 180
+ “Upgrading an Existing Search Index” on page 181

Creating a New Search Index

1 Stop Vibe.
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Linux: On the Vibe server, specify the following command:
letc/init.d/teani ng stop

Windows:  See “Stopping Vibe as an Application” on page 88.

2 Stop the Lucene search index.
On the Lucene index server, specify the following command:

Linux: letc/init.dlindexserver stop

Windows: c:\Program
Fi I es\ Novel | \ Team ng\ | uceneserver\i ndexserver\ bi n\i ndexserver -
shut down. bat

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe4.0 system.

4 On a different server than where your original search index was running, create a new search
index, as described in “Installing the Lucene Software” on page 145.

Upgrading an Existing Search Index

The Vibe installation program cannot upgrade the Lucene search index when it is running on a
remote server. To upgrade your remote search index from Novell Vibe 4.0 to Micro Focus Vibe 4.0.4,
you need to run the Remote Lucene Server installation program:

1 Stop Vibe.

Linux: On the Vibe server, specify the following command:
letc/init.d/teanmi ng stop

Windows:  See “Stopping Vibe as an Application” on page 88.

2 Stop the Lucene search index.

On the Lucene index server, specify the following command:

Linux: letc/init.dlindexserver stop

Windows: c:\Program
Fi I es\ Novel | \ Team ng\ | uceneserver\indexserver\ bi n\i ndexserver -
shut down. bat

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 4.0 system.

4 Copy the Vibe 4.0.4 Remote Lucene Server Installation program from the directory where the
Vibe 4.0.4 Installation program is located to a convenient directory on the server where the
remote Lucene search index is located.

The name of the Remote Lucene Server Installation program varies by platform:
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© 00 N o O

10
11
12

13
14
15

16

17

18

Linux: | ucene-installer.!linux

Windows: | ucene-installer.exe

Start the Vibe 4.0.4 Remote Lucene Server installation program.

Accept the License Agreement, then click Next.

Select Update software and settings.

Click Next to continue.

Click Next to accept the installation location.

Click Next to accept the Java JDK location.

In the Host field, specify the hostname where you are installing the remote Lucene Index Server.
Change Lucene configuration settings as needed, then click Next.

For information about Lucene configuration settings, see “Changing Lucene Configuration
Settings” on page 108.

Click Install to install the upgraded Lucene search index software.
Click Finish when the upgrade is complete.

(Conditional) If memcached is running on the Lucene search index server, reboot the server
where it is running to ensure that the 4 cache is cleared.

Start the Lucene Index Server.
On the Lucene index server, specify the following command:

Linux: /etc/init.d/indexserver start

Windows: c:\Program
Fi I es\ Novel | \ Team ng\ | uceneserver\indexserver\ bi n\i ndexserver -
startup. bat

Ensure that the index server is running.
/etc/init.d/indexserver status

Now that all remote Vibe components have been upgraded, follow the instructions in “Upgrading
the Vibe Software” on page 182.

Upgrading the Vibe Software

Complete the following steps for each server in your Vibe system that is running the Vibe software:

1
2

3

Ensure that you have a current backup of your Vibe 4.0 system.
Stop Vibe.

Linux: On the Vibe server, specify the following command:
letc/init.d/ teanm ng stop
Windows:  See “Stopping Vibe as an Application” on page 88.

Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 4.0 system.
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Copy the i nstal I er. xm file from the directory where the Vibe 4 Installation program is located
to the directory where you have extracted the Vibe 4.0.4 software.

Theinstaller.xm file provides default values when you run the Vibe 4 Installation program.

Copy the | i cense-key. xnl file from the directory where the Vibe 4 Installation program is
located to the directory where you have extracted the Vibe 4.0.4 software.

Alternatively, you can obtain a new license key (*. xm ) from the location where you downloaded
the Vibe 4.0.4 software, copy it to the directory containing the extracted Vibe 4.0.4 software, and
rename itto | i cense- key. xm .

Start the Vibe 4.0.4 installation program.

If you need assistance with this task, see the detailed installation instructions for the platform
where you are upgrading Vibe:

¢ “Running the Linux Vibe Installation Program” on page 72
+ “Running the Windows Vibe Installation Program” on page 83

Accept the License Agreement, then click Next.

Novell Vibe 4 Installation Program = X
Installation Options
Select the action you want to perferm. N
" New installation
* Update software and settings
" Recenfigure settings

Because you provided your Vibe 4 i nstal | er. xm file in the directory with the Vibe 4.0.4
installation program, the Update software and settings installation option is selected by default.

8 Click Next to continue.

9 Click Yes to let the Installation program know that you have stopped Vibe.

10

11

12

13
14
15

16

Select the check box to let the installation program know that you have backed up all of your
data, then click Next.

Select Basic or Advanced, depending on the type of Vibe installation you are upgrading, then
click Next.

For more information about the differences between basic and advanced installations, see “What
Is a Basic Vibe Installation?” on page 51 and “What Is an Advanced Installation?” on page 103.

Continue through the installation process, retaining or changing configuration information
depending on the needs of your Vibe 4.0.4 system.

Click Install when you are ready to perform the upgrade.
Click Finish when the upgrade is complete.

(Conditional) If memcached is running on the Vibe server, reboot the server to ensure that the
cache is cleared.

Continue with “Upgrading the Vibe Database from 4 to 4.0.4” on page 184.
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Upgrading the Vibe Database from 4 to 4.0.4

Upgrade the Vibe software (as described in “Upgrading the Vibe Software” on page 182) before
upgrading the Vibe database.

When you upgrade to Vibe 4.0.4, the Vibe Installation program does not update the database as part
of the Vibe software upgrade. Therefore, you must manually update the database before you can
start Vibe:

1 (Conditional) When upgrading a MySQL database, ensure that the Vibe database character set
for the Vibe system is in UTF-8 format.
la To view the character set format, run the following command:

SELECT default_character_set _nane FROM i nf ormati on_scherma. SCHEMATA S WHERE
schema_nanme = 'sitescape';

In this command si t escape is the name of the Vibe database. Replace si t escape with the
name of your database.

1b If the character set format is anything other than UTF-8, run the following command to
change it:

In the following command, si t escape is the name of the Vibe database. Replace
si t escape with the name of your database.

ALTER DATABASE sit escape CHARACTER SET utf 8;
2 Change to the db directory in the Vibe installation:
cd /vibe_installation/temp-installer/db
This directory contains the following properties files:
* nysql -1iqui base. properties
¢ Oracle-liquibase. properties
* sql server-1liqui base. properties

3 In a text editor, open the properties file that corresponds with your database type and make the
applicable changes in both the Dri ver and r ef erenceDri ver sections. Save and close the text
editor when you are finished making changes.

+ Change the database user name and password for accessing the database.
+ (Conditional) Specify the IP address for the database if it is running on a remote server.
You need to replace | ocal host with the IP address of the remote server.

+ (Optional) Change the name of the Vibe database (the default name of the Vibe database is
si t escape, the name of the company that previously developed the Vibe software).

4 Save your changes and close the properties file.

5 In the same directory (/ vi be_i nstal | ati on/t enp-i nstal | er/ db), execute the following
commands to update the database schema:
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Windows  SET PATH=C:\path_to_java_used_by_vi be\ bi n; %ATH%
manage- dat abase. bat dat abase_t ype updat eDat abase

Possible database types (dat abaseType) are nysql , or acl e, or sql ser ver, depending on
your type of database.

Linux PATH=/ pat h_t o_j ava_used_by_vi be/ bi n: $PATH
./ manage- dat abase. sh dat abase_t ype updat eDat abase

Possible database types (dat abaseType) are nmysql , or acl e, or sql ser ver, depending on
your type of database.

NOTE: Ensure that the nanage- dat abase. sh file is executable.

NOTE: You can safely ignore the following Liquibase log messages:

* Warning: nodifyDataType will [ose primary key/autoincrenent/not null
settings for nysql

+ Any messages that contain the words i nfo: failureorinfo: failed, aslong as they
are associated with a type | NFOmessage

6 Start Vibe 4.0.4 in the same way that you have been starting Vibe 4.

When you start Vibe for the first time after the upgrade, it takes longer to start than usual
because data in the Vibe database must be upgraded before the Vibe site is ready to use.

Linux: On the Vibe server, specify the following command:
letc/init.d/teami ng start

Windows:  See “Starting Vibe as an Application” on page 88.
or
See “Starting Vibe as a Windows Service” on page 87.

NOTE: If you have been starting Vibe as a Windows service, you need to delete your
existing Windows service configuration and re-configure Vibe as a Windows service before
you can start Vibe. For information about how to configure Vibe as a Windows service, see
“Configuring Vibe as a Windows Service” on page 87.

7 (Recommended) For security reasons, delete the password that you specified in Step 7 in
“Creating the Vibe Database” on page 75.

7a Change to the db directory in the Vibe installation:
cd /vibe_installation/tenmp-installer/db
This directory contains the following properties files:
* nysql -liqui base. properties
¢ Oacle-liquibase. properties
¢ sql server-1|iqui base. properties

7b In a text editor, open the dat abase_t ype-|i qui base. properti es file that corresponds
with your database type, then delete the password.

7c Save and close the properties file.

8 Continue with “Performing Post-Upgrade Tasks” on page 198.
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Performing Post-Upgrade Tasks

After you start Micro Focus Vibe, you can access your Vibe site as usual. However, you need to reset
some aspects of the interface before you allow users to access the upgraded site. The interface reset
affects only those definitions and templates that are included with the Vibe product. If you have
created custom definitions and templates, they are unaffected by the interface reset.

+ “Re-Installing the Windows Service” on page 186

+ “Resetting the Search Index” on page 186

+ “Resetting the Standard Templates” on page 187

+ “Resetting Your Definitions” on page 188

¢ “Updating the Server.xml File When Using Secure HTTP” on page 189

Re-Installing the Windows Service

If you installed Vibe as a Windows service (as described in “Running Vibe as a Windows Service” on
page 86), you must do the following by using the instructions in the same section.

1. Remove the service as described in “Removing Vibe as a Windows Service” on page 87.

2. Re-install the service as described in “Configuring Vibe as a Windows Service” on page 87.

This is necessary because the original service references an unsupported version of Tomcat.

Resetting the Search Index

In order for an upgraded search index to be compatible with Vibe 4.0.4, you need to re-index the
search index. Until you reset the search index, the search index and the vibe server are not in a
compatible state. The cat al i na. out and appser ver. | og files show errors until the search index is
reset.

The steps to reset the search index differ depending on whether you have multiple Lucene Index
servers. For more information about multiple search indexes, see Chapter 21, “Running Multiple
Lucene Index Servers,” on page 157.

Depending on the size of your Vibe site, this can be a very time-consuming process.

+ “Resetting a Single Search Index” on page 186
+ “Resetting the Search Index with Multiple Index Servers” on page 187

Resetting a Single Search Index

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,

3 Inthe Management section, click Search Index.

4 Select Re-Index Everything.

5 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.
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6 After the index server has been reset, ensure that no errors are contained in the following log

files:
Windows: ¢ C. \Program Fi |l es\ Novel |\ Team ng\ apache-tontat\| ogs\cat al i na. out
¢ C \Program Fil es\ Novel |\ Teani ng\ apache-tontat\| ogs\ appserver. | og
Linux: ¢ /opt/novel | /team ng/ apache-tontat/| ogs/catal i na. out

*

/ opt/novel | / team ng/ apache-tontat/| ogs/ appserver. | og

Resetting the Search Index with Multiple Index Servers

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Consoleicon '+,

3 In the Search Index section, click Index.

4 Select Re-Index Everything.

5 Select each node that you want to re-index.

6 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.
7 After the index server has been reset, ensure that no errors are contained in the following log

files:
Windows: ¢ C\Program Fil es\ Novel I \ Teani ng\ apache-t ontat\| ogs\ cat al i na. out
¢ C.\Program Fil es\ Novel |\ Teani ng\ apache-t ontat\| ogs\ appserver. | og
Linux: + /opt/novel | /team ng/ apache-toncat/| ogs/ catal i na. out

* /opt/novel | /team ng/ apache-tontat/| ogs/ appserver.| og

Resetting the Standard Templates

IMPORTANT: The following procedure deletes any custom maodifications that you have previously
made to the default Vibe templates. If you have manually customized any default Vibe templates,
back up the files you have modified before performing the interface reset. This applies only to default
templates that you have modified; templates that you have created are not affected.

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,

3 In the Management section, click Workspace and Folder Templates.
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Workspace and Folder Templates

Mew - Reset Import Export

Standard Templates

Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

Blog - A blog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created. Blogs typically pro
larger group can make comments on the entries posted by the original author.

Calendar - A calendar folder is a place to post group events or display other types of entries by date.

Guestbook - A guestbook folder is a simple place that individuals can "sign,” indicating that they have visited a user's Personal Workspace. Visitors ms
A picture of the individual signing the guestbook is displayed with the comment. The guestbook is useful for expanding users’ social networks.

Files - Afile folderis a place to put files. Comments or entire discussio_ns can be posted about individual files. Additionally, the files can be automatical

user to add and delete files via any WebDAY client, such as the MS Windows File Manager.

Milestones - A milestone folder is used to roll up or summarize activity in one or more Task folders.

Micro-Blog - A micro-blog folder is a special folder that gets created automatically for each user. Itis intended to contain short text entries only. Each us
one that is created automatically will be accessed as the user's real micro-blog.

Mirrored Files - A mirrored file folder is a special type of file folderwhere it uses a server file system directory as its file storage area instead of the nom
knowledge about the folder contents in synch with whatever is in the directory. The mirrored folder feature can mirror any WebDAV or local file path.

4 Click Reset.
5 Click OK to confirm, then click Close.

Your Vibe site is now ready for use.

Resetting Your Definitions

Various aspects of the Vibe interface have been redesigned and enhanced since Vibe 4. Some of
these enhancements affect entries, folders, user profiles, and user workspaces. If you have made
customizations to these areas of Vibe, you must reset these definitions in order to see the
enhancements, as described in this section.

WARNING: The following procedure deletes any custom modifications that you have previously
made to the default Vibe definitions. If you want to save any modified definitions before proceeding,
you can export the modified definitions. Also, you might want to document exactly what changes you
have made in order to make it easier to reconstruct the definition after you reset it. This applies only
to definitions that you have modified; definitions that you have created are not affected.

To reset your Vibe definitions:

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Consoleicon *,
In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.
The Reset Definitions page is displayed.
5 Click Select All.
You can expand each definition to ensure that all definitions have been selected.
6 Click OK.
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Updating the Server.xml File When Using Secure HTTP

The server. xnm Tomcat configuration file (apache-t ontat -1 ocati on/ conf/server. xm ) is
overwritten during the upgrade to Vibe 4.0.4. If you set up secure HTTP browser connections to the
Vibe server, and if you changed the password for the . keyst or e file to something other than the
default changei t, you need to update the server. xnl file after upgrading Vibe.

For information about how to update the . keyst or e password in the server. xm file, see “Do Not
Change the Password for the Keystore File” in the Micro Focus Vibe 4.0.4 Administration Guide.
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Upgrading From Novell Vibe 3.4 to Micro
Focus Vibe 4.x

This section describes how to upgrade from Novell Vibe 3.4 to Micro Focus Vibe 4.x. You can also
upgrade from Vibe 3.3 to Vibe 4, as described in Chapter 25, “Upgrading From Novell Vibe 3.3 to
Micro Focus Vibe 4.x,” on page 203. If you have not yet upgraded to Vibe 3.3, upgrade to Vibe 3.3 as
described in Chapter 26, “Upgrading to Novell Vibe 3.3 from Previous Versions,” on page 213. You
cannot upgrade from a version prior to Vibe 3.3 to Vibe 4.

After you upgrade your Vibe system, ensure that you check the Vibe download site where you
downloaded the Vibe software for any hot patches that might be available.

¢ “Understanding the Upgrade Process” on page 191

+ “Backing Up Vibe Data” on page 192

+ “Updating the Java Development Kit (JDK)” on page 192

+ “Installing the Java Cryptography Extension (JCE)” on page 192
+ “Remote Lucene Index Server Upgrade” on page 192

+ “Upgrading the Vibe Software” on page 194

+ “Upgrading the Vibe Database from 3.4 to 4” on page 196

+ “Performing Post-Upgrade Tasks” on page 198

Understanding the Upgrade Process

During the upgrade from Novell Vibe 3.4 to Vibe 4, the following aspects of your Vibe system are
modified:

+ The software is upgraded from Vibe 3.4 to Vibe 4.
+ Abackup copy of your existing Vibe 3.4 installation is created in the following directory:

Linux: / opt/novel | / t eanmi ng/t eam ng- backup

Windows: C:\Program Fi | es\ Novel I \ Team ng\ t eam ng- backup

If your original Vibe system began with version 1.0 (this version of Novell Vibe is called Novell
Teaming), the backup copy is located in the following directory:

Linux: /opt/icecore

Windows: C:\Program Fil es\icecore
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Backing Up Vibe Data

Ensure that your Vibe data is backed up before you begin the upgrade process. For information about
the data that needs to be backed up, see “Backing Up Vibe Data” in the Micro Focus Vibe 4.0.4
Administration Guide.

Because of significant changes to the database schema, Micro Focus recommends that you use your
database backup software to back up your Vibe database before upgrading to Vibe 4.

Updating the Java Development Kit (JDK)

Vibe 4 requires the latest version of the IBM or Oracle JDK.

Before you begin the upgrade process, update to the latest JDK, as described in “Java Development
Kit (JDK)” on page 231.

Installing the Java Cryptography Extension (JCE)

Vibe 4 requires that you also install the Java Cryptography Extension (JCE) in addition to the JDK on
each server in your Vibe system. (This was not a requirement in Vibe 3.4 and earlier.)

Before you begin the upgrade process, install the JCE on each server in your Vibe system, as
described in “Java Cryptography Extension (JCE)” on page 232.

Remote Lucene Index Server Upgrade

IMPORTANT: If your Lucene search index is running on the same server as the Vibe software, you
do not need to upgrade it separately. Skip to “Upgrading the Vibe Software” on page 194.

You have the following options when upgrading your remote Lucene search index to Vibe 4;
+ Create a new search index

Because a full re-index is required after upgrading to Vibe 4, creating a new search index is less
time-consuming than upgrading your existing search index. The benefit to creating a new
Lucene search index is that you are able to maintain the original search index in the unlikely
case of an emergency rollback.

+ Upgrade your existing Lucene search index

If you choose to upgrade your existing Lucene search index, you must perform a re-index after
the upgrade, as described in “Resetting the Search Index” on page 198.

These options are described in the following sections:

+ “Creating a New Search Index” on page 192
+ “Upgrading an Existing Search Index” on page 193

Creating a New Search Index

1 Stop Vibe.
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Linux: On the Vibe server, specify the following command:
letc/init.d/teani ng stop

Windows:  See “Stopping Vibe as an Application” on page 88.

2 Stop the Lucene search index.
On the Lucene index server, specify the following command:

Linux: letc/init.dlindexserver stop

Windows: c:\Program
Fi I es\ Novel | \ Team ng\ | uceneserver\i ndexserver\ bi n\i ndexserver -
shut down. bat

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.4 system.

4 On a different server than where your original search index was running, create a new search
index, as described in “Installing the Lucene Software” on page 145.

Upgrading an Existing Search Index

The Vibe installation program cannot upgrade the Lucene search index when it is running on a
remote server. To upgrade your remote search index from Novell Vibe 3.4 to Novell Vibe 4, you need
to run the Remote Lucene Server installation program:

1 Stop Vibe.

Linux: On the Vibe server, specify the following command:
letc/init.d/teanmi ng stop

Windows:  See “Stopping Vibe as an Application” on page 88.

2 Stop the Lucene search index.

On the Lucene index server, specify the following command:

Linux: letc/init.dlindexserver stop

Windows: c:\Program
Fi I es\ Novel | \ Team ng\ | uceneserver\indexserver\ bi n\i ndexserver -
shut down. bat

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.4 system.

4 Copy the Vibe 4 Remote Lucene Server Installation program from the directory where the Vibe 4
Installation program is located to a convenient directory on the server where the remote Lucene
search index is located.

The name of the Remote Lucene Server Installation program varies by platform:
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Linux: | ucene-installer.!linux

Windows: | ucene-installer.exe

Start the Vibe 4 Remote Lucene Server installation program.

Accept the License Agreement, then click Next.

Select Update software and settings.

Click Next to continue.

Click Next to accept the installation location.

Click Next to accept the Java JDK location.

In the Host field, specify the hostname where you are installing the remote Lucene Index Server.
Change Lucene configuration settings as needed, then click Next.

For information about Lucene configuration settings, see “Changing Lucene Configuration
Settings” on page 108.

Click Install to install the upgraded Lucene search index software.
Click Finish when the upgrade is complete.

(Conditional) If memcached is running on the Lucene search index server, reboot the server
where it is running to ensure that the 3.4 cache is cleared.

Start the Lucene Index Server.
On the Lucene index server, specify the following command:

Linux: /etc/init.d/indexserver start

Windows: c:\Program
Fi I es\ Novel | \ Team ng\ | uceneserver\indexserver\ bi n\i ndexserver -
startup. bat

Ensure that the index server is running.
/etc/init.d/indexserver status

Now that all remote Vibe components have been upgraded, follow the instructions in “Upgrading
the Vibe Software” on page 194.

Upgrading the Vibe Software

Complete the following steps for each server in your Vibe system that is running the Vibe software:

1
2

3

Ensure that you have a current backup of your Vibe 3.4 system.
Stop Vibe.

Linux: On the Vibe server, specify the following command:
letc/init.d/ teanm ng stop
Windows:  See “Stopping Vibe as an Application” on page 88.

Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.4 system.
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Copy the i nstal | er. xnl file from the directory where the Vibe 3.4 Installation program is
located to the directory where you have extracted the Vibe 4 software.

Theinstaller.xm file provides default values when you run the Vibe 3.4 Installation program.

Obtain a new license key from the location where you downloaded the Vibe 4 software, then
place it in the same directory with the Vibe software. (The Vibe installation program does not
start without a license file in the same directory.) Rename the license to | i cense- key. xmi .

Vibe 4 requires an updated license. If you use a license from a previous version, not all features
are available.

Start the Vibe 4 installation program.

If you need assistance with this task, see the detailed installation instructions for the platform
where you are upgrading Vibe:

¢ “Running the Linux Vibe Installation Program” on page 72
+ “Running the Windows Vibe Installation Program” on page 83

Accept the License Agreement, then click Next.

Novell Vibe 4 Installation Program = X
Installation Options
Select the action you want to perferm. N
" New installation
* Update software and settings
" Recenfigure settings

Because you provided your Vibe 3.4 i nstal | er. xnm file in the directory with the Vibe 4
installation program, the Update software and settings installation option is selected by default.

8 Click Next to continue.

9 Click Yes to let the Installation program know that you have stopped Vibe.

10

11

12

13
14
15

16

Select the check box to let the installation program know that you have backed up all of your
data, then click Next.

Select Basic or Advanced, depending on the type of Vibe installation you are upgrading, then
click Next.

For more information about the differences between basic and advanced installations, see “What
Is a Basic Vibe Installation?” on page 51 and “What Is an Advanced Installation?” on page 103.

Continue through the installation process, retaining or changing configuration information
depending on the needs of your Vibe 4 system.

Click Install when you are ready to perform the upgrade.
Click Finish when the upgrade is complete.

(Conditional) If memcached is running on the Vibe server, reboot the server to ensure that the
3.4 cache is cleared.

Continue with “Upgrading the Vibe Database from 3.4 to 4” on page 196.
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Upgrading the Vibe Database from 3.4 to 4

Upgrade the Vibe software (as described in “Upgrading the Vibe Software” on page 206) before
upgrading the Vibe database.

When you upgrade to Vibe 4, the Vibe Installation program does not update the database as part of
the Vibe software upgrade. Therefore, you must manually update the database before you can start
Vibe:

1 (Conditional) When upgrading a MySQL database, ensure that the Vibe database character set
for the Vibe 3.4 system is in UTF-8 format.
la To view the character set format, run the following command:

SELECT default_character_set _nane FROM i nf ormati on_scherma. SCHEMATA S WHERE
schema_nanme = 'sitescape';

In this command si t escape is the name of the Vibe database. Replace si t escape with the
name of your database.

1b If the character set format is anything other than UTF-8, run the following command to
change it:

In the following command, si t escape is the name of the Vibe database. Replace
si t escape with the name of your database.

ALTER DATABASE sit escape CHARACTER SET utf 8;
2 Change to the db directory in the Vibe installation:
cd /vibe_installation/temp-installer/db
This directory contains the following properties files:
* nysql -1iqui base. properties
¢ Oracle-liquibase. properties
* sql server-1liqui base. properties

3 In a text editor, open the properties file that corresponds with your database type and make the
applicable changes in both the Dri ver and r ef erenceDri ver sections. Save and close the text
editor when you are finished making changes.

+ Change the database user name and password for accessing the database.
+ (Conditional) Specify the IP address for the database if it is running on a remote server.
You need to replace | ocal host with the IP address of the remote server.

+ (Optional) Change the name of the Vibe database (the default name of the Vibe database is
si t escape, the name of the company that previously developed the Vibe software).

4 Save your changes and close the properties file.

5 In the same directory (/ vi be_i nstal | ati on/t enp-i nstal | er/ db), execute the following
commands to update the database schema:
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Windows nanage- dat abase. bat dat abaseType mar k33Dat abaseAsUpdat ed
manage- dat abase. bat dat abaseType updat eDat abase

Possible database types (dat abaseType) are nysql , or acl e, or sql ser ver, depending on
your type of database.

Linux ./ manage- dat abase. sh dat abaseType nar k33Dat abaseAsUpdat ed
./ manage- dat abase. sh dat abaseType updat eDat abase

Possible database types (dat abaseType) are nmysql , or acl e, or sql ser ver, depending on
your type of database.

NOTE: Ensure that the nanage- dat abase. sh file is executable.

NOTE: You can safely ignore the following Liquibase log messages:

* Warning: nodifyDataType will [ose primary key/autoincrenent/not null
settings for nysql

+ Any messages that contain the words i nfo: failureorinfo: failed, aslong as they
are associated with a type | NFOmessage

6 Start Vibe 4 in the same way that you have been starting Vibe 3.4.

When you start Vibe for the first time after the upgrade, it takes longer to start than usual
because data in the Vibe database must be upgraded before the Vibe site is ready to use.

Linux: On the Vibe server, specify the following command:
letc/init.d/teami ng start

Windows:  See “Starting Vibe as an Application” on page 88.
or
See “Starting Vibe as a Windows Service” on page 87.

NOTE: If you have been starting Vibe as a Windows service, you need to delete your
existing Windows service configuration and re-configure Vibe as a Windows service before
you can start Vibe. For information about how to configure Vibe as a Windows service, see
“Configuring Vibe as a Windows Service” on page 87.

7 (Recommended) For security reasons, delete the password that you specified in Step 7 in
“Creating the Vibe Database” on page 75.

7a Change to the db directory in the Vibe installation:
cd /vibe_installation/tenmp-installer/db
This directory contains the following properties files:
* nysql -liqui base. properties
¢ Oacle-liquibase. properties
¢ sql server-1|iqui base. properties

7b In a text editor, open the dat abase_t ype-|i qui base. properti es file that corresponds
with your database type, then delete the password.

7c Save and close the properties file.

8 Continue with “Performing Post-Upgrade Tasks” on page 198.
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Performing Post-Upgrade Tasks

After you start Micro Focus Vibe 4, you can access your Vibe site as usual. However, you need to
reset some aspects of the interface before you allow users to access the upgraded site. The interface
reset affects only those definitions and templates that are included with the Vibe product. If you have
created custom definitions and templates, they are unaffected by the interface reset.

+ “Resetting the Search Index” on page 198

+ “Resetting Your Definitions” on page 199

+ “Resetting the Standard Templates” on page 200

+ “Updating the Vibe License” on page 200

+ “Re-Installing the Windows Service” on page 200

+ “Updating the Server.xml File When Using Secure HTTP” on page 201

Resetting the Search Index

In order for an upgraded search index to be compatible with Vibe 4, you need to re-index the search
index. Until you reset the search index, the search index and the vibe server are not in a compatible
state. The cat al i na. out and appser ver. | og files show errors until the search index is reset.

The steps to reset the search index differ depending on whether you have multiple Lucene Index
servers. For more information about multiple search indexes, see Chapter 21, “Running Multiple
Lucene Index Servers,” on page 157.

Depending on the size of your Vibe site, this can be a very time-consuming process.

+ “Resetting a Single Search Index” on page 198

+ “Resetting the Search Index with Multiple Index Servers” on page 199

Resetting a Single Search Index

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Consoleicon '+,

3 Inthe Management section, click Search Index.

4 Select Re-Index Everything.

5 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.

6 After the index server has been reset, ensure that no errors are contained in the following log

files:
Windows: ¢ C. \Program Fi |l es\ Novel I\ Team ng\ apache-tontat\| ogs\cat al i na. out
¢ C. \Program Fi |l es\ Novel |\ Teani ng\ apache-tontat\| ogs\ appserver. | og
Linux: ¢ /opt/novel | /team ng/ apache-tontat/| ogs/catal i na. out

+ /opt/novel | /team ng/ apache-tontat/| ogs/ appserver. | og
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Resetting the Search Index with Multiple Index Servers

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Consoleicon '+,

3 In the Search Index section, click Index.

4 Select Re-Index Everything.

5 Select each node that you want to re-index.

6 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.
7 After the index server has been reset, ensure that no errors are contained in the following log

files:
Windows: ¢ C \Program Fil es\ Novel I\ Teani ng\ apache-tontat\| ogs\ cat al i na. out
¢ C\Program Fil es\ Novel |\ Teani ng\ apache-t ontat\| ogs\ appserver. | og
Linux: + /opt/novel | /team ng/ apache-toncat/| ogs/ catal i na. out

+ /opt/novel | /team ng/ apache-tontat/| ogs/ appserver.| og

Resetting Your Definitions

Various aspects of the Vibe interface have been redesigned and enhanced since Vibe 3.4. Some of
these enhancements affect entries, folders, user profiles, and user workspaces. If you have made
customizations to these areas of Vibe, you must reset these definitions in order to see the
enhancements, as described in this section.

WARNING: The following procedure deletes any custom modifications that you have previously
made to the default Vibe definitions. If you want to save any modified definitions before proceeding,
you can export the modified definitions. Also, you might want to document exactly what changes you
have made in order to make it easier to reconstruct the definition after you reset it. This applies only
to definitions that you have modified; definitions that you have created are not affected.

To reset your Vibe definitions:

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,
3 Inthe System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.
The Reset Definitions page is displayed.
5 Click Select All.
You can expand each definition to ensure that all definitions have been selected.
6 Click OK.
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Resetting the Standard Templates

IMPORTANT: The following procedure deletes any custom modifications that you have previously
made to the default Vibe templates. If you have manually customized any default Vibe templates,
back up the files you have modified before performing the interface reset. This applies only to default
templates that you have modified; templates that you have created are not affected.

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration

Consoleicon * .

3 Inthe Management section, click Workspace and Folder Templates.

Workspace and Folder Templates
New - Reset Import Export

Standard Templates

Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

Blog - A blog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created. Blogs typically pro
larger group can make comments on the entries posted by the original author.

Calendar - A calendar folder is a place to post group events or display other types of entries by date.

Guestbook - A guestbook folder is a simple place that individuals can "sign,” indicating that they have visited a user's Personal Workspace. Visitors ms
A picture of the individual signing the guestbook is displayed with the comment. The guestbook is useful for expanding users’ social networks.

Files - Afile folder is a place to put files. Comments or entire discussions can be posted about individual files. Additionally, the files can be automatical
user to add and delete files via any WebDAY client, such as the MS Windows File Manager.

Milestones - A milestone folder is used to roll up or summarize activity in one or more Task folders.

Micro-Blog - A micro-blog folder is a special folder that gets created automatically for each user. Itis intended to contain short text entries only. Each us
one that is created automatically will be accessed as the user's real micro-blog.

Mirrored Files - A mirrored file folder is a special type of file folderwhere it uses a server file system directory as its file storage area instead of the nom
knowledge about the folder contents in synch with whatever is in the directory. The mirrored folder feature can mirror any WebDAV or local file path.

4 Click Reset,
5 Click OK to confirm, then click Close.

Your Vibe 4 site is now ready for use.

Updating the Vibe License

After upgrading to Vibe 4, you need to update the Vibe license, as described in Chapter 11, “Updating
Your Vibe License,” on page 91.

Re-Installing the Windows Service

If you installed Vibe as a Windows service (as described in “Running Vibe as a Windows Service” on
page 86), you must remove the service and re-install it. This is necessary because the original
service references an unsupported version of Tomcat.
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Updating the Server.xml File When Using Secure HTTP

The server. xnm Tomcat configuration file is overwritten during the upgrade to Vibe 4. If you set up
secure HTTP browser connections to the Vibe server, and if you changed the password for the

. keyst or e file to something other than the default changei t , you need to update the ser ver. xni file
after upgrading to Vibe 4.

For information about how to update the . keyst or e password in the server. xm file, see “Do Not
Change the Password for the Keystore File” in the Micro Focus Vibe 4.0.4 Administration Guide.
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Upgrading From Novell Vibe 3.3 to Micro
Focus Vibe 4.x

This section describes how to upgrade from Novell Vibe 3.3 to Micro Focus Vibe 4.x. You must
upgrade to Vibe 3.3 if you have not already, as described in Chapter 26, “Upgrading to Novell Vibe
3.3 from Previous Versions,” on page 213. You cannot upgrade from a version prior to Vibe 3.3 to
Vibe 4.

After you upgrade your Vibe system, ensure that you check the Vibe download site where you
downloaded the Vibe software for any hot patches that might be available.

+ “Understanding the Upgrade Process” on page 203

+ “Backing Up Vibe Data” on page 203

+ ‘“Installing the Java Cryptography Extension (JCE)” on page 204
+ “Remote Lucene Index Server Upgrade” on page 204

+ “Upgrading the Vibe Software” on page 206

+ “Updating the Vibe Database from 3.3 to 4” on page 207

+ “Performing Post-Upgrade Tasks” on page 209

Understanding the Upgrade Process

During the upgrade from Novell Vibe 3.3 to Vibe 4, the following aspects of your Vibe system are
modified:

+ The software is upgraded from Vibe 3.3 to Vibe 4.
+ Abackup copy of your existing Vibe 3.3 installation is created in the following directory:

Linux: [ opt/ novel | / t eam ng/t eam ng- backup

Windows: C:\Program Fi | es\ Novel I \ Team ng\ t eam ng- backup

If your original Vibe system began with version 1.0 (this version of Novell Vibe is called Novell
Teaming), the backup copy is located in the following directory:

Linux: /opt/icecore

Windows: C:\Program Fil es\icecore

Backing Up Vibe Data

Ensure that your Vibe data is backed up before you begin the upgrade process. For information about
the data that needs to be backed up, see “Backing Up Vibe Data” in the Micro Focus Vibe 4.0.4
Administration Guide.
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Installing the Java Cryptography Extension (JCE)

Vibe 4 requires that you also install the Java Cryptography Extension (JCE) in addition to the JDK on
each server in your Vibe system. (This was not a requirement in Vibe 3.4 and earlier.)

Before you begin the upgrade process, install the JCE on each server in your Vibe system, as
described in “Java Cryptography Extension (JCE)” on page 232.

Remote Lucene Index Server Upgrade

IMPORTANT: If your Lucene search index is running on the same server as the Vibe software, you
do not need to upgrade it separately. Skip to “Upgrading the Vibe Software” on page 206.

You have the following options when upgrading your remote Lucene search index to Vibe 4.

+ Create a new search index

Because a full re-index is required after upgrading to Vibe 4, creating a new search index is less
time-consuming than upgrading your existing search index. The benefit to creating a new
Lucene search index is that you are able maintain the original search index in the unlikely case
of an emergency rollback.

+ Upgrade your existing Lucene search index

If you choose to upgrade your existing Lucene search index, you must perform a re-index after
the upgrade, as described in “Resetting the Search Index” on page 198.

These options are described in the following sections:

+ “Creating a New Search Index” on page 204

+ “Upgrading an Existing Search Index” on page 205
Creating a New Search Index
1 Stop Vibe.
Linux: On the Vibe server, specify the following command:

letc/init.d/teanm ng stop

Windows:  See “Stopping Vibe as an Application” on page 88.

2 Stop the Lucene search index.
On the Lucene index server, specify the following command:

Linux: letc/init.dlindexserver stop

Windows: c:\Program

Fi | es\ Novel I\ Teanmi ng\ | uceneserver\indexserver\bi n\i ndexserver -
shut down. bat
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3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.3 system.

4 On a different server than where your original search index was running, create a new search
index, as described in “Installing the Lucene Software” on page 145.

Upgrading an Existing Search Index

The Vibe installation program cannot upgrade the Lucene search index when it is running on a
remote server. To upgrade your remote search index from Novell Vibe 3.3 to Micro Focus Vibe 4, you
need to run the Remote Lucene Server installation program:

1 Stop Vibe.

Linux: On the Vibe server, specify the following command:
letc/init.d/ team ng stop

Windows:  See “Stopping Vibe as an Application” on page 88.

2 Stop the Lucene search index.
On the Lucene index server, specify the following command:

Linux: letc/init.dlindexserver stop

Windows: c:\Program
Fi I es\ Novel | \ Team ng\ | uceneserver\i ndexserver\ bi n\i ndexser ver -
shut down. bat

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.3 system.

4 Copy the Vibe 4 Remote Lucene Server Installation program from the directory where the Vibe 4
Installation program is located to a convenient directory on the server where the remote Lucene
search index is located.

The name of the Remote Lucene Server Installation program varies by platform:

Linux: | ucene-installer.!linux

Windows: | ucene-installer.exe

Start the Vibe 4 Remote Lucene Server installation program.
Accept the License Agreement, then click Next.
Select Update software and settings.

Click Next to continue.

© 00 N o O

Click Next to accept the installation location.

10 Click Next to accept the Java JDK location.

11 In the Host field, specify the hostname where you are installing the remote Lucene Index Server.
12 Change Lucene configuration settings as needed, then click Next.

For information about Lucene configuration settings, see “Changing Lucene Configuration
Settings” on page 108.

13 Click Install to install the upgraded Lucene search index software.
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14
15

16

17

18

Click Finish when the upgrade is complete.

(Conditional) If memcached is running on the Lucene search index server, reboot the server
where it is running to ensure that the 3.3 cache is cleared.

Start the Lucene Index Server.
On the Lucene index server, specify the following command:

Linux: /etc/init.d/indexserver start

Windows: c:\Program
Fi I es\ Novel | \ Team ng\ | uceneserver\i ndexserver\ bi n\i ndexserver -
startup. bat

Ensure that the index server is running.
/etc/init.d/indexserver status

Now that all remote Vibe components have been upgraded, follow the instructions in “Upgrading
the Vibe Software” on page 206.

Upgrading the Vibe Software

N

Ensure that you have a current backup of your Vibe 3.3 system.
Stop Vibe.

Linux: On the Vibe server, specify the following command:
letc/init.d/teani ng stop

Windows:  See “Stopping Vibe as an Application” on page 88.

Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.3 system.

Copy theinstal | er. xm file from the directory where the Vibe 3.3 Installation program is
located to the directory where you have extracted the Vibe 4 software.

Theinstal l er.xm file provides default values when you run the Vibe 3.3 Installation program.

Obtain a new license key from the location where you downloaded the Vibe 4 software, then
place it in the same directory with the Vibe software. (The Vibe installation program does not
start without a license file in the same directory.) Rename the license to | i cense- key. xni .

Vibe 4 requires an updated license. If you use a license from a previous version, not all features
are available.

Start the Vibe 4 installation program.

If you need assistance with this task, see the detailed installation instructions for the platform
where you are upgrading Vibe:

+ “Running the Linux Vibe Installation Program” on page 72
+ “Running the Windows Vibe Installation Program” on page 83
Accept the License Agreement, then click Next.
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Novell Vibe 4 Installation Program = x

Installation Options

Select the action you want to perform.

" New Installation
i+ Update software and settings
" Reconfigure settings

Because you provided your Vibe 3.3 i nstal | er. xn file in the directory with the Vibe 4
installation program, the Update software and settings installation option is selected by default.

8 Click Next to continue.

9 Click Yes to let the Installation program know that you have stopped Vibe.

10

11

12

13
14
15

16

Select the check box to let the installation program know that you have backed up all of your
data, then click Next.

Select Basic or Advanced, depending on the type of Vibe installation you are upgrading, then
click Next.

For more information about the differences between basic and advanced installations, see “What
Is a Basic Vibe Installation?” on page 51 and “What Is an Advanced Installation?” on page 103.

Continue through the installation process, retaining or changing configuration information
depending on the needs of your Vibe 4 system.

Click Install when you are ready to perform the upgrade.
Click Finish when the upgrade is complete.

(Conditional) If memcached is running on the Vibe server, reboot the server to ensure that the
3.3 cache is cleared.

Continue with “Updating the Vibe Database from 3.3 to 4” on page 207.

Updating the Vibe Database from 3.3t0 4

Upgrade the Vibe software (as described in “Upgrading the Vibe Software” on page 206) before
upgrading the Vibe database.

When you upgrade to Vibe 4, the Vibe Installation program does not update the database as part of
the Vibe software upgrade. Therefore, you must manually update the database before you can start
Vibe:

1

(Conditional) When upgrading a MySQL database, ensure that the Vibe database character set
for the Vibe 3.4 system is in UTF-8 format.

la To view the character set format, run the following command:

In the following command, si t escape is the name of the Vibe database. Replace
si t escape with the name of your database.

SELECT default _character_set nane FROM i nfornati on_scherma. SCHEMATA S WHERE
schema_nanme = 'sitescape';

1b If the character set format is anything other than UTF-8, run the following command to
change it:
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ALTER DATABASE sitescape CHARACTER SET utf8;

In this command si t escape is the name of the Vibe database. Replace si t escape with the
name of your database.

2 Change to the db directory in the Vibe installation:

cd /vibe_installation/temp-installer/db
This directory contains the following properties files:
* nysql -1iqui base. properties
¢ Oracle-liquibase. properties
* sql server-1iqui base. properties

In a text editor, open the properties file that corresponds with your database type and make the
applicable changes in both the Dri ver and r ef erenceDri ver sections. Save and close the text
editor when you are finished making changes.

+ Change the database user name and password for accessing the database.
+ (Conditional) Specify the IP address for the database if it is running on a remote server.
You need to replace | ocal host with the IP address of the remote server.

+ (Optional) Change the name of the Vibe database (the default name of the Vibe database is
si t escape, the name of the company that previously developed the Vibe software).

Save your changes and close the properties file.

5 In the same directory (/ vi be_i nstal | ati on/tenp-installer/db), execute the following

commands to update the database schema:

Windows nanage- dat abase. bat dat abaseType mar k33Dat abaseAsUpdat ed
manage- dat abase. bat dat abaseType updat eDat abase

Possible database types (dat abaseType) are nysql , or acl e, or sqgl ser ver, depending on
your type of database.

Linux ./ manage- dat abase. sh dat abaseType nar k33Dat abaseAsUpdat ed
./ manage- dat abase. sh dat abaseType updat eDat abase

Possible database types (dat abaseType) are nysql , or acl e, or sql ser ver, depending on
your type of database.

NOTE: Ensure that the nanage- dat abase. sh file is executable.

NOTE: You can safely ignore the following Liquibase log messages:

* Warning: nodifyDataType will lose primary key/autoincrenent/not null
settings for nysql

+ Any messages that contain the words i nfo: failureorinfo: failed, aslong as they
are associated with a type | NFOmessage

Start Vibe 4 in the same way that you have been starting Vibe 3.3.

When you start Vibe for the first time after the upgrade, it takes longer to start than usual
because data in the Vibe database must be upgraded before the Vibe site is ready to use.
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Linux: On the Vibe server, specify the following command:
letc/init.d/teanming start

Windows:  See “Starting Vibe as an Application” on page 88.
or
See “Starting Vibe as a Windows Service” on page 87.

NOTE: If you have been starting Vibe as a Windows service, you need to delete your
existing Windows service configuration and re-configure Vibe as a Windows service before
you can start Vibe. For information about how to configure Vibe as a Windows service, see
“Configuring Vibe as a Windows Service” on page 87.

7 (Recommended) For security reasons, delete the password that you specified in Step 7 in
“Creating the Vibe Database” on page 75.

7a Change to the db directory in the Vibe installation:
cd /vibe_installation/tenp-installer/db
This directory contains the following properties files:
¢ nysql -|iqui base. properties
¢ Oracl e-1iquibase. properties
* sql server-1liqui base. properties

7b In a text editor, open the dat abase_t ype-1i qui base. properti es file that corresponds
with your database type, then delete the password.

7c Save and close the properties file.
8 Continue with “Performing Post-Upgrade Tasks” on page 209.

Performing Post-Upgrade Tasks

After you start Micro Focus Vibe 4, you can access your Vibe site as usual. However, you need to
reset some aspects of the interface before you allow users to access the upgraded site. The interface
reset affects only those definitions and templates that are included with the Vibe product. If you have
created custom definitions and templates, they are unaffected by the interface reset.

+ “Resetting the Search Index” on page 210

+ “Resetting Your Definitions” on page 210

+ “Resetting the Standard Templates” on page 211

+ “Updating the Vibe License” on page 212

+ “Re-Installing the Windows Service” on page 212

+ “Updating the Server.xml File When Using Secure HTTP” on page 212
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Resetting the Search Index

In order for an upgraded search index to be compatible with Vibe 4, you need to re-index the search
index.

The steps to reset the search index differ depending on whether you have multiple Lucene Index
servers. For more information about multiple search indexes, see Chapter 21, “Running Multiple
Lucene Index Servers,” on page 157.

Depending on the size of your Vibe site, this can be a very time-consuming process.

+ “Resetting a Single Search Index” on page 210
+ “Resetting the Search Index with Multiple Index Servers” on page 210

Resetting a Single Search Index

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Consoleicon *.

3 Inthe Management section, click Search Index.

4 Select Re-Index Everything.

5 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.

Resetting the Search Index with Multiple Index Servers

1 Log in to the Vibe site as the Vibe administrator.

N

Click your linked name in the upper right corner of the page, then click the Administration

Console icon '+,

In the Search Index section, click Index.
Select Re-Index Everything.

Select each node that you want to re-index.
Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

o O~ W

A message notifies you when indexing is complete.

Resetting Your Definitions

Various aspects of the Vibe interface have been redesigned and enhanced since Vibe 3.3. Some of
these enhancements affect entries, folders, user profiles, and user workspaces. If you have made
customizations to these areas of Vibe, you must reset these definitions in order to see the
enhancements, as described in this section.
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WARNING: The following procedure deletes any custom modifications that you have previously
made to the default Vibe definitions. If you want to save any modified definitions before proceeding,
you can export the modified definitions. Also, you might want to document exactly what changes you
have made in order to make it easier to reconstruct the definition after you reset it. This applies only
to definitions that you have modified; definitions that you have created are not affected.

To reset your Vibe definitions:

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,
In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.
The Reset Definitions page is displayed.
5 Click Select All.
You can expand each definition to ensure that all definitions have been selected.
6 Click OK.

Resetting the Standard Templates

IMPORTANT: The following procedure deletes any custom modifications that you have previously
made to the default Vibe templates. If you have manually customized any default Vibe templates,
back up the files you have modified before performing the interface reset. This applies only to default
templates that you have modified; templates that you have created are not affected.

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Consoleicon *.

3 Inthe Management section, click Workspace and Folder Templates.

Workspace and Folder Templates
Mew - Reset Import Export

Standard Templates

Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

Blog - A blog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created. Blogs typically pro
larger group can make comments on the entries posted by the original author.

Calendar - A calendar folder is a place to post group events or display other types of entries by date.

Guestbook - A guestbook folder is a simple place that individuals can "sign,” indicating that they have visited a user's Personal Workspace. Visitors ms
A picture of the individual signing the guestbook is displayed with the comment. The guestbook is useful for expanding users' social networks.

Files - Afile folder is a place to put files. Comments or entire discussions can be posted about individual files. Additionally, the files can be automatical
user to add and delete files via any WebDAY client, such as the MS Windows File Manager.
Milestones - A milestone folder is used to roll up or summarize activity in one or more Task folders.

Micro-Blog - A micro-blog folder is a special folder that gets created automatically for each user. Itis intended to contain short text entries only. Each us
one that is created automatically will be accessed as the user's real micro-blog.

Mirrored Files - A mirrored file folder is a special type of file folderwhere it uses a server file system directory as its file storage area instead of the nom
knowledge about the folder contents in synch with whatever is in the directory. The mirrored folder feature can mirror any WebDAV or local file path.

4 Click Reset.
5 Click OK to confirm, then click Close.
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Your Vibe 4 site is now ready for use.

Updating the Vibe License

After upgrading to Vibe 4, you need to update the Vibe license, as described in Chapter 11, “Updating
Your Vibe License,” on page 91.

Re-Installing the Windows Service

If you installed Vibe as a Windows service (as described in “Running Vibe as a Windows Service” on
page 86), you must remove the service and re-install it. This is necessary because the original
service references an unsupported version of Tomcat.

Updating the Server.xml File When Using Secure HTTP

The server. xm Tomcat configuration file is overwritten during the upgrade to Vibe 4. If you set up
secure HTTP browser connections to the Vibe server, and if you changed the password for the

. keyst or e file to something other than the default changei t , you need to update the server. xni file
after upgrading to Vibe 4.

For information about how to update the . keyst or e password in the server. xnl file, see “Do Not
Change the Password for the Keystore File” in the Micro Focus Vibe 4.0.4 Administration Guide.
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2 Upgrading to Novell Vibe 3.3 from
Previous Versions

For information about how to upgrade to Vibe 3.3, see “Update” (https://www.novell.com/
documentation/vibe33/vibe33_inst/data/bjOkxa6.html) in the Micro Focus Vibe 3.3 Installation Guide
(https://www.novell.com/documentation/vibe33/vibe33_inst/data/bookinfo.html).
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Updating the Operating System Where
Vibe Is Running

You can update the operating system where Vibe is running.

1 Update the Linux or Windows operating system to a version that Vibe supports.

For information about which versions are supported, see “Vibe Server Requirements” on
page 19.

For information about how to update the operating system, view the appropriate documentation
for your operating system.

2 (Conditional) If you updated a Linux server, the TrueType font path that Vibe uses for document
conversion might be broken after the update. To fix this problem, you need to re-run the Vibe
installation after upgrading the Linux operating system.

For information on how to run the Vibe installation, see “Linux: Installing and Setting Up a Basic
Vibe Site” on page 71 for a basic installation, or Chapter 15, “Performing an Advanced Vibe
Installation,” on page 127 for an advanced installation.
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VI I Migrate

+ Chapter 28, “Migrating Existing Micro Focus Vibe 4 Data into a New Vibe 4 System,” on
page 219

+ Chapter 29, “Migrating from SiteScape Forum or Other Collaboration Software,” on page 227
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Migrating Existing Micro Focus Vibe 4
Data into a New Vibe 4 System

IMPORTANT: The term “data migration” as used in this section, is essentially about creating a clone
of an existing Vibe system.

+ Cross-version Migration Not Supported: Data migration between servers running different
versions of Vibe is not supported. However, you can use data migration in conjunction with an
upgrade (see “Using Data Migration in Conjunction with an Upgrade to Vibe 4” on page 220).

+ Name and Credentials Must Be the Same: The database name and the database username
and password must be the same on the source and the target server.

This section describes how to migrate data from an existing Vibe 4 server to a new Vibe 4 server. You
might want to do this for any of the following reasons:

+ Your existing Vibe system has outgrown the server where you originally set it up.

+ You want to move your existing Vibe system to a different operating system.

In this case, you can install Vibe 4 on a new server, then migrate your existing Vibe 4 data to
your new Vibe 4 system.

+ You want to preserve your old system in its current state.
+ You are upgrading from Kablink Vibe to Micro Focus Vibe.

NOTE: In the instructions that follow, “target server” refers to the server where you install the Vibe 4
software, and “source server” refers to the existing server from which you are migrating Vibe data.

The instructions in this section are based on a single-server Vibe configuration. If you have a multi-
server Vibe configuration, the single-server instructions can serve as a foundation to get you started
with your more complex migration process.

This section does not include instructions for migrating an Oracle database. Use the instructions for
your Vibe platform as a guideline for the tasks that are involved in migrating Vibe data, then apply
these guidelines to your Oracle database migration.

¢ “Using Data Migration in Conjunction with an Upgrade to Vibe 4” on page 220
+ “Linux Migration with a MySQL Database” on page 220
+ “Windows Migration with an MS SQL Database” on page 222
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Using Data Migration in Conjunction with an Upgrade
to Vibe 4

As stated above, data migration between servers running different versions of Vibe is not supported.
If you want to migrate data from Vibe 3.4 to a new Vibe 4 system, you have two basic choices:

+ You can
1. Upgrade the Vibe 3.4 server to Vibe 4.
2. Install a new Vibe 4 server
3. Migrate the data from the old Vibe 4 server to the new Vibe 4 system.

Or
+ You can
1. Install Vibe 3.4 on the new server.
2. Migrate the data from the existing Vibe 3.4 server to the new Vibe 3.4 server

3. When you are assured that everything is running as expected, upgrade the new server to
Vibe 4.

Linux Migration with a MySQL Database

+ “Preparing the Target Linux Server” on page 220

+ “Preparing the Source Linux Server” on page 221

+ “Transferring Data from the Source Server to the Target Server” on page 221
+ “Importing the Vibe Database to the Target Server” on page 222

+ “Finalizing Your New Vibe 4 Site” on page 222

Preparing the Target Linux Server

On the target server:
1 Install the Vibe 4 software on the target server, as described in Part I, “Basic Installation,” on
page 49, paying special attention to these important details:

+ Set up the same Linux user to run the Vibe software that has been used to run the Vibe
software in the source Vibe server.

+ Select the same encryption algorithm for the Vibe database that was used for the source
Vibe server.

IMPORTANT: If the database encryption algorithms do not match between the source and
target Vibe systems, you cannot log in to the new Vibe 4 site.

2 Start Vibe on the target server.
3 Verify that the new Vibe site is working as expected.
4 Stop Vibe on the target server.

5 Rename the t eani ng directory to t eami ng_backup. In a future step, you will copy the t eani ng
directory from the source server to the target server.

The location of the t eanmi ng directory varies by platform:
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Linux: /var/opt/Mcro Focus/teaning

Windows: c:\Mcro Focus\team ng

Continue with “Preparing the Source Linux Server” on page 221.

Preparing the Source Linux Server

On the source server:

1 Stop Vibe.

Back up your existing database:
nysql dunp -uusernane -ppassword sitescape > sitescape. sql

This creates a file named si t escape. sql in the directory where you executed the nysqgl dunp
command.

3 Ensure that you have a recent backup of your entire Vibe system.

Continue with “Transferring Data from the Source Server to the Target Server” on page 221.

Transferring Data from the Source Server to the Target
Server

On the source server:

1

Mount the target server to the source server so that data can be copied from one server to the
other.

In a terminal window on the source server, become the Linux user that runs the Vibe software.

Copy the database backup of your existing Vibe database (si t escape. sql file) that you created
in Step 2 in “Preparing the Source Linux Server” on page 221 to a convenient temporary location
on the target server.

Copy the entire data area from / var/ opt/ M cro Focus/t eani ng on the source server to the
same location on the target server.

(Conditional) If you are using secure LDAP (LDAPS), you need to copy the cacert s file to the
same location on the target server.

Edit the / opt/ novel | / t eam ng/ apache-t ontat / webapps/ ssf/ WEB- | NF/ cl asses/ confi g/
ssf-ext. properti es file on the target server to include the same content as the corresponding
file on the source server, as follows:

6a Make sure that the user . pwdenc. def aul t =PROPERTY- VALUE values are the same in the
ssf-ext.properties files on both servers.

6b Copy the following property values in the ssf - ext . properti es file on the source server
and replace the corresponding property values on the target server with the source server
values.

NOTE: We recommending pasting to avoid typing errors.

+ dat abase. passwor d=PROPERTY- VALUE
* nuil . SiteScape. out. passwor d=PROPERTY- VALUE
¢ sntp. service. keyst or e. passwor d=PROPERTY- VALUE
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+ kabl i nk. encrypti on. key=PROPERTY- VALUE
¢ kabl i nk. encryption. key. i ni ti al =PROPERTY- VALUE
6¢c Save the modified ssf - ext. properti es file on the target server.
7 Continue with “Importing the Vibe Database to the Target Server” on page 222.

Importing the Vibe Database to the Target Server

On the target server;
1 Remove the empty Vibe database that was created when you installed the Vibe 4 software:
nysql >drop dat abase sitescape;

2 Change to the directory where you copied the si t escape. sql file in Step 3 in “Transferring Data
from the Source Server to the Target Server” on page 221.

3 Create an empty database called si t escape:
nysql -uusernane -ppassword -e "create database sitescape character set utf8"
4 Manually re-create the Vibe database with the data that you copied from the source server:

nysql -uusernane -ppassword sitescape < sitescape. sql

Finalizing Your New Vibe 4 Site

1 Start Vibe 4, as described in “Starting Vibe on Linux” on page 80.

2 Reindex the Vibe site, as described in “Rebuilding the Lucene Index” in “Site Maintenance” in the
Micro Focus Vibe 4.0.4 Administration Guide.

Your Vibe site should now function just as it did on the original source server.

Windows Migration with an MS SQL Database

+ “Preparing the Target Windows Server” on page 222

+ “Preparing the Source Windows Server” on page 223

+ “Transferring Data from the Source Server to the Target Server” on page 223
+ “Importing the Database to the Target Server” on page 224

+ “Finalizing Your New Vibe 4 Site” on page 225

Preparing the Target Windows Server

On the target server:

1 Install the Vibe 4 software, as described in Part I, “Basic Installation,” on page 49.

IMPORTANT: Select the same encryption algorithm for the Vibe 4 database that you selected
for the source Vibe server. If the database encryption algorithms do not match between the
source and target systems, you cannot log in to the new Vibe 4 site.

2 Start Vibe on the target server.
3 Verify that the new Vibe site is working as expected.
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4 Stop Vibe on the target server.

5 Rename the t eam ng directory to t eam ng_backup. In a future step you will copy the t eam ng
directory from the source server to the target server.

The location of the teaming directory varies by platform:

Linux: /var/opt/Mcro Focus/teaning

Windows: c:\Program Fil es\M cro Focus\ Teani ng

6 Continue with “Preparing the Source Windows Server” on page 223.

Preparing the Source Windows Server

On the source server:

1 Stop Vibe.
2 Back up your existing database:

2a In Microsoft SQL Server Management Studio, browse to and right-click the existing
database (named si t escape), then click Tasks > Back Up.

2b For Backup type, select Full.
2c Set other backup options as desired, then click OK.
This creates a file named si t escape. bak in the following directory:

c:\Program Fil es\M crosoft SQ Server\MSSQ.\ Backup

3 Ensure that you have a recent backup of your entire system.
4 Continue with “Transferring Data from the Source Server to the Target Server” on page 223.

Transferring Data from the Source Server to the Target
Server

On the source server:

1 Map a drive from the target server to the source server so that data can be copied from one
server to the other.

2 Copy your existing software extensions to the target server:

From: c:\hone\i cecor edat a\ ext ensi ons

To: c:\Mcro Focus\tean ng\extensi ons

Beginning with Vibe 3, the ext ensi ons directory now contains kabl i nk and | i f eray. com
directories.

3 Delete the empty kabl i nk directory.
4 Delete or rename the following directories to make room for the corresponding directories that
you are copying from the source server:

c:\Mcro Focus\teamn ng
c:\Mcro Focus\teani ng\l ucene
c:\Mcro Focus\team ng\ extensi ons
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5 Copy the entire data area from c:\ M cro Focus\t eam ng on the source server to the same
location on the target server.

6 (Conditional) If you are using secure LDAP (LDAPS), you need to copy the cacert s file to the
same location on the target server.

7 Editthe C:\ Program Fi | es\ Novel | \ Team ng\ apache- t ontat \ webapps\ ssf\ VVEB-
I NF\ cl asses\ confi g\ ssf-ext.properti es file on the target server to include the same
content as the corresponding file on the source server, as follows:

7a Make sure that the user . pwdenc. def aul t =PROPERTY- VALUE values are the same in the
ssf-ext.properties files on both servers.

7b Copy the following property values in the ssf - ext . properti es file on the source server
and replace the corresponding property values on the target server with the source server
values.

NOTE: We recommending pasting to avoid typing errors.

+ dat abase. passwor d=PROPERTY- VALUE
¢ nail. SiteScape. out. passwor d=PROPERTY- VALUE
¢ sntp. service. keyst or e. passwor d=PROPERTY- VALUE
¢ kabl i nk. encrypti on. key=PROPERTY- VALUE
¢ kabl i nk. encryption. key. i niti al =PROPERTY- VALUE
7c Save the modified ssf - ext . properti es file on the target server.
8 Continue with “Importing the Database to the Target Server” on page 224.

Importing the Database to the Target Server

On the target server:

1 In Microsoft SQL Server Management Studio, browse to and right-click the existing Vibe
database (named si t escape) that was created when you installed the Vibe 4 software, then
click Delete.

2 To import the data from your source database, browse to and right-click Databases, then click
Tasks > Restore.

3 Inthe To database field, specify si t escape.

4 Inthe From device field, browse to and select the si t escape. bak file that you transferred to the
target server.

5 Set other restore options as desired, then click OK.
This creates the si t escape database in the following directory on the target server:

c:\Program Fi |l es\ M crosoft SQ. Server\MSSQ

Backed-up data from the source database is imported into the database for your new Vibe 4
system.
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Finalizing Your New Vibe 4 Site

1 Start Vibe 4, as described in “Starting Vibe on Linux” on page 80.

2 Reindex the Vibe site, as described in “Rebuilding the Lucene Index” in “Site Maintenance” in the
Micro Focus Vibe 4.0.4 Administration Guide.

Your Vibe site should now function just as it did on the original source server.
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29 Migrating from SiteScape Forum or
Other Collaboration Software

Moving legacy corporate data into a new collaboration system can look like a long, challenging
process. To make the job easier, see the Micro Focus Teaming Migration Services Flyer. (http://
www.novell.com/docrep/2009/04/Novell_Teaming_Migration_Flyer_en.pdf)
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Vibe System Requirements
Assistance

The system requirements for Micro Focus Vibe include supporting components that might or might
not already be installed on your Vibe server. This section helps you meet the Vibe system
requirements if you are not familiar with how to install these supporting components.

+ “Java Development Kit (JDK)” on page 231

+ “Java Cryptography Extension (JCE)” on page 232

+ “MySQL or MariaDB SQL Database Server” on page 234
+ “PostgreSQL Database Server” on page 236

Java Development Kit (JDK)

The Micro Focus Vibe software runs inside a Java Virtual Machine (JVM).

WARNING: Vibe requires a Java Development Kit (JDK), not a Java Runtime Environment (JRE), in
order to run properly.

We recommend that you use the Oracle JDK/ Follow the instructions in the section below for your
operating system and JDK preference:

If you want to use an SSL connection between your Micro Focus Vibe site and a WebDAV server, and
if the WebDAV server has a self-signed certificate rather than a certificate provided by a certificate
authority, you must use the Oracle JDK. The existing Vibe functionality for handling self-signed
certificates is not compatible with the way the IBM JDK handles self-signed certificates.

+ “Oracle JDK on Linux” on page 231

+ “Oracle JDK on Windows” on page 232

Oracle JDK on Linux

IMPORTANT: OES 2018 installs the Open JDK by default, which doesn’t work with Vibe.

We strongly recommend that you add the Oracle JDK to the OES 2018 server and reference it when
configuring Vibe.

This section describes how to install the Java Development Kit (JDK) for 64-bit Linux, using the
following archive binary file: j dk- ver si on-1i nux-x64. tar. gz.
1 Go to the following URL:
Java SE Downloads (http://www.oracle.com/technetwork/java/javase/downloads/index.html)

2 Download the j dk-versi on-1i nux-x64. tar. gz file to the / usr/j ava directory on your Linux
server.

3 Accept the License Agreement.
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4 As the r oot user, change to the / usr/j ava directory where you downloaded the file, then use
the following command to ensure that the download arrived safely:

Is -1
You should see a file named j dk- ver si on- 1 i nux-x64. t ar. gz.
5 Extract the file:
tar -xvf jdk-version-linux-x64.tar.gz
The Oracle JDK is now installed on your Linux server.
6 (Conditional) You might need to remove a symbolic link and create a new one:
rm/usr/javall at est
In -s /usr/javaljdkversion /usr/javal/l atest
7 Run the following two commands:
chmod -R 755 /usr/javaljdkversion
chown -R root:root /usr/javaljdkversion
8 Install the JCE, as described in “Java Cryptography Extension (JCE)” on page 232.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you
plan to install the JDK. The Vibe installation program prompts you for this location.

Oracle JDK on Windows

1 Go to the following URL:

Java SE Downloads (http://www.oracle.com/technetwork/java/javase/downloads/index.html)
2 Download the latest Java SE version that is appropriate for your operating system.
3 Accept the license agreement.

4 Click the j dk- ver si on-wi ndows- ver si on. exe file in the Download column, then save the file to
an empty temporary directory on your Windows server.

5 Change to that temporary directory, then run the downloaded executable.

This creates a directory named c: \ Progr am Fi | es\ Java\ j dkver si on with the Oracle JDK
software in it.

The Oracle JDK is now installed on your Windows server.
6 Install the JCE, as described in “Java Cryptography Extension (JCE)” on page 232.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you
plan to install the JDK. The Vibe installation program prompts you for this location.

Java Cryptography Extension (JCE)

You must install the Java Cryptography Extension (JCE) in addition to the JDK.
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Oracle JCE on Linux and Windows

1 On your management workstation, download the Java Cryptography Extension (JCE) Unlimited

2

Strength Jurisdiction Policy files (http://www.oracle.com/technetwork/java/javase/downloads/

jce8-download-2133166.html) from Oracle.
Follow the instructions from the Readme that is downloaded with the Oracle JCE.

IBM JCE on Linux

To install the JCE on Linux:

1

10

On the Vibe server, verify that the following files exist:

/etcl/alternatives/jce_version_ibmlocal policy
/etc/alternatives/jce_version_ibmus_export_policy

On your management workstation, download the Java Cryptography Extension (JCE) Unlimited

Strength Jurisdiction Policy files (https://www14.software.ibm.com/webapp/iwm/web/reg/
pick.do?source=jcesdk&lang=en_US) from IBM.

Log in to the Vibe server as the root user (or equivalent), then create the following directory:

nkdir -p /usr/lib64/jvmprivatel/java-version-ibnljce/unrestricted

Copy the JCE Unlimited Strength Jurisdiction Policy ZI P file to the folder on the Vibe server that

you created in Step 3.

cp ~/ Downl oads/ unrestrictedpolicyfiles.zip /usr/lib64/jvmprivate/java-
version-ibnljce/urestricted

Unzip the files:

unzip /usr/lib64/jvmprivate/java-version-ibnijce/unrestricted/
urestrictedpolicyfiles.zip

(Optional if Vibe is already installed) Stop Vibe.
/etc/init.d/team ng stop

Remove the existing links:
rm/etc/alternatives/jce_version_i bmlocal policy
rm/etc/alternatives/jce_version_i bmus_export_policy
Create a new link to the JCE that you downloaded:

In -s Jusr/lib64/jvmprivate/java-version-ibnijce/unrestricted/
| ocal _policy.jar /etc/alternatives/jce_version_ibmlocal _policy

In -s /usr/lib64/jvmprivate/java-version-ibnijce/unrestricted/
US export _policy.jar /etc/alternatives/jce_version_i bmus_export_policy

Verify that the links were created:
Is -1 /etc/alternatives/jce*
(Optional if Vibe is already installed) Start Vibe.
/etcl/init.d/team ng start
tailf /opt/novell/team ng/apache-tontat/| ogs/catalina. out

tailf /opt/novell/team ng/apache-tontat/| ogs/ appserver.|og
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MySQL or MariaDB SQL Database Server

+ “MySQL (or MariaDB) on Linux” on page 234
+ “MySQL or MariaDB on Windows” on page 236

MySQL (or MariaDB) on Linux

IMPORTANT: The steps in this section are optimized for installing MYSQL on SUSE Linux Enterprise
Server (SLES) 11.

For information regarding the installation of MySQL on other versions of SLES or other flavors of
Linux, see Installing and Upgrading MySQL (http://dev.mysqgl.com/doc/refman/5.1/en/installing.html)
in the MySQL documentation (http://dev.mysqgl.com/doc/).

In SLES 12, the default database changed from MySQL to MariaDB. Installation and management
procedures, etc. are basically unchanged. For information on installing SLES 12 and using MariaDB,
see the SLES 12 Documentation (https://www.suse.com/documentation/sles-12/) and MariaDB (http:/
/www.mariadb.com) web sites.

Depending on the options you select when installing Open Enterprise Server 2 and SUSE Linux
Enterprise Server (SLES), the MySQL or MariaDB database server might be installed along with the
operating system. Check for the following directory:

[ usr/ bi n/ nysq|

If the / usr/ bi n/ nysql directory does not exist, you need to install the MySQL or MariaDB database
server. If MySQL or MariaDB is already installed, you still need to configure it for use with Vibe.

+ “Installing MySQL/MariaDB” on page 234

+ “Configuring MySQL/MariaDB” on page 235

+ “Learning More about MySQL/MariaDB” on page 235

Installing MySQL/MariaDB

Ensure you have access to your operating system installation media.
In YaST, click Software > Software Management.

In the Search field, type nysql , then click Search.

Select mysql, then click Accept.

Click Continue to resolve dependencies.

o 00~ W N P

Click Continue to acknowledge package support status.
MySQL is then installed from the SLES media.
7 Continue with “Configuring MySQL/MariaDB” on page 235.
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Configuring MySQL/MariaDB

When MySQL or MariaDB is initially installed, it is not configured with an administrator password, nor
is it configured to start automatically. Follow the steps below to set up the MySQL or MariaDB
database server for use with Vibe:

1 InYaST, click System > System Services.

2 Scroll to and select the service, then click Enable.

3 Click Continue to install dependencies, then click OK to close the status box.

4 Click OK > Yes to finish the installation, then exit YaST.

5 In a terminal window, become the r oot user.

6 To verify that the database server has started, use the following command:

ps -eaf | grep nysql

You should see the processes running.
7 Set the administrator password for the database server:

nysqgl adm n -u root password new _password

This command changes the password for the database r oot user, which is the default
administrator user name for the MySQL or MariaDB database server. This command is part of
the database client package.

IMPORTANT: The database r oot user name is not the same as the Linux r oot user. The Linux
root user has a password established for it when you install Linux. In a parallel fashion, the
database r oot user needs to have a password established for it when you install MySQL or
MariaDB.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Vibe Installation Summary Sheet, specify the database
administrator password. The Vibe installation program prompts you for this information.

Learning More about MySQL/MariaDB

The following table includes some basic and useful MySQL or MariaDB commands:

Action Command
Stop MySQL /etcl/init.d/ nysql stop
Start MySQL /etc/init.d/ nysql start

Show MySQL status nysqgladmn -u root -p extended-status

If you want to administer MySQL or MariaDB through a GUI interface, you can download tools from:
MySQL GUI Tools Downloads (http://dev.mysql.com/downloads/gui-tools/5.0.html)
For more information about MySQL, see:

MySQL Documentation (http://dev.mysql.com/doc)
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MySQL or MariaDB on Windows

1 In your web browser, go to the MySQL or MariaDB download site.

N

Scroll down if necessary, then click the type of Windows operating system you are using (32-bit
or 64-bit).

On the Windows Essentials line, click Download.

Click Save File, browse to and select a convenient temporary directory, then click Save.
In Windows Explorer, browse to the directory where you saved the MySQL . exe file.
Double-click the . exe file to start the Setup Wizard.

~N o o0~ W

Follow the online instructions to install the software on the Windows server, then continue with
Step 8 to configure the server.

8 Unless you are already familiar with configuring MySQL or MariaDB on a Windows server, select
Standard Configuration, then click Next.

9 Select Include Bin Directory in Windows PATH, then click Next.
10 Set the database r oot user password, then click Next.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Vibe Installation Summary Sheet, specify the database
administrator password. The Vibe installation program prompts you for this information.

11 Click Execute to configure the database server, then click Finish.
Some messages report the status of your installation.

12 To monitor the database server, click Start > All Programs, then click MySQL > MySQL Server
5.1 > MySQL Command Line Client or the equivalent MariaDB options.

PostgreSQL Database Server

+ “PostgreSQL on Linux” on page 236
+ “PostgreSQL on Windows” on page 238

+ “Securing PostgreSQL and Vibe Communications” on page 239

PostgreSQL on Linux

IMPORTANT: The steps in this section are optimized for installing PostgreSQL on SUSE Linux
Enterprise Server (SLES) 12.

For information regarding the installation of PostgreSQL on other versions of SLES or other flavors of
Linux, see the PostgreSQL (https://www.postgresgl.org/docs/manuals/) and the SUSE (https://
www.suse.com/documentation/) documentation on the web.

+ ‘“Installing PostgreSQL and Setting the postgres User Password” on page 237
+ “Configuring the Socket Connection Method” on page 237
+ “Learning More about PostgreSQL” on page 238
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Installing PostgreSQL and Setting the postgres User Password

1 Ensure you have access to your operating system installation media.
2 InYaST, click Software > Software Management.

3 Inthe Search field, type post gresgl , then click Search.

4

Select the postgresgl-jdbc and postgresql94-server packages for the PostgreSQL server, and if
the Vibe software is running on the same machine, select the PostgreSQL client package,
libecpg6, then click Accept.

ol

If needed, click Continue to resolve dependencies.

6 Click Continue to acknowledge package support status.

PostgreSQL is then installed from the SLES media.

7 Click Finish.

8 In YaST, click System > Services Manager.

9 Scroll to and select postgresql, then click Enable/Disable > Start/Stop > OK.
10 After the configuration is updated, close YaST and open a terminal prompt.
11 Set a password for the database administrator (post gr es system user) by entering the following
commands:

su - postgres

psql

\ password postgres
speci fy-a- password
r epeat -t he- password
\q

exit

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Vibe Installation Summary Sheet, record the postgres
administrator password. If you want to use a password other than post gr es you must modify the
postgresql-create-empty-database.sql file. See the PostgreSQL documentation on the web (https://
www.postgresql.org/docs/manuals/) for help.

12 Continue with “Configuring the Socket Connection Method” on page 237.

Configuring the Socket Connection Method

1 Astheroot user, browseto/var/lib/pgsql/data.

2 Edit the pg_hba. conf file and change the following local and host lines to specify md5
encryption, as follows:

| ocal all al | nd5
host al |l al | 127.0.0.1/32 nd5
host al | al | ::1/128 nd5
host al |l al | 0.0.0.0/0 nd5

For more information about the pg_hba.conf file, see the PostgreSQL documentation on the web
(https:/Iwww.postgresqgl.org/docs/9.4/static/auth-pg-hba-conf.html).

3 Save the file.
4 Edit the post gres. conf file.
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10
11

Uncomment the listen_addresses line by removing the pound sign (#).
Change ‘localhost’ to **.

Save and close the file.

In YaST, click System > Services Manager.

Scroll to and select postgresql, then click Start/Stop > OK to stop PostgreSQL.
Repeat from Step 8 to restart PostgreSQL, then close YaST.

Continue with “Securing PostgreSQL and Vibe Communications” on page 239

Learning More about PostgreSQL

If you want to administer PostgreSQL through a GUI interface, you can download tools from:

Community Guide to PostgreSQL GUI Tools (https://wiki.postgresql.org/wiki/
Community_Guide_to_PostgreSQL_GUI_Tools)

For more information about PostgreSQL, see:

The PostgreSQL Wiki (https://wiki.postgresqgl.org/wiki/Main_Page)

PostgreSQL on Windows

1

In your web browser, go to the PostgreSQL download site.

2 Scroll down if necessary, then click the type of Windows operating system you are using (32-bit

~N o o0 b~ W

10

11

12

13

or 64-hit).

On the Windows Essentials line, click Download.

Click save File, browse to and select a convenient temporary directory, then click Save.
In Windows Explorer, browse to the directory where you saved the . exe file.
Double-click the . exe file to start the Setup Wizard.

Follow the online instructions to install the software on the Windows server, then continue with
Step 8 to configure the server.

Unless you are already familiar with configuring PostgreSQL on a Windows server, select
Standard Configuration, then click Next.

Select Include Bin Directory in Windows PATH, then click Next.
Set the database postgres user password, then click Next.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Vibe Installation Summary Sheet, specify the database
administrator password. The Vibe installation program prompts you for this information.

Click Execute to configure the database server, then click Finish.
Some messages report the status of your installation.

To monitor the database server, click Start > All Programs, then click PostgreSQL > PostgreSQL
Server > PostgreSQL Command Line Client.

Continue with “Securing PostgreSQL and Vibe Communications” on page 239
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Securing PostgreSQL and Vibe Communications

IMPORTANT: If SSL is enabled on your PostgreSQL server, you must modify the Vibe server as
follows:

1 Shut down the Vibe server.

2 Rerun the Vibe installer and when specifying the JDBC URL, add ?ssl =t r ue after the database
name, for example:

url ="jdbc: postgresql ://1P_address_or_DNS_nane: 5432/ vi be_db_nane?ssl =t r ue"
3 Restart Vibe.
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Memcached Caching with Micro
Focus Vibe

Micro Focus Vibe contains two caching options for the hibernate caching provider: ehcache and
memcached. For more information about ehcache, see Ehcache (http://ehcache.sourceforge.net).

+ “About Memcached” on page 241

+ “Downloading and Installing Memcached” on page 241

+ “Configuring Memcached” on page 242

+ “Securing Memcached” on page 243

+ “Configuring Memcached in the Vibe Installation Program” on page 244

+ “Memcached Logging” on page 244

About Memcached

Memcached is a high-performance, distributed memory object caching system used by a number of
large Internet sites such as Wikipedia, Flickr, Twitter, and Youtube, as well as enterprise systems.

+ “Advantages for Using Memcached” on page 241
+ “Hardware Requirements and Configurations” on page 241

Advantages for Using Memcached

Memcached offers the following advantages over other caching systems:

+ Better utilization of memory resources from the server farm.

+ No replication (and therefore no overhead involved in replication). This results in a reduction of
60 or more threads per Vibe node in a two-node cluster.

+ The number of servers and the size of data scale together.
+ Scales out much better than replication-based cluster cache.

Hardware Requirements and Configurations

Micro Focus Vibe supports memcached only on the SUSE Linux operating system.

Downloading and Installing Memcached

NOTE: You should run memcached only on a SUSE Linux operating system. 64-bit is recommended.

Memcached is included with the SUSE Linux Enterprise High Availability Extension. You simply need
to install it on the server where the Lucene search index is running as you would any other Linux
package.
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If you do not have the SUSE Linux Enterprise High Availability Extension, you can download and
install memcached by completing the following steps on the Lucene search index server:

o 00~ W N P

Navigate to the openSUSE Software Download page (http://software.opensuse.org).
In the Search field, type nentached, then click Search.

Download the RPMfile after it is returned in the search results.

Install the downloaded RPMfile.

Repeat Step 1 through Step 4 on the Lucene search index server.

Continue with “Configuring Memcached” on page 242.

Configuring Memcached

After you have downloaded and installed memcached on the server where the Lucene search index
is running, as described in “Downloading and Installing Memcached” on page 241, you need to
configure it on each node.

You configure memcached by adding the desired switches to the MEMCACHED PARAMS variable.

1
2
3

Navigate to the et ¢/ sysconfi g directory.
Open the nentached file in a text editor.

Uncomment the MEMCACHED PARAMS variable and add any switches that you feel are appropriate.
When you uncomment the MEMCACHED PARANS variable, the following switches are already
present:

+ -d: Runs as a daemon. This is recommended.

+ -|: Determines the interface to listen on. The default value is the localhost. You should either
delete this switch with its default address (this is recommended for a simple setup) or
change the default address to the address that you want memcached to listen on. For
example, -1 172.17.2. 3.

To see a complete list of switches that are available with memcached, type mentached - h from
the command line of a machine where memcached is installed.

(Recommended) Increase the maximum memory to use for items to 1024 MB. You do this by
adding the - mswitch to the MEMCACHED PARANS variable. For example:

-m 1024

(Recommended) You should configure memcached to start automatically each time you reboot
the server where the Lucene search index is running. To configure memcached to start
automatically, enter the following command from the command line:

chkconfig --add menctached

To verify that automatic startup is enabled, enter the following command from the command line:
chkconfi g menctached

Validate that memcached is running from the local server by typing the following command:

net stat -ap|grep nentached

After you have verified that memcached is running on the local server, log in to a remote server,
then validate that memcached is running to ensure that no networking problems exist:

7a From the command line of a remote server, make a network connection to the server where
memcached is running. For example, you can use the t el net command.
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tel net 172.17.2.3 11211

7b Type a simple memcached command, such as stats and stats settings.
7c After you have verified that memcached is running as expected, type qui t to exit t el net .

Following is an example of what you see:

07309: ~/ Desktop # tel net XxX.XXX.XxX.xx 11211
Tryi ng XXX. XXX. XXX. XX. .
Connected to XXX.XXX.XXX. XX
Escape character is ""]".
stats

STAT pid 2486

STAT uptine 313

STAT time 1334337169

STAT version 1.2.6

STAT poi nter_size 64

STAT rusage_user 0.028001
STAT rusage_system 0. 000000
STAT curr_itens 10

STAT total _itenms 17

STAT bytes 7971

STAT curr_connections 4

STAT total connections 6
STAT connection_structures 5
STAT cnd_get 79

STAT cnd_set 17

STAT get _hits 62

STAT get _mi sses 17

STAT evictions 0

STAT bytes_read 14249

STAT bytes witten 67674
STAT |imt_maxbytes 67108864
STAT threads 1

END

quit

Connection closed by foreign host.
07309: ~/ Desktop #

8 Continue with “Configuring Memcached in the Vibe Installation Program” on page 244.

Securing Memcached

Memcached was not designed for authentication and is protected only by firewalls and similar
mechanisms.

Viable options include the following:

¢ Set up an SSL tunnel between memcached and instances of Tomcat.

¢ Use SASL for authentication.

+ Use the Lucene server’s firewall to allow access only from the Vibe servers that run Vibe Tomcat.
For example:

1. Atthe terminal prompt on the Lucene server, run the following command for each Vibe
server that needs access:
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iptables -A INPUT -s ip_of _allowed server -p tcp --dport 11211 -j ACCEPT

Where ip_of_allowed_server is the IP address of one of the Vibe servers needing access.

For example:
i ptables -A INPUT -s 192.168.1.61 -p tcp --dport 11211 -j ACCEPT

2. Repeat Step 1 until all of the Vibe servers that need access are allowed to communicate
through the Lucene server’s firewall.

3. Run the following command to block access by all other servers:
iptables -A INPUT -s 0.0.0.0/0 -p tcp --dport 11211 -j DROP

Configuring Memcached in the Vibe Installation
Program

After you have installed and configured memcached, you need to configure the Vibe installation
program to use memcached as the hibernate caching provider. For more information, see “Running
the Linux Vibe Installation Program” on page 72.

Memcached Logging

To trace activities on the Vibe server that are related to memcached:

1 Navigate to the following directory: / opt / novel | / t eani ng/ apache-t ontat / conf
2 Open thel og4j . properti es file in a text editor.
3 Uncomment the following lines in the | og4j . properti es file:

# Traci ng of mentached

#| og4j . cat egory. net. spy. menctached=DEBUG

#l og4j . cat egory. net. rubyeye. xmencached=DEBUG

#l og4j . cat egory. com googl ecode. hi ber nat e. nentached=DEBUG

#| og4j . cat egory. com novel | . t eam ng. mencached=DEBUG

#l og4j . cat egory. com novel | . t eani ng. hi ber nat e. nentached=DEBUG

4 Save and close the | og4j . properti es file.
5 Restart the Vibe server.
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C Third-Party Materials

+ “ANTLR 3 License” on page 245

+ “Colt License Agreement” on page 246

+ “Domdj License” on page 246

+ “iCal4j License” on page 247

+ “ICUA4J license (ICU4J 1.3.1 and later)” on page 247
+ “JAXEN License” on page 248

+ “Jung” on page 248

+ “ASM” on page 249

+ “Firebug Lite” on page 250

ANTLR 3 License

Copyright (c) 2003-2008, Terence Parr
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the author nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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Colt License Agreement

Packages cern.colt*, cern.jet*, cern.clhep
Copyright (c) 1999 CERN - European Organization for Nuclear Research.

Permission to use, copy, modify, distribute and sell this software and its documentation for any
purpose is hereby granted without fee, provided that the above copyright notice appear in all
copies and that both that copyright notice and this permission notice appear in supporting
documentation. CERN makes no representations about the suitability of this software for any
purpose. It is provided “as is” without expressed or implied warranty.

Packages hep.aida.*

Written by Pavel Binko, Dino Ferrero Merlino, Wolfgang Hoschek, Tony Johnson, Andreas
Pfeiffer, and others. Check the FreeHEP home page for more info. Permission to use and/or
redistribute this work is granted under the terms of the LGPL License, with the exception that any
usage related to military applications is expressly forbidden. The software and documentation
made available under the terms of this license are provided with no warranty.

Dom4j License

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

Redistribution and use of this software and associated documentation (“Software”), with or without
modification, are permitted provided that the following conditions are met:

1. 1.Redistributions of source code must retain copyright statements and notices. Redistributions
must also contain a copy of this document.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. The name “DOM4J” must not be used to endorse or promote products derived from this
Software without prior written permission of MetaStuff, Ltd. For written permission, please
contact dom4j-info@metastuff.com.

4. The name “DOM4J” must not be used to endorse or promote products derived from this
Software without prior written permission of MetaStuff, Ltd. For written permission, please
contact dom4j-info@metastuff.com.

5. Products derived from this Software may not be called “DOM4J” nor may “DOM4J” appear in
their names without prior written permission of MetaStuff, Ltd. DOMA4J is a registered trademark
of MetaStuff, Ltd.

6. Due credit should be given to the DOM4J Project (http://www.dom4j.org).

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS “AS IS™ AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.
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ICal4j License

Copyright (c) 2008, Ben Fortuna
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of Ben Fortuna nor the names of any other contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

ICU4J license (ICU4J 1.3.1 and later)

COPYRIGHT AND PERMISSION NOTICE
Copyright (c) 1995-2001 International Business Machines Corporation and others
All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the
Software, and to permit persons to whom the Software is furnished to do so, provided that the above
copyright notice(s) and this permission notice appear in all copies of the Software and that both the
above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS.
IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE
LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR
ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.
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Except as contained in this notice, the name of a copyright holder shall not be used in advertising or
otherwise to promote the sale, use or other dealings in this Software without prior written
authorization of the copyright holder.

JAXEN License

Copyright (C) 2000-2002 Bob McWhirter & James Strachan.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions,
and the disclaimer that follows these conditions in the documentation and/or other materials
provided with the distribution.

3. The name “Jaxen” must not be used to endorse or promote products derived from this software
without prior written permission. For written permission, please contact license@jaxen.org.

4. Products derived from this software may not be called “Jaxen,” nor may “Jaxen” appear in their
name, without prior written permission from the Jaxen Project Management (pm@jaxen.org).

In addition, we request (but do not require) that you include in the end-user documentation provided
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:

“This product includes software developed by the Jaxen Project (http://www.jaxen.org).”

Alternatively, the acknowledgment may be graphical using the logos available at http://
www.jaxen.org.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE Jaxen
AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Jaxen
Project and was originally created by bob mcwhirter (bob@werken.com) and James Strachan
(jstrachan@apache.org). For more information on the Jaxen Project, please see http://
WWW.jaxen.org.

Jung

THE JUNG LICENSE
Copyright (c) 2003-2004, Regents of the University of California and the JUNG Project

All rights reserved.
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Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the University of California nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ASM

Copyright (c) 2000-2005, INRIA, France Telecom
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the copyright holders nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Firebug Lite

Copyright (c) 2006-2007, Joe Hewitt
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the copyright holders nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Documentation Updates

Changes made to this guide since the initial release of Vibe 4.0 are listed below.

Section Changed Summary of Changes

Various Information updated to accommodate the changed
SQL database default from SLES 11 (MySQL) to
SLES 12 (MariaDB)

Documentation Updates
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